MatchPoint™

BLADE™

Wood Processing System
Patents

The *BLADE* wood processing system is made and sold under one or more of the following patents:

- US 6,539,830  
- US 6,702,096  
- US 7870879  
- AU 2006263691  
- NZ 564779

For use with US 6539830
For use with AU 783340
For use with CA 2398768

Other patents may apply

Return Goods Policy

Return goods cannot be accepted without prior authorization and are subject to a restocking charge. The Seller certifies the articles specified herein were produced in compliance with all provisions of the Fair Labor Standards Act of 1938, as amended, including Section 12.—Rev. 6/98

Reporting Errors and Recommending Improvements

To report errors or recommend improvements to this manual, please complete the Document Evaluation Form in the appendices. Mail or fax the form to:

MiTek Machinery Division  
301 Fountain Lakes Industrial Drive  
St. Charles, MO 63301  
Attn: Engineering Manager, Fax: 636-328-9218
Notice of Change

Use this page to record Service Bulletins and Notices that you receive to keep your manual updated.

**BLADE™**

Wood Processing System

<table>
<thead>
<tr>
<th>Service Bulletin or Notice #</th>
<th>Dated</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Contents

**Preliminary Pages**
- Legal Notice .......................................................... ii
- Notice of Change .................................................... iii
- Contents ................................................................. iv

**Safety (English)**
- Safety Indicators: Signal Words ........................................ 1
- General Equipment Safety Rules ....................................... 2
  - Know Your Equipment ................................................. 2
  - Personal Safety ...................................................... 2
  - Installing the Equipment ............................................ 3
  - Lockout/Tagout ..................................................... 3
  - Keeping a Safe Environment ...................................... 3
  - Operating and Maintaining the Equipment ....................... 4
  - Electrical Safety .................................................. 4
- Lockout/Tagout .......................................................... 5
  - Lockout/Tagout Guidelines .......................................... 5
  - Electrical Lockout/Tagout Procedures .............................. 6
  - Hydraulic System Lockout/Tagout Procedure ..................... 10
  - Pneumatic System Lockout/Tagout Procedure .................... 10
- Troubleshooting With an Energized Machine ....................... 10
- Safety Tests ............................................................ 11
  - Inspecting Indicators ............................................... 11
  - Testing the E-stop Pushbuttons and Pull-Cords .................. 12
  - Testing Movement While E-stop is Active ....................... 13
  - Testing E-Stops for Optional Equipment ........................ 14
  - Testing Interlocked Doors ........................................ 15
- Restricted Zone .......................................................... 17
  - Know the Restricted Zone: Shown in Red ....................... 17
  - Marking the Restricted Zone ..................................... 18
- Safety Symbol Definitions ............................................ 19
- Declaration of Safety Conformity ................................... 27
- Treatment for Hazardous Substances ................................. 28

**Seguridad (Español)**
- Indicadores de seguridad: Palabras de aviso ................. 30
- Reglas de seguridad para el equipo de general .................. 31
- Bloqueo/Etiquetado ..................................................... 34
  - Pautas de bloqueo/etiquetado .................................... 34
  - Procedimientos de bloqueo/etiquetado eléctricos ............ 35
  - Procedimiento de bloqueo/etiquetado del sistema neumático 39
- Solución de problemas con una máquina energizada ............. 39
- Pruebas de seguridad .................................................. 40
  - Indicadores de inspección ......................................... 40
  - Pruebas de los botones pulsadores del freno de emergencia y las cuerdas de parada de emergencia 41
  - Prueba de movimiento mientras el botón pulsador del freno de emergencia está activo .................................................. 43
  - Prueba de los equipo opcional ................................... 44
  - Prueba de las puertas interbloqueadas ........................ 45
Contents

Zona restringida ......................................................... 48
Conocer la zona restringida ........................................ 48
Marcar la zona restringida ........................................... 49
Información adicional ................................................. 49

Introduction  Chapter 1
Introduction to the Manual ........................................... 50
Purpose and Scope of This Equipment Manual .............. 50
Understanding This Manual ......................................... 52
Screen Shots ............................................................. 52
Navigation ................................................................. 53
Formatting Cues .......................................................... 53

Additional Resources ................................................. 54
Supplemental Documentation ....................................... 54
Board Stretcher Software Manual .................................. 54
Web Site ................................................................. 54
Contacting Us ........................................................... 54

General Information  Chapter 2
Introduction to the Equipment ..................................... 55
Purpose of the Equipment .......................................... 55
Description of the Equipment .................................... 55
Safety Compliance of the Equipment ............................ 56
Overview Graphics ..................................................... 56
Graphics Identifying Main Components .......................... 56
Graphic Showing Optional Equipment ........................... 58
Graphics Identifying Axes and Home Positions .................. 59

Main Components and Optional Equipment ..................... 62
Main Components on Every BLADE System ...................... 62
Optional Equipment and Features ................................. 63
Outfeed System Descriptions ....................................... 64
Dust Extraction Methods ............................................ 64
Second Monitor Feature ............................................. 64
Auto Deck Description .............................................. 65
Printers Available ..................................................... 67

Technical Specifications ........................................... 68
General Specifications ............................................... 68
Environmental, Transportation, and Handling Specifications .. 70

Truss Terminology ..................................................... 71

Software  Chapter 3
Introduction to the Software ........................................ 73
BLADE Software Overview ......................................... 73
Board Stretcher Software Overview ................................ 73
Reports Software Overview ....................................... 73
Tips & Tricks & Terminology for Using the Software ........ 73
BLADE Software Home Screen ................................... 74
Overview of Home Screen ........................................... 74
Introduction to the Main Menus .................................... 74
## Contents

Status Indicators on Home Screen .............................................. 75  
Toolbar ..................................................................................... 76  
The Cut List Screen ..................................................................... 80  
Right-Click Menu From Cut List ................................................ 82  
Database View (Parts Data and Visual Representation) ............... 83  

**Saw Menus in Detail** ................................................................. 85  
File Menu .................................................................................. 85  
Diagnostics Menu ....................................................................... 86  
Diagnostics>Detailed Diagnostics Menu .................................... 89  
Material Handling Menu ............................................................. 97  
Tools Menu ................................................................................ 99  

**Board Stretcher Software** ......................................................... 102  
**Reports Software** ................................................................ 103  

**Operation** .................................................................................. 105  
**Chapter 4** ................................................................................ 107  
**Safety Operating Notes** ............................................................ 107  
**E-Stops, Interlocks, and Indicators** .......................................... 107  
Activating an E-Stop .................................................................. 110  
Restarting After an E-Stop is Activated ...................................... 111  
Interlocked Door Switches .......................................................... 112  
Safety Protection When Saw Chamber Door is Open ................. 114  
Using and Locking Out the Disconnect Switch ............................ 115  
Indicator Lights on Saw’s Operator Interface Panel ................... 118  
Indication of Movement (Beacon & Horn) .................................... 119  

**Operator Interface Overview** .................................................. 120  
Graphics Showing Saw Operator Interface ................................ 120  
Saw Operator Interface ............................................................... 122  
Adding a Keyboard or Mouse ..................................................... 123  
Using a USB Memory Stick ........................................................ 123  
Operator Interface for Auto Deck .............................................. 124  
Operator Interface for Powered Skewed Conveyor .................... 125  
Printer Overview ....................................................................... 125  

**Using Windows 10®** ................................................................. 126  
Finding the Start Menu .............................................................. 126  
Shutting Down the Computer ..................................................... 127  

**Using Windows 8** .................................................................. 128  
Finding the Windows 8 Start Menu ............................................ 128  
Shutting Down a Windows 8 Computer ....................................... 128  

**Using the BLADE Software: Tips & Terms** ............................. 129  
Understanding the Length Measurement Format ...................... 129  
Terminology .............................................................................. 129  
Shortcuts .................................................................................... 129  
Using the On-Screen Keyboard (OSK) ....................................... 130  
User Interface Tips .................................................................... 132  
Quick Troubleshooting for Operator Interface ......................... 133  
Logging In or Out ...................................................................... 134  
Retrieving a Saw Password ....................................................... 134  

**Operating Procedure: Overview** ............................................. 135
## Contents

Summary of Normal Operating Procedure ........................................ 135
Restart Procedure ................................................................. 135
**Operating Procedure: Detailed** ................................................ 136
  - Powering Up or Down ....................................................... 136
  - Setting Up the Auto Deck Staging Conveyor ............................ 138
  - Importing Job Files ......................................................... 140
  - Cutting the Parts ............................................................ 141
**Specialized Operating Procedures** ......................................... 142
  - Optimizing (Operating Board Stretcher Software) .................... 142
  - Operating the CLS (Crooked Lumber Sensor) ......................... 142
  - Choosing Manual Mode or Auto Mode .................................. 143
  - Cutting 1 Board .................................................................. 143
  - Raising or Lowering the Load Arms ..................................... 144
  - Using the Visualize Feature ............................................... 144
  - Finding an Active E-Stop ................................................... 144
  - Operating the Printer ....................................................... 145
  - Other Printing Options (Board Stretcher) .............................. 146
  - Managing Remainders ....................................................... 146
  - Deleting Completed Jobs ................................................... 147
  - Rejecting or Resetting Jobs and Boards ............................... 147
  - Recording Non-Productive Time ......................................... 147
  - Determining Board Recovery Solutions ................................ 149
  - Resetting a VFD Fault ....................................................... 151
  - Resetting a Stalled Saw .................................................... 152
  - Managing the Configuration ................................................ 152
  - Changing Default Computer Settings (Tools>Options) ............. 152
**Manual Operations** ............................................................ 154
  - Manually Operating the Saw .............................................. 154
  - Manually Operating the Auto Deck ...................................... 155
  - Raising the Lumber Stops .................................................. 157
  - Operating the Powered Skewed Conveyor .............................. 158
**Calibration** ....................................................................... 159
  - Homing the System .......................................................... 159
  - Calibrating the Angle, Bevel, Elevation, and CLS .................. 160
  - Home System ..................................................................... 165
  - Solution to Z-Pulse Error ................................................... 166
  - Defining Printer Marks ...................................................... 166
**Second Monitor and Production Metrics (optional)** .................... 167
  - Activating a Second Monitor (Display) ............................... 167
  - Managing Production Metrics ............................................ 167
**Printer** ........................................................................... 168
**Appendix A** ........................................................................ 168
**Supplies** ........................................................................... 168
  - How to Order Printer Supplies ............................................ 168
  - How Much Ink Will I Use? ................................................. 168
  - Placing Your First Supplies Order Through Matthews™ .......... 169
**Overview of Printer Components** .......................................... 170
## Contents

- Printer Component Descriptions ........................................ 170
- Printer System Graphics .................................................. 171
- Keeping You and Your Printer Safe .................................... 173
- Sensor States ............................................................... 173
- Maintaining the Printer (HANG NEAR PRINTER) ...................... 174
  - Cleaning the Printer Daily ........................................... 174
  - Printer Relief Valve .................................................. 175
  - Printer Fuse ............................................................. 175
- Flushing the Printer ........................................................ 176
  - Identifying Your Printer ............................................ 176
  - The Flushing Procedure ............................................ 177
- Manually Purging Ink or Cleaner From Lines ......................... 179
- Preparing for Shut Down of Over 48 Hours ........................... 180
- After Shut Down for Over 48 Hours ................................... 180
- Replacing an Ink or Cleaner Fluid Bottle ............................ 181
- Printer Description and Operation Details ......................... 182
- Printer Options Overview .............................................. 182
- Print Fields ............................................................... 183
- Print Side ................................................................. 184
- Edge Printer ............................................................... 184
- Image Size and Location ................................................ 185
- Printing Lateral Bracing on Roof Trusses ............................ 187
- Sample Printer Agreement .............................................. 188
- Training................................................................. 190
- Appendix B .................................................................... 190
- Safety Resources .......................................................... 190
- Basic Understanding of the System .................................... 190
  - Description of Machine and Training .............................. 190
  - Operator Requirements ............................................. 191
  - Meeting Your Expectations ......................................... 191
  - Optimizing Board Usage ............................................ 191
- Acceptable Material and Finished Parts .............................. 192
  - What You Should Send To the Saw ................................. 192
  - What the Saw Will Cut .............................................. 192
  - Stock Length, Size, and Grade ...................................... 193
- Things to Understand ...................................................... 194
  - Understanding Job Files ............................................ 194
  - Understanding the CLS .............................................. 194
  - Using Reminders ...................................................... 195

## Glossary

## Index
Safety Indicators: Signal Words

The following signal words and colors are used throughout this document to indicate safety hazards. Pay careful attention when you see them. The level of severity differs for each signal word and color.

Signal words are accompanied by graphics showing what personnel should or should not do. The graphics are called safety symbols and are defined on page 19, but more specific text is provided every time a graphic is used throughout the manual. Everyone near the machine must be trained on how to read these safety indicators.

Failure to comply with the instructions accompanying each signal word may result in property damage, personal injury, or even death. Personnel must follow all safety procedures and practices to ensure the safest possible operation of this equipment. However, at no time is this document a substitute for common sense. Personnel must ensure that the work environment is safe and free of distractions.

| **DANGER** | Indicates an imminently hazardous situation which, if not avoided, is likely to result in death or serious injury. |
| **WARNING** | Indicates a potentially hazardous situation which, if not avoided, may result in death or serious injury. |
| **CAUTION** | When CAUTION is used *with* the safety alert symbol (yellow triangle), it indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. When CAUTION is used *without* the safety alert symbol, it indicates a potentially hazardous situation which may result in equipment damage. |
| **NOTICE** | Calls attention to information that is significant to understanding the operation at hand. |
| **ENVIRONMENTAL** | Applies to conditions that may affect the environment but do not have an immediate, direct effect on personnel or equipment. |
General Equipment Safety Rules

Because it is impossible to anticipate every circumstance that might involve a hazard, the safety information provided in this equipment manual and on the machine is not all-inclusive. If this machine is operated or serviced using a procedure not specifically recommended by the manufacturer, the procedure shall be approved by a professional engineer to ensure it will not render the equipment unsafe. Use extreme caution and common sense at all times!

Know Your Equipment

• Read this manual completely before using or maintaining the equipment. Do not operate this machine unless you have a thorough knowledge of the controls, safety devices, emergency stops, and operating procedures outlined in this manual.

• Read and follow all safety notes. Failure to comply with these instructions may result in economic loss, property damage, and/or personal injury including death.

• Refer to the lockout/tagout guidelines on the following pages to safely perform maintenance and troubleshooting of this equipment.

• Observe and obey all safety labels. Replace worn labels immediately.

• Use this equipment solely for the purpose described in this manual.

• Only qualified personnel should attempt to operate or perform maintenance on this equipment. “Qualified personnel” is defined as:

  ...a person or persons who, by possession of a recognized degree or certificate of professional training, or who, by extensive knowledge, training, or experience, has successfully demonstrated the ability to solve problems relating to the subject matter and work—ANSI B30.2-1983

  ...one who has skills and knowledge related to the construction and operation of the electrical equipment and installations and has received safety training on the hazards involved—NEC 2002 Handbook

Personal Safety

• Always wear safety glasses and hearing protection in an industrial environment.

• Utilize a filtering face piece (dust mask) when working near sawdust.

• Wear proper clothing and appropriate personal protective equipment (e.g. safety glasses and hearing protection.) Do not wear loose clothing or jewelry. Confine long hair by tying it back.

• Use caution when lifting heavy parts or material.
Installing the Equipment

- Follow installation instructions completely.
- This equipment is not for use in a residential area.

Lockout/Tagout

- Before performing maintenance on the pneumatic or hydraulic systems, bleed the lines to eliminate pressure.
- Lockout/tagout all energized systems before performing maintenance on them. Refer to the Lockout/Tagout Guidelines section on page 5.

Keeping a Safe Environment

- Keep children away. All visitors should be kept a safe distance from the work area. Hazards may not be apparent to individuals unfamiliar with the machine.
- Keep work areas well lit.
- Keep the work area clean and free of any trip or slip hazards.
- Do not use the equipment in damp or wet locations, or expose it to rain or snow.
- Minimize dust clouds and protect your equipment by cleaning dust in this manner:
  - Vacuum dust prior to blowing with air
  - Shut down electrical power and sources of ignition
  - If using compressed air, it should be a low compression (no more than 15 psi)
  - Powered cleaning equipment such as vacuums must be consistent with local governmental codes for use in dusty conditions.
Operating and Maintaining the Equipment

- Ensure that all people, tools, and foreign objects are clear of the restricted zones before operating this equipment. The restricted zones are shown on page 17.
- Perform safety tests to ensure all E-stops are working properly before operating the equipment at the initial startup, after performing any maintenance, and in accordance with the maintenance schedule.
- In case of machine malfunction, stop the machine immediately using an E-stop and report the malfunction to a supervisor.
- Never leave the machine running unattended. Turn the power off! Do not leave the machine until all parts have come to a complete stop and all electrical power has been shut off.
- Check for worn or damaged parts regularly. Repair or replace them immediately.
- Keep the hydraulic, pneumatic, and electrical systems in good working order at all times. Repair leaks and loose connections immediately. Never exceed the recommended pressure or electrical power.
- Check that all safety devices are in working order before each shift starts. All protective guards and safety devices must be in place before and during use of the machine. Never disconnect or bypass any safety device or electrical interlock.
- Only qualified maintenance personnel shall remove or install safety devices.
- Periodically inspect the quality of the finished product.

Electrical Safety

- Do not use any liquids in the interior of electrical cabinets.
- When using solvents on and around the machine, remove power to the machine to eliminate the chance of sparking, resulting in explosion or fire. Wear a respirator approved for use with solvents. Wear protective clothing, gloves, and safety glasses.
Lockout/Tagout

Lockout/Tagout Guidelines

All lockout/tagout guidelines must be met according to OSHA 29 CFR 1910.147. A specific procedure should be included in your company’s energy control program. This manual is not intended to replace your company’s de-energizing or lockout/tagout procedure required by OSHA, but merely to provide general guidance.

The term “lockout,” as used in this manual, means placing a lockout device on any and all energy sources to ensure that the energy isolating device and the equipment being controlled cannot be re-energized or operated until the lockout device is removed. The photos on the next page show where the electrical disconnects are located for this machine.

- Energy sources include electrical, mechanical, hydraulic, pneumatic, chemical, thermal, or other energy.
- In the case of electrical energy sources, the main power and control power to the machinery must be turned off and physically locked in the “off” position.
- A lockout device is usually a keyed padlock.
- If more than one person is working in a restricted zone, use a group lockout device that will allow each person to use a lock that can be removed only by the person performing the maintenance.

“Tagout” means that a prominent warning is securely fastened to an energy-isolating device to indicate that the equipment shall not be operated.

Whenever you see this symbol, lockout/tagout!
Electrical Lockout/Tagout Procedures

When Working on a Machine Outside the Machine’s Main Electrical Enclosure

Before performing maintenance on any machine with electrical power, lockout/tagout the machine properly. When working on a machine outside of the machine’s main electrical enclosure, not including work on the electrical transmission line to the machine, follow your company’s approved lockout/tagout procedures which should include, but are not limited to the steps here.

1. Engage an E-stop on the machine.
2. Turn the disconnect switch handle to the “off” position. See Figure SAFETY-1.
3. Attach a lock and tag that meet OSHA requirements for lockout/tagout.
4. Restrain or de-energize all pneumatic components, hydraulic components, and other parts that could have live or stored power.

### WARNING

**ELECTROCUTION HAZARD.**

When the disconnect switch is off, there is still live power within the disconnect switch’s enclosure. Always turn off power at the building’s power source to the equipment before opening this electrical enclosure!

If working on the electrical transmission line to the machine, follow the procedure on page 9.
Figure SAFETY-1: Sample of a Lockout/Tagout Mechanism on an Electrical Enclosure

Sample of a Lock and Tag Attached to a Machine’s Electrical Enclosure
Figure SAFETY-2: Lockout/Tagout on Additional Equipment in the System

Auto Deck Enclosure
May be replaced with optional infeed equipment.
Power can also be disconnected using saw’s main disconnect switch.

Powered Skewed Conveyor Enclosure
(optional equipment)

Main Pneumatic Filter/Regulator
- Located on right side of saw.
- Yellow plate is shown in lockout position. Place lock and tag through holes in yellow plate.
- Pneumatic lines will bleed naturally when yellow plate is in lockout position.
- Ensure gauge reads 0 before performing replacing a supply bottle for the printer or performing any maintenance!
When Working on a Machine Inside the Machine’s Main Electrical Enclosure or in the Electrical Transmission Line to the Machine

Before opening the main electrical enclosure, or attempting to repair or replace an electrical transmission line to the machine, lockout/tagout the machine properly. Follow your company’s approved lockout/tagout procedures which should include, but are not limited to the steps here.

1. Engage an E-stop on the machine.

2. Shut the power to the machine off at the machine’s power source which is usually an electrical service entry panel on the facility wall. One example of a locked-out power source panel is shown in Figure SAFETY-3.

3. Attach a lock and tag that meets OSHA requirements for lockout/tagout.

4. Open the door to the enclosure in which you need access, and using a multimeter, verify that the power is off.

Figure SAFETY-3: Sample of a Lockout/Tagout Mechanism on a Power Source Panel
Hydraulic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required
If working on components other than the hydraulic system, but that requires you to be near the vicinity of movable hydraulic components, you must, at a minimum, physically restrain the hydraulic components from moving. If this is not possible, lockout/tagout the entire hydraulic system.

When Lockout/Tagout is Required
Before attempting repair or performing maintenance on a hydraulic line or component, lockout/tagout the machine properly. Follow your company’s approved lockout/tagout procedures.

Pneumatic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required
If working on components other than the pneumatic system, but that requires you to be near the vicinity of movable pneumatic components, you must, at a minimum, physically restrain the pneumatic components from moving. If this is not possible, lockout/tagout the entire pneumatic system.

When Lockout/Tagout is Required
Before attempting repair or maintenance on a pneumatic line or component, lockout/tagout the machine properly. Follow your company’s approved lockout/tagout procedures.

Troubleshooting With an Energized Machine

Only a qualified electrician, using the personal protective equipment and following the procedures recommended in NFPA 70E should ever attempt service or repair of or near an energized area or component of the machine.

Whenever maintenance is performed while the equipment is electrically energized, there is a potential electric arc flash hazard. Refer to NFPA 70E for the personal protective equipment required when working with electrically energized components. Pneumatic and hydraulic components may move unexpectedly if not de-energized. Physically restrain any components capable of movement when working on or near those components.
Safety Tests

This test procedure MUST be performed by qualified personnel at startup and after ANY maintenance, adjustment, or modification. Testing ensures that the safety system and machine control system work together to properly stop the machine.

These test procedures MUST be performed by qualified personnel every day at startup and after ANY maintenance, adjustment, or modification. Testing ensures that the safety system and machine control system work together to properly stop the machine.

<table>
<thead>
<tr>
<th>![WARNING]</th>
<th>CRUSH AND CUT HAZARD.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![WARNING]</td>
<td>Before turning on the equipment, make sure that all personnel and equipment are clear.</td>
</tr>
</tbody>
</table>

Inspecting Indicators

1. While performing any of the following safety tests, check to ensure the Blade In Motion light located on the operator interface panel lights up when the blade is running.

2. While performing any of the following safety tests, check to ensure the beacon on top of the main electrical enclosure lights up when cutting is taking place.

3. Verify that all safety labels are present and legible.
Testing the E-stop Pushbuttons and Pull-Cords

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
</table>
| CRUSH AND CUT HAZARD.  
Before turning on the equipment, make sure that all personnel and equipment are clear. |

1. Start running the saw and all integrated components:
   a) Power up the saw using the instructions on page OP-134.
   b) Press the RESET button on the saw’s operator interface panel.
   c) Start any optional infeed and outfeed equipment. To start the Powered Skewed Conveyor, refer to page OP-158.
   d) Press the Saw Motor START button on the saw’s operator interface panel to start the motor.
   e) Wait approximately 5 seconds, until the blade is up to full speed.

2. Prepare a stopwatch to time how long it takes for the saw blade to stop.

3. Activate any one of the E-stops listed here and measure the time between pressing the E-stop and when the blade comes to a complete stop.
   - Pushbutton on saw’s operator interface panel
   - Pushbutton on main electrical enclosure
   - Pushbutton on Auto Deck operator interface
   - Pull-cord on Infeed Rail

4. Ensure that the blade and integrated components stop motion in a timely manner:
   - If the saw blade does not stop within 5-10 seconds, contact MiTek Machinery Division Customer Service immediately for resolution.
   - If all integrated components do not stop in a timely manner, lockout/tagout the entire wood processing system and arrange for a qualified service technician to troubleshoot and repair the equipment.
   - If the blade and integrated components stop as expected, repeat the procedure to test all E-stops listed in step 3.
Testing Movement While E-stop is Active

<table>
<thead>
<tr>
<th>![Warning Icon]</th>
<th>WARNING</th>
</tr>
</thead>
</table>
| CRUSH AND CUT HAZARD.  
Before turning on the equipment, make sure that all personnel and equipment are clear. |

1. Use the touch screen to manually move an axis.

2. Watch the axis that was chosen to see if it moves. Because an E-stop is activated, no movement should occur.

3. If movement does occur, Lockout/Tagout immediately and repair the problem.
Testing E-Stops for Optional Equipment

<table>
<thead>
<tr>
<th></th>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Warning Icon]</td>
<td>CRUSH AND CUT HAZARD.</td>
</tr>
<tr>
<td></td>
<td>Before turning on the equipment, make sure that all personnel and equipment are clear.</td>
</tr>
</tbody>
</table>

Test E-stops for all optional equipment. The procedure below applies to the Powered Skewed Conveyor only.

1. Ensure that the Powered Skewed Conveyor’s disconnect switch is in the ON position.

2. Ensure all system E-stops and safety devices are reset.

3. Turn the selector switch located on the Powered Skewed Conveyor to the START position and release the switch. The conveyor will begin movement.


5. Ensure that the Powered Skewed Conveyor, saw, and all peripheral equipment stop motion.

6. If any piece does not stop, lockout/tagout and arrange for a qualified service technician to repair the equipment.
Testing Interlocked Doors

Certain doors are interlocked with the E-stop system and should not open when certain parts are in motion.

1. Test that the **SAW CHAMBER DOOR** interlock is functioning by performing this procedure:

   a) Turn the saw blade on (see step 1 on page SAFETY-12).

   b) Attempt to open the saw chamber door while pressing the *Request to Unlock* button (see page OP-112 and page OP-113).
      
      • The door should NOT open while the saw blade is running.

   c) Press the STOP button.

   d) Watch the lights on the operator interface panel.
      
      • A red *Blade In Motion* light should be illuminated when blade is moving.
      • A green *Blade Motion Stopped* light should illuminate when blade stops.

   e) Wait until the blade stops spinning, then attempt to open the saw chamber door again as described in step 1b.
      
      • The door should open now.

   f) With the door open, attempt to start the blade by pressing the green *START* button on the saw’s operator interface panel.
      
      • The blade should NOT move.

---

**WARNING**

**CRUSH AND CUT HAZARD.**

Before turning on the equipment, make sure that all personnel and equipment are clear.
g) Resolve any inconsistencies:

1) If the door opens while the blade is still moving OR the blade spins with the door open, lockout/tagout the saw and arrange for a qualified service technician to repair the equipment.

2) If the indicator lights are not behaving as expected, replace the bulb or repair the light.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUT AND CRUSH HAZARD.</td>
</tr>
<tr>
<td>Never attempt to stop the saw blade with your hand or a hand-held object.</td>
</tr>
</tbody>
</table>

There may be instances when access is given to the saw chamber while the saw blade is coasting at a speed less than 5 RPM. This is normal and not a cause for alarm. Do not force the blade to stop.

2. Test that the STROKE/ELEVATION CHAMBER DOOR interlock is functioning by performing this procedure:

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRUSH AND CUT HAZARD.</td>
</tr>
<tr>
<td>Before turning on the equipment, make sure that all personnel and equipment are clear.</td>
</tr>
</tbody>
</table>

a) Open the stroke/elevation chamber door (see page OP-112 and page OP-113).

b) Ensure that the E-stop circuit is not engaged (no E-stops active).

c) Attempt to manually move either the angle, elevation, or stroke axis (refer to instructions in step 1 on page SAFETY-13).

* The axis should NOT move while a door is open.

d) If an axis moves while the door is open, lockout/tagout the saw and arrange for a qualified service technician to repair the equipment.
Restricted Zone

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stay out of the restricted zone when equipment is in use. Serious injury or death may result if personnel are in the restricted zone.</td>
</tr>
<tr>
<td>Always look for personnel in the restricted zone before operating equipment.</td>
</tr>
</tbody>
</table>

Know the Restricted Zone: Shown in Red
Marking the Restricted Zone

The restricted zone must be marked so everyone near the equipment can clearly see the area where danger may exist.

MiTek offers Restricted Zone Tape that is easy to apply and has text in English and Spanish. Some equipment comes with restricted zone tape. If your machine did not come with restricted zone tape, you may order it from MiTek Machinery Division Customer Service.

Instructions for where and how to apply restricted zone tape can be found in the Installation Manual that came with your system or by obtaining Service Bulletin 181 from the MiTek Machinery Web site.
Safety Symbol Definitions

The safety symbols shown in this section can be found throughout the manual to indicate hazards that are related to this equipment. All personnel expected to operate or maintain this equipment should become familiar with these safety symbols and what they mean.

This is the Electrical Hazard Symbol. It indicates that there are dangerous high voltages present inside the enclosure of this product and/or that a power source is present. To reduce the risk of fire or electric shock, do not attempt to open the enclosure or gain access to areas where you are not instructed to do so. Refer servicing to qualified service personnel only. This product should be operated only from the type of source indicated on the manufacturer’s identification label. Installation should be in compliance with applicable sections of the national electric code. Consult your local building code before installing.

This is the user caution symbol. It indicates a condition where damage to the equipment resulting in injury to the operator could occur if operational procedures are not followed. To reduce the risk of damage or injury, refer to accompanying documents, follow all steps or procedures as instructed.

Hot surface! Surface temperature can exceed greater that 70°C during normal operation. Do not touch.

Ventilation - Slots and openings in the cabinet are provided for ventilation and to ensure reliable operation of the product. To protect the unit from overheating, those openings must not be blocked or covered. This product should not be placed in a built-in installation, such as a wall cutout, unless proper ventilation is provided. Hot temperatures will result.

Operation of this equipment may result in flying debris and excessive noise. To reduce the risk of injury, wear only approved PPE.
Crush hazard! Keep hands clear.

Keep hands away from moving parts.

High pressure hose. Use appropriate PPE when working on equipment. Maintain safe pressure levels at all times.

Hydraulic hose is under great pressure. Use safe operating procedures at all times.

Equipment produces loud noise in excess of 100 DBA during operation. Use appropriate hearing protection when in vicinity of this equipment.

Crush hazard from above

Caustic chemicals used in this area. Use appropriate PPE.
Slip hazard! Use of approved footwear is required.

Keep hands clear of cutting parts.
Keep hands and body clear.
The operation of this equipment requires the use of PPE.
Do not operate without wearing required protective clothing.
Refer to manual - After installation, read the user's guide carefully before operating. Follow all operating and other instructions carefully.

Circuits are live - Lockout/tagout the upstream power source.

Lockout in a de-energized state

Lift Point - In order to reduce the likelihood of damage to the equipment, use only the lift points indicated in the manual.

Read all safety warnings and instructions before proceeding.
Two- or three-man lift required to safely move this equipment. Refer to installation manual.

Hazardous moving parts are located behind this access panel. Do not operate this equipment without all guards and covers in place.

Do not place containers with liquids such as coffee, water, sodas, etc. on this unit.

Do not operate this equipment in a wet environment.

Do not expose to water

No lift point. Do not lift this device with a hook/crane assembly. Damage to the equipment will be incurred. Refer to the installation instructions.
Do not use non-approved lubricants in this machine.

Unauthorized persons are not allowed beyond this point.

Do not operate without guards and covers in place

Do not discard into municipal waste stream

oil drop
Declaration of Safety Conformity

Conforms Electrically to:

- NFPA 79
- NEC Electrical code
- Electrical enclosures carry UL508A and the CUL for Canada
- Safety circuit conforms to Category 4 redundant monitoring

Conforms Mechanically to:

- 10CFR 1910
- ANSI B11.19
Treatment for Hazardous Substances

**WARNING**

PRINTER INK AND CLEANER IS HIGHLY FLAMMABLE!
Keep away from extreme heat, sparks, or open flame.
No smoking near these substances.

---

**Table SAFETY-1: General Safety Data**

<table>
<thead>
<tr>
<th>Primary Hazards</th>
<th>Printer Ink</th>
<th>Printer Cleaner</th>
<th>Most Hydraulic Fluid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flammable</td>
<td>Flammable</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Method of extinguishing fire**

<table>
<thead>
<tr>
<th>Printer Ink</th>
<th>Printer Cleaner</th>
<th>Most Hydraulic Fluid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcohol-resistant foam, carbon dioxide, dry powder, water fog-NOT water</td>
<td>Alcohol-resistant foam, carbon dioxide, dry powder, water fog-NOT water</td>
<td>Water fog, foam, dry chemical, or carbon dioxide</td>
</tr>
</tbody>
</table>

**Protective Equipment**

<table>
<thead>
<tr>
<th>Gloves</th>
<th>Goggles</th>
<th>Eyewash station</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Goggles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Eyewash station</td>
</tr>
</tbody>
</table>

---

**Table SAFETY-2: How to Treat Contact With a Hazardous Substance**

<table>
<thead>
<tr>
<th>If Substance Gets On...</th>
<th>Then Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Ink</strong></td>
<td><strong>Printer Cleaner</strong></td>
</tr>
<tr>
<td>Skin/Clothing</td>
<td>Rinse, remove clothing, then wash skin w/soap</td>
</tr>
<tr>
<td>Hair</td>
<td>Wash with soap and water</td>
</tr>
<tr>
<td>Eyes</td>
<td>Flush with water</td>
</tr>
<tr>
<td>Ingested</td>
<td>Do NOT induce vomiting</td>
</tr>
<tr>
<td>Inhalation</td>
<td>Move to fresh air</td>
</tr>
</tbody>
</table>
Sea cuidadoso.
Protéjase.
Indicadores de seguridad: Palabras de aviso

Las siguientes palabras y colores de aviso se utilizan a lo largo de este documento para indicar riesgos de seguridad. Preste suma atención cuando los vea. El nivel de gravedad es diferente por cada palabra o color de aviso.

Las palabras de aviso van acompañadas por gráficos que muestran al personal lo que deben y no deben hacer. Los gráficos se llaman símbolos de seguridad y se definen en la página 56, pero se proporciona un texto más específico cada vez que se utiliza un gráfico por todo el manual. Todas las personas que estén cerca de una máquina tienen que ser capacitadas en cómo leer estos indicadores de seguridad.

No cumplir las instrucciones que acompañan cada palabra de aviso puede producir daños a la propiedad, lesiones personales e incluso la muerte. El personal debe seguir todos los procedimientos y prácticas de seguridad establecidos para asegurar el uso más seguro posible de este equipo. No obstante, en ningún caso este documento reemplaza el sentido común. El personal debe asegurarse de que el entorno de trabajo sea seguro y esté libre de distracciones.

<table>
<thead>
<tr>
<th>PELIGRO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indica una situación potencialmente peligrosa que, si no se evita, podría producir la muerte o lesiones graves.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ADVERTENCIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indica una situación potencialmente peligrosa que, si no se evita, podría producir la muerte o lesiones graves.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PRECAUCIÓN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indica una situación potencialmente peligrosa que, si no se evita, puede producir lesiones menores o moderadas.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AVISO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Llama la atención a información importante para entender la operación que se desea realizar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AMBIENTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Se aplica a condiciones que pueden afectar el entorno pero que no tienen un efecto inmediato o directo sobre el personal o el equipo.</td>
</tr>
</tbody>
</table>
Reglas de seguridad para el equipo de general

Debido a la imposibilidad de anticipar todas las circunstancias que podrían constituir un riesgo, la información de seguridad suministrada en este manual del equipo y sobre la máquina no es exhaustiva. Si se utiliza o realiza el mantenimiento de esta máquina utilizando un procedimiento no recomendado específicamente por el fabricante, el procedimiento deberá ser aprobado por un ingeniero profesional para asegurarse de que no afecte la seguridad del equipo. ¡Manéjese siempre con suma precaución y sentido común!

Conozca su equipo

• Lea este manual en su totalidad antes de utilizar o mantener el equipo. No utilice esta máquina a menos que esté perfectamente familiarizado con los controles, los dispositivos de seguridad, los frenos de emergencia y los procedimientos operativos que se describen en este manual.
• Lea y siga todas las notas de seguridad. El no cumplimiento de estas instrucciones podría producir pérdidas económicas, daños a la propiedad y lesiones personales, incluida la muerte.
• Refiérase a las pautas de bloqueo/etiquetado proporcionadas en las siguientes páginas para realizar el mantenimiento y solucionar problemas de este equipo en forma segura.
• Observe y cumpla con todas las etiquetas de seguridad. Cambie las etiquetas gastadas inmediatamente.
• Utilice este equipo únicamente para el propósito que se describe en este manual.
• Sólo personal calificado debe intentar utilizar o realizar el mantenimiento de este equipo. Por "personal calificado" se entiende:

...una persona o personas que, por el hecho de poseer un título o certificado de capacitación profesional reconocido o que, por sus amplios conocimientos o experiencia, han demostrado con éxito estar capacitados para resolver problemas relacionados con el tema y el trabajo en cuestión—ANSI B30.2-1983

...una persona que posee habilidades y conocimientos relacionados con la construcción y uso de equipos e instalaciones eléctricas y que ha recibido capacitación en seguridad sobre los riesgos posibles—NEC 2002 Handbook

Seguridad personal

• Use siempre lentes de seguridad y protección auditiva en un entorno industrial.
• Utilice una máscara protectora cuando trabaje cerca de aserrín.
• Utilice ropa adecuada y equipo de protección personal apropiado (por ejemplo, lentes de seguridad y protección auditiva.) No use ropa suelta ni joyas. Si tiene el cabello largo, átelo para atrás.
• Proceda con precaución cuando levante piezas o materiales pesados.
Instalación del equipo

• Siga las instrucciones de instalación al pie de la letra.
• No utilizar este equipo en zonas residenciales.

Procedimientos de Bloqueo/Etiquetado

• Antes de realizar el mantenimiento de los sistemas neumáticos o hidráulicos, purgue las líneas para eliminar la presión.
• Bloquee y etiquete todos los sistemas energizados antes de realizar tareas de mantenimiento en ellos. Refiérase a la sección Pautas de bloqueo/etiquetado en la página 34.

Cómo mantener un entorno seguro

• Mantenga alejados a los niños. Todos los visitantes deben mantenerse a una distancia segura del área de trabajo. Los riesgos pueden no ser evidentes a las personas no familiarizadas con la máquina.
• Mantenga las áreas de trabajo bien iluminadas.
• Mantenga el área de trabajo limpia y libre de cualquier riesgo de tropiezo o resbalamiento.
• No utilice el equipo en lugares húmedos o mojados y no lo exponga a la lluvia o a la nieve.
• Minimice las nubes de polvo y proteja su equipo quitando el polvo de la siguiente manera:
  • Aspire el polvo antes de soplarlo con aire
  • Apague la alimentación eléctrica y todas las fuentes de ignición
  • Si usa aire comprimido, debe ser a compresión baja (no más de 15 psi)
  • El equipo eléctrico de limpieza como las aspiradoras debe cumplir con los códigos del gobierno local para uso en condiciones polvorientas.

Uso y mantenimiento del equipo

• Asegúrese de que no haya personas, herramientas y objetos extraños en las zonas restringidas antes de utilizar este equipo. Las zonas restringidas se indican en la página 48.
• Realice pruebas de seguridad para verificar que todos los frenos de emergencia funcionen adecuadamente antes de utilizar el equipo por primera vez, después de realizar cualquier tarea de mantenimiento y según la frecuencia de mantenimiento establecida.
• En caso de que la máquina no funcione correctamente, deténgala inmediatamente utilizando un freno de emergencia e informe el problema a un supervisor.
• No deje nunca la máquina encendida si no está junto a ella. ¡Apáguela! No la abandone hasta que todas las piezas se detengan completamente y hasta que se haya apagado la alimentación eléctrica.

• Verifique periódicamente que no haya piezas gastadas o dañadas. Repárelas o cámbielas inmediatamente.

• Mantenga los sistemas hidráulicos, neumáticos y eléctricos en buen funcionamiento en todo momento. Repare las fugas y las conexiones sueltas inmediatamente. No exceda nunca la presión ni potencia eléctrica recomendadas.

• Verifique que todos los dispositivos de seguridad estén en buen funcionamiento antes de comenzar de cada turno. Todos los dispositivos protectores y de seguridad deben estar en su lugar antes y durante el uso de la máquina. No desconecte ni evite nunca ningún dispositivo de seguridad ni interbloqueo eléctrico.

• Solo el personal de mantenimiento calificado puede quitar o instalar los dispositivos de seguridad.

• Inspeccione periódicamente la calidad del producto terminado.

**Seguridad eléctrica**

• No utilice líquidos en el interior de los gabinetes eléctricos.

• Cuando utilice disolventes sobre o alrededor de la máquina, desconecte la alimentación para eliminar las probabilidades de chispas, que pueden producir una explosión o incendio. Use un respirador aprobado para el uso con disolventes. Use ropa protectora, guantes y lentes de seguridad.
Bloqueo/Etiquetado

Pautas de bloqueo/etiquetado

Deben cumplir con todas las pautas de bloqueo/etiquetado conforme a la norma OSHA 29 CFR 1910.147. El programa de control de energía de la compañía debe incluir un procedimiento específico. El objetivo de este manual no es reemplazar el procedimiento de desenergización o bloqueo/etiquetado requerido por la OSHA, sino proporcionar pautas orientativas generales.

El término "bloqueo", según se utiliza en este manual, se refiere a la colocación de un dispositivo de bloqueo en las fuentes de energía para asegurar que el dispositivo aislador de energía y el equipo controlado por éste no puedan reenergizarse o utilizarse hasta que se retire dicho dispositivo.

Las fotos de la página siguiente muestran los lugares en los que se encuentran los interruptores de desconexión eléctrica de esta máquina.

- Las fuentes de energía incluyen energía eléctrica, mecánica, hidráulica, neumática, química, térmica y otras.
- En el caso de fuentes de energía eléctrica, la alimentación principal y la alimentación de control a la maquinaria deben apagarse y bloquearse físicamente en la posición "off" (apagado).
- Por lo general, como dispositivo de bloqueo se utiliza un candado con llave.
- Si hay más de una persona trabajando en una zona restringida, utilice un dispositivo de bloqueo grupal que permita a cada persona utilizar un candado que sólo pueda ser retirado por la persona que realiza el mantenimiento.

"Etiquetado" significa que debe colocarse una advertencia fácil de ver en un dispositivo aislador de energía que indique que el equipo no debe utilizarse.

Siempre que vea este símbolo, ¡Bloquee/Etiquete!
Procedimientos de bloqueo/etiquetado eléctricos

Cuando trabaja en una máquina fuera del gabinete eléctrico principal de la máquina

Si trabaja en la línea de transmisión eléctrica a la máquina, siga el procedimiento de la página 38.

Antes de realizar el mantenimiento de cualquier máquina con alimentación eléctrica, bloquee y etiquete la máquina de forma adecuada. Cuando trabaje en una máquina fuera del gabinete eléctrico principal de la máquina, salvo en el caso de trabajos en la línea de transmisión eléctrica a la máquina, siga los procedimientos de bloqueo/etiquetado aprobados por la compañía, los cuales deberían incluir, entre otros, los pasos aquí indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Coloque el mango del interruptor con fusibles en la posición "apagado/apagada". Vea la page SEGURIDAD-36.

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/etiquetado de la OSHA.

4. Trabe o desenergice todos los componente neumáticos, componentes hidráulicos y otras piezas que tengan alimentación directa o almacenada.
En la plataforma automática Auto Deck se corta la corriente cuando se apaga el interruptor de desconexión principal de la sierra en Figura SEGURIDAD SEGURIDAD-1.

La opción de la banda transportadora eléctrica con rodillos sesgados cuenta con un control de apagado eléctrico con el interruptor de desconexión principal de la sierra, pero aún existe la conexión trifásica.

El interruptor de desconexión principal de la sierra no afecta al sistema de recuperación de madera.
Filtro/regulador neumático principal
(ubicado del lado derecho de la sierra)

- Se encuentra del lado derecho de la sierra.
- La placa amarilla se muestra en posición bloqueada. Coloque el bloqueo y la etiqueta a través de los orificios en la placa amarilla.
- Las mangueras neumáticas sangrarán de manera natural cuando la placa amarilla se encuentre en posición de bloqueo.
- Verifique que la lectura del indicador sea 0 antes de reemplazar un frasco de suministro para la impresora o de realizar cualquier tipo de mantenimiento.

Caja de la plataforma automática Auto Deck
Se puede reemplazar con equipo opcional (guía de alimentación).
También es posible desconectar la electricidad usando el interruptor de desconexión principal de la sierra.

Caja de la banda transportadora eléctrica con rodillos sesgados (equipo opcional)
**Cuando trabaje en una máquina dentro del gabinete eléctrico principal de la máquina o en la línea de transmisión eléctrica a la máquina**

Antes de abrir el gabinete eléctrico principal o intentar reparar o reemplazar una línea de transmisión eléctrica a la máquina, bloquee y etiquete la máquina de manera adecuada. Siga los procedimientos de bloqueo/etiquetado aprobados por la compañía, los cuales deberían incluir, entre otros, los pasos aquí indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Apague la alimentación a la máquina en la fuente de alimentación, que, por lo general, es un panel de entrada de suministro eléctrico que se encuentra en una pared de las instalaciones. En la Figura SEGURIDAD 1 se muestra un ejemplo de panel de fuente de alimentación bloqueado.

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/etiquetado de la OSHA.

4. Abra la puerta del gabinete al que necesita acceder y usando un multímetro verifique que la alimentación esté apagada.

**Figura SEGURIDAD-1: Ejemplo de un mecanismo de Bloqueo/Etiquetado en un panel de fuente de alimentación**
Procedimiento de bloqueo/etiquetado del sistema neumático

Cuando no se requiere bloqueo/etiquetado

Si trabaja con componentes que no son del sistema neumático pero que requieren su presencia en la proximidad de componentes neumáticos móviles, debe, como mínimo, trabar físicamente estos componentes para que no se muevan. Si no es posible, bloquee/etiquete todo el sistema neumático.

Cuando se requiere bloqueo/etiquetado

Antes de intentar reparar o realizar el mantenimiento de una línea o componente neumático, bloquee/etiquete la máquina en forma apropiada. Siga los procedimientos de bloqueo/etiquetado aprobados por la compañía.

Solución de problemas con una máquina energizada

Sólo un electricista calificado que utilice el equipo de protección personal y siga los procedimientos recomendados en la norma NFPA 70E debe intentar realizar tareas de reparación o mantenimiento en un área o componente energizados de la máquina o en su proximidad.

Cada vez que se realizan tareas de mantenimiento mientras el equipo está eléctricamente energizado, existe un riesgo potencial de formación de un arco eléctrico. Consulte en la norma NFPA 70E el equipo de protección personal requerido para trabajar con componentes eléctricamente energizados. Los componentes neumáticos e hidráulicos pueden moverse de manera imprevista si no se desenergizan. Trabe físicamente cualquier componente que pueda moverse cuando deba trabajar en ellos o en su proximidad.
Pruebas de seguridad

Estos procedimientos de prueba DEBEN ser realizados por personal calificado durante la puesta en marcha todos los días y después de CUALQUIER tarea de mantenimiento, ajuste o modificación. Las pruebas permiten verificar si el sistema de seguridad y el sistema de control funcionan juntos y detienen la máquina de manera adecuada.

<table>
<thead>
<tr>
<th>![CAUTION]</th>
<th></th>
</tr>
</thead>
</table>
| **RIESGO DE APLASTAMIENTO Y CORTE.**  
Antes de encender el equipo, asegúrese de que todo el personal y el equipo estén alejados. |

Indicadores de inspección

1. Mientras realiza cualquiera de las siguientes pruebas de seguridad, inspeccione que la luz de cuchilla en movimiento situada por una interfaz del operador se encienda cuando la cuchilla esté funcionando.

2. Mientras realiza cualquiera de las siguientes pruebas de seguridad, inspeccione para asegurarse de que la luz en la parte superior de la caja eléctrica principal se encienda cuando se realizan los cortes.

3. Verifique que todas las etiquetas de seguridad estén presentes y sean legibles.
Pruebas de los botones pulsadores del freno de emergencia y las cuerdas de parada de emergencia

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>RIESGO DE APLASTAMIENTO Y CORTE.</td>
</tr>
<tr>
<td>Antes de encender el equipo, asegúrese de que todo el personal y el equipo estén alejados.</td>
</tr>
</tbody>
</table>

1. Comience haciendo funcionar la sierra y todos los componentes integrados:

   a) Encienda la sierra según las instrucciones de la página OP-134.
   
   b) Presione el botón RESET (reestablecer) en la interfaz del operador de la sierra.
   
   c) Arranque cualquier equipo opcional de alimentación y de salida. Para arrancar la banda transportadora eléctrica con rodillos sesgados consulte la página OP-158.
   
   d) Presione el botón START (Inicio) del motor de la sierra en la interfaz del operador de la sierra para que arranque el motor.
   
   e) Espere aproximadamente 5 segundos, hasta que la cuchilla avance a toda velocidad.

2. Prepare un cronómetro para medir el tiempo que tarda en detenerse la cuchilla de la sierra.

3. Active cualquiera de los botones pulsadores del freno de emergencia señalados aquí y mida el tiempo entre cuando presiona el botón y cuando la cuchilla se detiene completamente.

   - Botón en la interfaz del operador de la sierra
   - Botón por la caja eléctrica principal
   - Botón en la interfaz del operador de la plataforma automática (Auto Deck)
   - Cuerda de parada de emergencia en el riel en la guía de alimentación
4. Asegúrese de que la cuchilla y los componentes integrados detengan el movimiento de una manera oportuna:

- Si la cuchilla de la sierra no se detiene en un intervalo de 5 a 10 segundos, comuníquese de inmediato con Servicio al Cliente de la División de maquinaria de MiTek para que lo solucionen.

- Si todos los componentes integrados no se detienen oportunamente, realice procedimientos de bloqueo/etiquetado en todo el sistema de procesamiento de madera y pida a un técnico de servicio calificado que diagnostique y repare el equipo.

- Si la cuchilla y los componentes integrados se detienen como es de esperar, repita el procedimiento para probar todos los botones pulsadores del freno de emergencia señalados en el paso 3.
Prueba de movimiento mientras el botón pulsador del freno de emergencia está activo

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>RIESGO DE APLASTAMIENTO Y CORTE.</td>
</tr>
<tr>
<td>Antes de encender el equipo, asegúrese de que todo el personal y el equipo estén alejados.</td>
</tr>
</tbody>
</table>

1. Use la pantalla táctil para mover un eje manualmente

2. Observe el eje que eligió para ver si se mueve. Como está activado un botón pulsador del freno de emergencia, no debe haber movimiento.

3. Si hay movimiento, realice de inmediato los procedimientos de bloqueo/etiquetado y repare el problema.

An E-stop must be activated for this test be useful.
Prueba de los equipo opcional

<table>
<thead>
<tr>
<th>CAUTION</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>RIESGO DE APLASTAMIENTO Y CORTE. Antes de encender el equipo, asegúrese de que todo el personal y el equipo estén alejados.</td>
<td></td>
</tr>
</tbody>
</table>

Pruebe los botones pulsadores de paro de emergencia para todo el equipo opcional. El siguiente procedimiento se aplica solamente a la banda transportadora eléctrica con rodillos sesgados.

1. Asegúrese de que el interruptor de desconexión de la banda transportadora eléctrica con rodillos sesgados esté en la posición ON (encendido).

2. Asegúrese de que todos los botones pulsadores del freno de emergencia y los dispositivos de seguridad del sistema estén restablecidos.

3. Mueva el interruptor selector situado en la banda transportadora eléctrica con rodillos sesgados a la posición START (Iniciar) y suelte el interruptor. La banda transportadora comenzará a moverse.

4. Active un botón pulsador de freno de emergencia en la banda transportadora eléctrica con rodillos sesgados.

5. Asegúrese de que la banda transportadora eléctrica con rodillos sesgados, la sierra y todo el equipo periférico dejen de moverse.

6. Si alguna pieza no se detiene, realice los procedimientos de bloqueo/etiquetado y pida a un técnico de servicio calificado que repare el equipo.
Prueba de las puertas interbloqueadas

Ciertas puertas están interbloqueadas con el sistema de botón pulsador de freno de emergencia y no deben abrirse cuando ciertas piezas se estén moviendo.

1. Pruebe que el interbloqueo de la PUERTA DE LA CÁMARA DE LA SIERRA funcione realizando este procedimiento:

   a) Encienda la cuchilla de la sierra (vea el paso 1 en la página SEGURIDAD-41).

   b) Trate de abrir la puerta de la cámara de la sierra mientras presiona el botón Request to Unlock.
      • La puerta NO debe abrirse mientras esté funcionando la cuchilla de la sierra.

   c) Presione el botón STOP (alto).

   d) Observe las luces por la interfaz del operador.
      • Una luz roja debe estar encendida cuando la cuchilla se esté moviendo.
      • Una luz verde (Blade Motion Stopped) debe encenderse cuando se detenga la cuchilla.

   e) Espere hasta que la cuchilla deje de dar vueltas y luego trate de nuevo de abrir la puerta de la cámara de la cuchilla, como se describió en el paso 1b.
      • La puerta debe abrirse ahora.

   f) Con la puerta abierta, trate de arrancar la cuchilla presionando el botón START (Iniciar) verde en la interfaz del operador de la sierra.
      • La cuchilla NO debe moverse.
g) Resuelva cualquier incongruencia:

1) Si se abre la puerta mientras la cuchilla todavía está en movimiento O la cuchilla gira con la puerta abierta, realice los procedimientos de bloqueo/etiquetado en la sierra y pida a un técnico de servicio calificado que repare el equipo.

2) Si las luces indicadoras no se comportan como se esperaba, reemplace la bombilla o repare la luz.

<table>
<thead>
<tr>
<th>! CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RIESGO DE APLASTAMIENTO Y CORTE.</strong></td>
</tr>
<tr>
<td>Nunca trate de detener la cuchilla de la sierra con la mano o con un objeto que sostenga con la mano.</td>
</tr>
</tbody>
</table>

Podría haber casos en que se permita el acceso a la cámara de la sierra mientras la cuchilla de la sierra se desacelera a una velocidad menor de 5 RPM. Esto es normal y no es causa de alarma. No fuerce la cuchilla para que se detenga.
2. Pruebe que el interbloqueo de la PUERTA DE LA CÁMARA DE LA CARRERA/ELEVACIÓN funcione realizando este procedimiento:

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Warning Icon]</td>
</tr>
<tr>
<td>RIESGO DE APLASTAMIENTO Y CORTE.</td>
</tr>
<tr>
<td>Antes de encender el equipo, asegúrese de que todo el personal y el equipo estén alejados.</td>
</tr>
</tbody>
</table>

   a) Abra la puerta de la cámara de carrera/elevación (vea las páginas OP-112 y OP-113).

   b) Asegúrese de que el circuito del botón pulsador del freno de emergencia no esté acoplado (no hay botones pulsadores del freno de emergencia activos).

   c) Trate de mover manualmente el ángulo, la elevación o el eje de la carrera (consulte las instrucciones en el paso 1 de la página SEGURIDAD-43).

   • El eje NO debe moverse mientras una puerta esté abierta.

   d) Si se mueve un eje mientras la puerta está abierta, realice los procedimientos de bloque/etiquetado en la sierra y pida a un técnico de servicio calificado que repare el equipo.
Zona restringida

DANGER

Manténgase alejado de la zona restringida cuando el equipo esté en uso. Pueden producirse lesiones graves o incluso la muerte si el personal está en la zona restringida.

Siempre observe que no haya personal en la zona restringida antes de operar el equipo.

Conocer la zona restringida
Marcar la zona restringida

Deberá marcarse la zona restringida de manera que todas las personas cerca del equipo puedan ver claramente el área donde pueda existir peligro.

MiTek ofrece la cinta de zona restringida o “Restricted Zone Tape”, fácil de aplicar y con texto en inglés y en español. Algunos equipos traen la cinta de zona restringida. Si su máquina no trajo la cinta de zona restringida, puede pedirla a MiTek Machinery Division Customer Service (Servicio al cliente de la división de maquinaria de MiTek).

Puede encontrar las instrucciones sobre dónde y cómo aplicar la cinta de zona restringida en el manual de su mesa o pórtico incluido con su sistema o pedir el Service Bulletin Kit 181 en la página web de MiTek Machinery.

Información adicional

Para entender el circuito del freno de emergencia (Understanding the E-Stop Circuit) página MT-123

Definiciones de los símbolos de seguridad (Safety Symbol Definitions) página SAFETY-19
Introduction

This chapter explains how to navigate through the equipment manual and how to contact MiTek.

Introduction to the Manual

<table>
<thead>
<tr>
<th>![WARNING]</th>
<th>Read this manual completely before using this equipment!</th>
</tr>
</thead>
<tbody>
<tr>
<td>![WARNING]</td>
<td>Do not operate this machine until you have a thorough understanding of all controls, safety devices, emergency stops, and operating procedures outlined in this manual.</td>
</tr>
<tr>
<td>![WARNING]</td>
<td>All hazard instructions must be read and observed. Failure to do so may result in economic loss, property damage, and/or personal injury.</td>
</tr>
<tr>
<td>![WARNING]</td>
<td>This manual must always be available to personnel operating and maintaining this equipment.</td>
</tr>
</tbody>
</table>

Purpose and Scope of This Equipment Manual

In order for this Equipment Manual to be useful, it must be accessible. It is structured so the Operation Manual can be kept at the machine and the Maintenance and Installation Manuals can be kept somewhere accessible by maintenance personnel only.

This manual addresses the most recent versions of the date on the title page. For earlier revisions, contact MiTek Machinery Division.

This manual can be a valuable tool for training.

- The Introduction and General Information chapters contain information on truss terminology and provide basic information about the equipment.
- The Operation Manual teaches operators how to efficiently operate the machine.
- The Maintenance Manual is written specifically for maintenance personnel.
- The appendices provide valuable training materials and technical information.
Figure 1-1: Overview of System
Understanding This Manual

The Equipment Manual (or Manual Set)

This equipment manual is a set of three (3) books. The part number for the entire set is 001080. The manuals listed in Table 1-1 are all part of the equipment manual (also called the manual set).

The page numbers include a prefix so it is clear in which book a page can be found when using cross-references. The Safety (SAFETY) and Introduction (INTRO) sections have their own prefix because they are found in all three books.

Table 1-1: Manual Set

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Page # Prefix</th>
<th>Description</th>
<th>Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book 1: Operation Manual</td>
<td>OP</td>
<td>Includes operation procedures and defines the control user interface</td>
<td>001080-OP</td>
</tr>
<tr>
<td>Book 2: Maintenance Manual</td>
<td>MT</td>
<td>Includes preventive maintenance, repair maintenance, troubleshooting, parts list, drawing set list, and glossary</td>
<td>001080-MT</td>
</tr>
<tr>
<td>Book 3: Installation Manual</td>
<td>IN</td>
<td>Includes requirements prior to installation, installation procedures, and startup procedures.</td>
<td>001080-IN</td>
</tr>
</tbody>
</table>

Review the table of contents to understand the structure of the chapters and appendices.

The Drawing Set

The drawing set is included with this manual set. A list of the drawings can be found in the Maintenance Manual. The actual drawings are either in a separate 11x17 binder or in the back of the Maintenance Manual.

Screen Shots

See page OP-73 for software versions that the screen shots were taken from.
Navigation

The graphics in Table 1-2 are used throughout the manual to quickly communicate a specific type of information.

Table 1-2: Navigational Tools Used Throughout the Manual

<table>
<thead>
<tr>
<th>Graphic</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Important safety note!]</td>
<td>Indicates that you must lockout/tagout at the disconnect switch located on the equipment using approved methods described in OSHA 29 CFR 1910.147 before continuing with the procedure.</td>
</tr>
<tr>
<td>![Indicates tools required before beginning a procedure.]</td>
<td></td>
</tr>
<tr>
<td>![Provides additional information for the steps or text.]</td>
<td></td>
</tr>
<tr>
<td>![Indicates how to get to or from the item discussed.]</td>
<td></td>
</tr>
<tr>
<td>![Refers reader to another section, table, graphic, or drawing for further explanation.]</td>
<td></td>
</tr>
<tr>
<td>![Indicates that the part number is listed in the Parts List appendix.]</td>
<td></td>
</tr>
</tbody>
</table>

Formatting Cues

To follow the procedures in this manual, you must first understand the text formats used. Table 1-3 describes how to read the cues provided in this text.

Table 1-3: How to Read the Text Formats

<table>
<thead>
<tr>
<th>If Text Looks Like...</th>
<th>It Indicates...</th>
<th>Example in Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>All caps</td>
<td>Key on keyboard or button on screen</td>
<td>Press ENTER</td>
</tr>
<tr>
<td>Initial cap and italic</td>
<td>Menu or field or virtual button that you must find or select</td>
<td>Click on the File menu</td>
</tr>
<tr>
<td>Initial cap only, no italics</td>
<td>Menu or field or virtual button when simply referring to it</td>
<td>While in the Main Menu</td>
</tr>
<tr>
<td>Plus sign (+)</td>
<td>Hold buttons at the same time</td>
<td>CTRL+ALT+DELETE</td>
</tr>
<tr>
<td>Greater Than sign (&gt;)</td>
<td>Next selection</td>
<td>File&gt;Open</td>
</tr>
</tbody>
</table>
Additional Resources

Supplemental Documentation

In addition to the equipment manual, refer to the documentation provided by the original manufacturer for the parts that are listed in this section. The supplemental documentation is provided at the time of installation, or it may be found inside an electrical enclosure. Refer to these documents when you need more detailed information on these components than the MiTek manual provides.

There is a plastic bag or a box of material sent with each system. It includes a collection of paperwork detailing the technical components used in the system that are manufactured by a different company. Inside this collection you will find spare internal fuses for the servo amplifier.

**Board Stretcher Software Manual**

*Board Stretcher* software is an optimizing software independent of the *BLADE* equipment, but it integrates closely with the *BLADE* for the most efficient lumber usage. This manual mentions items that may appear to be controlled by the *BLADE* software but are actually controlled by *Board Stretcher*.

To obtain the *Board Stretcher* manual, each *Board Stretcher* operator should register on *MiTek University™* for the *Board Stretcher* training class. The Training Manual that accompanies the class is the official *Board Stretcher* manual. Once the class is complete, the attendee can always log back on and download or print the manual. Color copies may be requested from the *MiTek University* staff.

Web Site

Visit the MiTek Web site for up-to-date information on all MiTek equipment.

**Contacting Us**

For technical assistance or to order parts, contact the Machinery Division Customer Service Department using one of the methods listed in Figure 1-2.
Introduction to the Equipment

Purpose of the Equipment

The BLADE wood processing system is a fast, accurate, and economical method of cutting a wide array of components for wood truss manufacturing. It is capable of cutting lumber for virtually all of your roof truss, floor truss, and wall panel needs.

Description of the Equipment

The BLADE wood processing system can be called a saw, but it is so much more. It includes the following components:

- Lumber Feed System
  The component that takes the lumber, in the correct order, to the Infeed Rail. The BLADE comes with an Auto Deck staging conveyor, but there are optional lumber feed systems available for an even higher level of automation.

- Infeed Rail
  The component that feeds the lumber into the saw chamber, and knows exactly when to stop for each cut.

- Saw
  The component that prints identification data on each cut piece, cuts the board, and moves the cut pieces to the outfeed component or waste conveyor.

- Outfeed Component
  The component that finished parts eject onto. It may be an outfeed table or optional powered outfeed equipment.

See page OP-58 for an overview of the entire system. Refer to the Maintenance Manual for more detailed graphics.
Safety Compliance of the Equipment

Equipment shipped to a U.S. destination is compliant with NFPA 79, NEC 2009, and the applicable OSHA regulations. This manual covers the U.S. requirements.

Overview Graphics

Graphics Identifying Main Components

The following graphics will assist in understanding the parts of the system. Review them for equipment familiarity and refer to them for better understanding of the text throughout this manual.

Figure 2-1: MatchPoint BLADE Saw as Part of the Wood Processing System, Front and Right View
Figure 2-2: MatchPoint BLADE Saw as Part of the Wood Processing System, Right Side View (top) and Left Side View (bottom)
Figure 2-3: *MatchPoint BLADE* Wood Processing System

![Diagram of BLADE Wood Processing System](image)

- **Infeed Rail**
  - Can be replaced with optional equipment.
- **Auto Deck**
  - Can be replaced with optional equipment.
- **Saw**
- **Outfeed Table**
  - Can be replaced with optional equipment.

Graphic Showing Optional Equipment

Figure 2-4: Optional Powered Skewed Conveyor Attached to Saw

![Optional Powered Skewed Conveyor](image)
Graphics Identifying Axes and Home Positions

There are 6 major axes referred to on this equipment. Their definitions and home positions are shown in the following graphics. The axis number shown in Table 2-1 may be needed when troubleshooting.

Table 2-1: Identification Number for Each Axis

<table>
<thead>
<tr>
<th>Axis #</th>
<th>Axis Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gripper</td>
<td>Holds and pushes board along Infeed Rail.</td>
</tr>
<tr>
<td>2</td>
<td>LASM</td>
<td>Lumber Advance Short Move; holds and moves board while inside saw chamber.</td>
</tr>
<tr>
<td>3</td>
<td>Elevation</td>
<td>Raises and lowers saw blade.</td>
</tr>
<tr>
<td>4</td>
<td>Stroke</td>
<td>Moves saw blade in and out.</td>
</tr>
<tr>
<td>5</td>
<td>Angle</td>
<td>Turns saw blade for angle cuts.</td>
</tr>
<tr>
<td>6</td>
<td>Bevel</td>
<td>Turns the saw blade for bevel cuts.</td>
</tr>
</tbody>
</table>

Figure 2-5: Defining the Elevation and Stroke Axes: Side View of Saw
Figure 2-6: Defining the LASM Axis

LASM is at “0” when groove in LASM clamp aligns with blade.

View: Front of saw, from slightly above

LASM at “0”  LASM at Home

View: Front of saw, from slightly below, with guards removed

Figure 2-7: Defining the Gripper Axis

Infeed Rail Attaches to Saw

Gripper in Home Position
Figure 2-8: Defining the Bevel and Angle Axes

**BEVEL CUT**
Home = 90°
(0° is shown)

**ANGLE CUT**
Home = 90° (shown)
Main Components and Optional Equipment

Main Components on Every *BLADE* System

Table 2-2 lists the main components that comprise this system. All of these components are within the scope of this manual.

**Table 2-2: Main Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Operation Incl. in Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Deck, 4-strand, 16’</td>
<td>The lumber feed system that comes with every saw: a staging conveyor that transports the lumber (placed there by operator) and advances 1 piece at a time for automatic loading onto Infeed Rail. See Table 2-4 for optional lumber lengths. It can be replaced with an automated lumber retrieval system for additional handling and sorting capabilities. See Table 2-4.</td>
<td>yes</td>
</tr>
<tr>
<td>Infeed Rail 16’</td>
<td>Receives 1 piece of lumber and feeds it into the saw chamber. See Table 2-4 for optional lengths.</td>
<td>yes</td>
</tr>
<tr>
<td>Saw w/1 print head, operator interface, waste conveyor, angle cuts, and bevel cuts</td>
<td>Saw assembly where the cutting and printing occurs. Waste conveyor can be built for left or right offloading. See Table 2-3 for additional print heads, cutting features, and voltage options.</td>
<td>yes</td>
</tr>
<tr>
<td>Outfeed table</td>
<td>Steel-top table that receives the finished parts. It can be replaced with optional outfeed components including a Powered Skewed Conveyor. See Table 2-4.</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Optional Equipment and Features

#### Table 2-3: Optional Features on the Saw

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Operation</th>
<th>Incl. in Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transformer for voltages other than 230 volt.</td>
<td>If the site voltage is anything other than 230 volts, a transformer is necessary.</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Additional print heads (up to 3 total)</td>
<td>The standard saw comes with one face printer. May also purchase an additional edge-printing head, an additional face-printing head, or both. See page OP-67 for more information on printing options.</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>AGS</td>
<td>Assembly Guide System; prints joint and component locations and plates. Requires printer option B. See page OP-183 for sample.</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Wall Frame software</td>
<td>Software that adds the capability to cut wall frame components.</td>
<td>no</td>
<td></td>
</tr>
</tbody>
</table>

#### Table 2-4: Optional Components and Features for Material Handling

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Operation</th>
<th>Incl. in Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>20-ft Infeed Rail</td>
<td>Handles boards 4 ft longer than the standard 16-ft.</td>
<td>same as standard</td>
<td></td>
</tr>
<tr>
<td>20-ft Outfeed Table</td>
<td>Handles boards 4 ft longer than the standard 16-ft.</td>
<td>same as standard</td>
<td></td>
</tr>
<tr>
<td>Additional lumber lengths for Auto Deck</td>
<td>For handling board lengths longer than 16’ or shorter than 6’.</td>
<td>same as standard</td>
<td></td>
</tr>
<tr>
<td>Auto Deck strand length</td>
<td>Longer strands are available on the Auto Deck</td>
<td>same as standard</td>
<td></td>
</tr>
<tr>
<td>Automated lumber retrieval system</td>
<td>A lumber retrieval system that picks the correct lumber and delivers it, in order, to the Infeed Rail.</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Powered Skewed Conveyor</td>
<td>A powered conveyor with skewed guides; replaces the standard outfeed table. Available in 16-ft or 20-ft lengths. RH model discharges toward operator. LH model discharges away from operator.</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Incline waste conveyor</td>
<td>Works with the saw waste conveyor to move waste up an incline to reach the top of a dumpster.</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Integrated waste conveyor</td>
<td>Several shapes and sizes available to move waste from the saw to the point of waste removal.</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Second Monitor</td>
<td>Allows a second monitor for displaying truss/part data and production metrics. See page OP-64.</td>
<td>yes</td>
<td></td>
</tr>
</tbody>
</table>
Outfeed System Descriptions

Several outfeed systems are available to facilitate sorting and moving the cut lumber off the saw and to the assembly tables. Talk to a MiTek representative to discuss the best option for your space and workflow. Several are listed in Table 2-4, but additional options may be available for a higher degree of automation.

Dust Extraction Methods

Two ports are provided for dust extraction from the saw chamber. It is highly recommended that a dust extraction method is used during operation. Refer to the Prior to Installation chapter in the Installation Manual for recommendations.

Second Monitor Feature

Some systems have an optional second monitor feature for truss/part data and production metrics to display. The feature integrates with the BLADE software to provide the data to the output ports. It does not include the monitor itself or the mounting of the monitor. When purchasing a monitor for this use, it is highly recommended to obtain the specifications listed here:

- Recommended screen size: 65”
- Supported screen resolution: 1920x1080
- Ports required: HDMI

To activate the second monitor in the BLADE software, refer to the Operations chapter.
Auto Deck Description

The Auto Deck is an automated staging conveyor that is part of the BLADE wood processing system’s lumber feed system. It is unique from the rest of the infeed system in that it can be replaced with an optional upgrade. This manual assumes an Auto Deck is present, and to understand its instructions, the following information may be useful.

The Auto Deck is made up of strands, each housing a conveyor chain. A standard system that carries lumber 6 to 16-ft long uses 4 strands. The strands run perpendicular to the Infeed Rail. A board must rest on at least 2 strands to travel forward to the Infeed Rail. Table 2-5 shows the Auto Deck designs that are currently available.

### Table 2-5: Auto Deck Specifications Currently Available

<table>
<thead>
<tr>
<th>Conveyor Length</th>
<th>Lumber Size</th>
<th>Number of Strands</th>
<th>Auto Deck Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>6’</td>
<td>6’ - 20’</td>
<td>5</td>
<td>89596-901</td>
</tr>
<tr>
<td>10’</td>
<td>4’ - 16’</td>
<td>5</td>
<td>89670-901</td>
</tr>
<tr>
<td>10’</td>
<td>4’ - 20’</td>
<td>6</td>
<td>89671-901(230V)</td>
</tr>
<tr>
<td>10’</td>
<td>4’ - 20’</td>
<td>6</td>
<td>89650-901 (AUS)</td>
</tr>
<tr>
<td>10’</td>
<td>6’ - 16’</td>
<td>4</td>
<td>89064-901</td>
</tr>
<tr>
<td>10’</td>
<td>6’ - 20’</td>
<td>5</td>
<td>89065-901</td>
</tr>
<tr>
<td>12’</td>
<td>6’ - 16’</td>
<td>4</td>
<td>89767-901</td>
</tr>
<tr>
<td>12’</td>
<td>6’ - 20’</td>
<td>5</td>
<td>89768-901</td>
</tr>
<tr>
<td>16’</td>
<td>6’ - 20’</td>
<td>5</td>
<td>89598-901</td>
</tr>
<tr>
<td>20’</td>
<td>4’ - 20’</td>
<td>6</td>
<td>89069-901</td>
</tr>
<tr>
<td>20’</td>
<td>6’ - 16’</td>
<td>4</td>
<td>89066-901</td>
</tr>
<tr>
<td>20’</td>
<td>6’ - 20’</td>
<td>5</td>
<td>89067-901</td>
</tr>
</tbody>
</table>
Figure 2-9: Sample of Auto Deck Dimensions for Select Models

Smallest Auto Deck
(89670-901)

- 11' 2-1/2"
- 2' 9"
- 1' 11"
- 13' 6-1/4"
- 11' 2-1/2"

Largest Auto Deck
(89067-901)

- 20' 7-1/2"
- 4' 8"
- 3' 2"
- 17' 6-1/4"
Printers Available

Table 2-6 lists the printers available for this equipment and the system ID that identifies each model. A printer dramatically improves communication and sorting of parts, reducing errors and time-consuming searches. All models are included in the scope of this manual. System A is included with the saw if no upgrade is ordered.

The number of nozzles (valves) is proportionate to the size of the print area. The more nozzles, the larger the print area. 16-nozzles for the front face (4-in. dimension of a 2x4), and 7 nozzles for the rear face and edge (2-in. dimension of a 2x4) is adequate for printing text and simple logos.

Table 2-6: Printer Models Available (also shown in the Printer Appendix)

<table>
<thead>
<tr>
<th># of Valves</th>
<th>16</th>
<th>7</th>
<th>7</th>
<th>Ideal Uses...</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID and Printing Location</td>
<td>Front</td>
<td>Rear</td>
<td>Edge</td>
<td></td>
</tr>
<tr>
<td>standard</td>
<td>A</td>
<td>X</td>
<td></td>
<td>Adds first level of communication</td>
</tr>
<tr>
<td>option</td>
<td>B</td>
<td>X</td>
<td>X</td>
<td>AGS (Assembly Guide System) for printing plate and joint locations</td>
</tr>
<tr>
<td>option</td>
<td>C</td>
<td>X</td>
<td></td>
<td>Depending on workflow, improves visibility of A</td>
</tr>
<tr>
<td>option</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>Wall panel printing</td>
</tr>
<tr>
<td>option</td>
<td>E</td>
<td>X</td>
<td>X</td>
<td>AGS+: Uses 2 print heads to print everything in B, plus plate outlines in correct location and basic graphics on the face-up side.</td>
</tr>
<tr>
<td>option</td>
<td>F</td>
<td>X</td>
<td>X</td>
<td>AGS+: Same as E, plus a 3rd print head to print on edge of board.</td>
</tr>
</tbody>
</table>

Learn more about the Printers starting on page OP-168.
Technical Specifications

General Specifications

Table 2-7: General Specifications

<table>
<thead>
<tr>
<th><strong>Lumber and Cut Capacity</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge of board</td>
</tr>
<tr>
<td>Face of board</td>
</tr>
<tr>
<td>Maximum length of board</td>
</tr>
<tr>
<td>Shortest length to exit saw chamber</td>
</tr>
<tr>
<td>Shortest length to enter saw via Auto Deck</td>
</tr>
<tr>
<td>Min. or max. length of cut</td>
</tr>
<tr>
<td>Number of angle cuts</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Speed and Axis Ranges</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear speed</td>
</tr>
<tr>
<td>Angular movement speed</td>
</tr>
<tr>
<td>Angle</td>
</tr>
<tr>
<td>Bevel</td>
</tr>
<tr>
<td>Elevation</td>
</tr>
<tr>
<td>Stroke</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Accuracy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length of cut</td>
</tr>
<tr>
<td>Angle of cut*</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Controls</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Mode or Manual Mode</td>
</tr>
<tr>
<td>VFD</td>
</tr>
<tr>
<td>Software for saw operation</td>
</tr>
<tr>
<td>Software for lumber optimization</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Printer</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print controller</td>
</tr>
<tr>
<td>Configuration</td>
</tr>
<tr>
<td>See page 67 for available configurations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Saw Blade</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter of blade</td>
</tr>
<tr>
<td>Blade motor</td>
</tr>
</tbody>
</table>
Table 2-7: General Specifications (Continued)

<table>
<thead>
<tr>
<th>Electrical</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>230 VAC</td>
</tr>
<tr>
<td></td>
<td><em>Transformer is required for other voltages.</em></td>
</tr>
<tr>
<td>Phase and frequency</td>
<td>3-phase, 60 Hz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pneumatics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>See page IN-28</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dimensions of System Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>See page IN-24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight of System Components</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>See page IN-30</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Safety</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance</td>
<td>NFPA and UL</td>
</tr>
<tr>
<td>Safety circuit</td>
<td>CAT4</td>
</tr>
<tr>
<td>Blade access</td>
<td>Chamber lockout w/dual redundancy</td>
</tr>
<tr>
<td>Blade stop time</td>
<td>5-10 seconds for E-stop</td>
</tr>
<tr>
<td></td>
<td>&lt;15 seconds for controlled stop</td>
</tr>
</tbody>
</table>
Environmental, Transportation, and Handling Specifications

Operating Temperature

This equipment will operate correctly in its intended ambient, between 41 degrees and 104 degrees Fahrenheit (between +5 degrees and +40 degrees Celsius).

Relative Humidity

This equipment will operate correctly within an environment at 50% RH (relative humidity), 104 degrees Fahrenheit (+40 degrees Celsius). Higher RH may be allowed at lower temperatures.

Measures shall be taken by the Purchaser to avoid the harmful effects of occasional condensation.

Transportation and Storage

This equipment will withstand, or has been protected against, transportation and storage temperatures between -13 degrees and 131 degrees Fahrenheit (between -25 degrees and +55 degrees Celsius) and for short periods up to 158 degrees Fahrenheit (+70 degrees Celsius). It has been packaged to prevent damage from the effects of normal humidity, vibration and shock.

Do not discard machinery into municipal waste stream.
Truss Terminology

Table 2-8: Truss Terminology

<table>
<thead>
<tr>
<th>Length Types</th>
<th>Height Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall length</td>
<td>H1  Board height</td>
</tr>
<tr>
<td>Centerline length</td>
<td>H2  Centerline height</td>
</tr>
<tr>
<td>Top length</td>
<td>H3  Centerline height</td>
</tr>
<tr>
<td>Bottom length</td>
<td>H4  Centerline height</td>
</tr>
</tbody>
</table>

Figure 2-11: Terminology Diagram
Figure 2-12: Parts of a Truss

- Bottom Chord Length
- Overhang
- Peak
- Cantilever
- Top Chord
- Heel
- Web
- Splice
- Wedge Block
- Slope (Pitch)
Introduction to the Software

BLADE Software Overview

The BLADE software, controlled from the saw’s operator interface, controls the BLADE wood processing system. Unlike other saws, the system dictates production rates, but the operator must understand the software to get the desired results. Operating procedures start on page OP-135, but this chapter gives an overview of the software.

Most BLADE software screen shots in this manual are taken from software version 4.1.2.0. Later software versions may vary slightly.

Board Stretcher Software Overview

Board Stretcher™ is additional software used by this equipment, but it may be loaded on a computer in the front-end offices instead of on the saw. It allows lumber optimization and automatic material handling to occur before sending the cut files to the saw. See the Board Stretcher Training Manual and free online training course located on MiTek University (as of early 2017).

Reports Software Overview

The Reports software is an additional piece of software that integrates with the BLADE software and Board Stretcher optimizing software. It gives the operators and managers additional tools to pull production reports from the system’s memory. An overview of the Reports software starts on page OP-103. See the Reports Software Training Manual and free online training course located on MiTek University (as of late 2017).

Tips & Tricks & Terminology for Using the Software

Refer to page OP-132.
**BLADE Software Home Screen**

**Overview of Home Screen**

The Home Screen is the main screen where the operators spend most of their time. It shows data for each part to be cut and provides access to all of the functionality required during normal production use. Figure 3-1 shows each section of the Home Screen.

**Figure 3-1: Home Screen Sections**

Clicking on a menu often opens up a new window. To return to the previous screen, you may need to cancel or close the new window.

**Introduction to the Main Menus**

**Figure 3-2: Main Menus and Ribbon for File Menu**

The tabbed menus at the top of the Home Screen are shown in Figure 3-2. Their location on the Home Screen is labeled *Main Menus* on page OP-74. Throughout this manual, they are referred to as the Main Menus. The area under the Main Menus displays different choices for each menu and is called the ribbon or ribbon choices. The Main Menus and ribbon choices are described in detail starting on page OP-85.
Status Indicators on Home Screen

The status indicators are shown on page OP-74. Table 3-1 gives a brief overview of each status indicator’s purpose. If any status indicator is red, that component is not ready. To determine why a status indicator is lit or a component is not ready, select the indicator to display a second menu or additional data. More details can be found in the Detailed Diagnostics screen.

Table 3-1: Status Indicators on Home Screen

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Component Description or Text Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Banner</td>
<td>Long indicator area directly above the Cut List window that displays one of the following, depending on the overall saw status: Not Ready/Ready/Clearing Saw/Active/Press Reset</td>
</tr>
<tr>
<td>Linear Bearing Oil</td>
<td>Linear bearings need oil added when indicator is red</td>
</tr>
<tr>
<td>Angle</td>
<td>Servo axis; turns the blade for angle cuts</td>
</tr>
<tr>
<td>Bevel</td>
<td>Servo axis; turns the blade for bevel cuts</td>
</tr>
<tr>
<td>Elevation</td>
<td>Servo axis; raises and lowers the blade assembly</td>
</tr>
<tr>
<td>Gripper</td>
<td>Servo axis; moves the gripper on the Infeed Rail</td>
</tr>
<tr>
<td>LASM</td>
<td>Servo axis; moves the LASM assembly that carries the boards through the saw chamber</td>
</tr>
<tr>
<td>Stroke</td>
<td>Servo axis; moves the blade forward/backward (in/out)</td>
</tr>
<tr>
<td>Clamps</td>
<td>Side clamp and top clamp on infeed side of saw</td>
</tr>
<tr>
<td>Load Arms</td>
<td>Load arms, located on Infeed Rail</td>
</tr>
<tr>
<td>Infeed Rail</td>
<td>Infeed Rail, including gripper</td>
</tr>
<tr>
<td>Doors/E-Stops</td>
<td>Indicates if saw chamber door and stroke/elevation door are closed and locked and all E-stops released</td>
</tr>
<tr>
<td>Auto Deck or automated feed system</td>
<td>The lumber feed system</td>
</tr>
<tr>
<td>Blade</td>
<td>Saw blade rotation</td>
</tr>
<tr>
<td>Printer</td>
<td>The printer(s), located on infeed end of saw</td>
</tr>
<tr>
<td>Outfeed</td>
<td>Outfeed clamp and lumber exit chain</td>
</tr>
<tr>
<td>CLS (Crooked Lumber Sensor)</td>
<td>Measurement: Amount elevation is adjusted to compensate for crooked lumber Square Cut: No CLS adjustment needed even if board is crooked LASM Covering: LASM covers CLS so CLS is not used Board Not Covering: Position or length of board prevents it from reaching the CLS</td>
</tr>
<tr>
<td>Machine</td>
<td>Shows errors found in the Machine tab under Diagnostics&gt;Detailed Diagnostics, including E-stops, waste conveyor, and Auto/Manual Mode switch. Additional troubleshooting must be done using Diagnostics which requires administrative permissions.</td>
</tr>
</tbody>
</table>
Overview of Toolbar Buttons

The Toolbar stays active at all times on the Home Screen, although some buttons may be grayed out when not available.

Table 3-2: Toolbar on Home Screen

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>START CUTTING begins feeding lumber into the saw chamber and cutting. Saw motor must</td>
</tr>
<tr>
<td>be turned on manually first. The button turns to STOP CUTTING while saw is actively</td>
</tr>
<tr>
<td>cutting.</td>
</tr>
<tr>
<td>STOP CUTTING stops the auto cutting sequence AND turns off the saw blade motor after</td>
</tr>
<tr>
<td>the last cut on the active board is complete.</td>
</tr>
<tr>
<td>HOME SYSTEM places all axes in their home positions.</td>
</tr>
<tr>
<td>CLEAR CUTLIST &amp; IMPORT imports a new job file and clears previous jobs out of the job</td>
</tr>
<tr>
<td>queue. (To import jobs without deleting previous jobs, go to File&gt;Import Jobs.)</td>
</tr>
<tr>
<td>CLEAR BOARD QUEUE erases the record of what the infeed system already has in queue</td>
</tr>
<tr>
<td>(usually the next 1-4 boards to be cut).</td>
</tr>
<tr>
<td>LUMBER YARD is described on page OP-77.</td>
</tr>
<tr>
<td>MANUAL BOARDS LIST displays the boards required for this job.</td>
</tr>
<tr>
<td>KEY-IN PART allows parts to be added to the Cut List or remainders list. See page</td>
</tr>
<tr>
<td>OP-78.</td>
</tr>
<tr>
<td>Non-Productive Time section allows the operator to indicate what the saw is doing</td>
</tr>
<tr>
<td>when it’s not running. See page OP-147.</td>
</tr>
<tr>
<td>Board Length indicates the length of the board needed to make the planned cuts, and</td>
</tr>
<tr>
<td>the actual length of the active board. The actual board must be equal to or longer than</td>
</tr>
<tr>
<td>the board needed.</td>
</tr>
<tr>
<td>CLS Status indicates the lumber crookedness measured by the CLS.</td>
</tr>
<tr>
<td>Clears all software errors and allows the saw to continue running (if safe).</td>
</tr>
</tbody>
</table>
Lumber Yard

*lumber*: a group of boards or a non-specific board
*board*: a specific piece of lumber required by the saw to cut out specific parts; lumber becomes a board when the software decides exactly how to use it
*lumber feed system*: any system that feeds lumber to the Infeed Rail; usually the Auto Deck staging conveyor or a lumber retrieval system
*station*: a physical location on a lumber retrieval system

The Lumber Yard is where the operator can see the lumber required for the active job, and assign specific lumber to specific stations in the lumber feed system.

The bottom half of the screen is the **Lumber Inventory**. It is a list of the lumber the software has used before so it knows what station or manual assignment it has and that it will fill the requirements for certain lumber in the active job. The top half of the screen is the **Required Lumber**. It shows lumber required for the job but the software is uncertain where it is located in the lumber feed system.

- To assign a Required Lumber to a specific spot in the Lumber Inventory, just drag it down and drop it on the desired station.
  - For a manually loaded lumber feed system, such as the Auto Deck, the software views all lumber as manual and it doesn’t matter what device ID each lumber type has. There is no need to make specific assignments.
  - For automated feed systems, the virtual lumber must be assigned to the station where the actual lumber is located.
- To change a lumber assignment, press the CLEAR button in the row of the assigned lumber inventory.
- To choose the number of Lumber Inventory rows displayed, go to *Tools>Options>Material Handling*.

**Figure 3-4: Lumber Yard Screen**

For additional details on how to use the Lumber Yard, refer to the Board Stretcher Training Manual.
Key-In Part

The KEY IN PARTS button is the only Toolbar button that requires further explanation that is not addressed elsewhere. It displays the part Key-In dialog and allows parts to be added to the Cut List or remainders list.

The Key-In Select screen shown in Figure 3-5 contains specific part types to choose from. Double-click the part type that looks most like the part that needs to be cut.

The next window displays a list of possible places to get the lumber from.
If using an Auto Deck, there will not be a choice of how to load the board.

Figure 3-5: Key-In Select Screen

The Key-In screen shown in Figure 3-6 allows the operator to specify the details of the part. Clicking on one of the parts in Figure 3-5 opens the Key-In screen. Enter the required information.

- If using a lumber feed system that allows stations to be chosen, the Grade, Stock Size, and Stock Length will be populated for boards being loaded from a station.
- If a manual board is selected, the operator fills in the following fields: Lumber Grade, Stock Size, Overall Length, Stock Length, Chord, and Crown.
Most fields in the Key-In screen are populated according to the part you chose on the Key-In Select screen, but many of the fields can be modified, including adding a bevel.

If entering dimensions, one of the cuts must be calculated to ensure correct cutting of the part.

- VALIDATE AND DRAW PART updates the part based on the information entered.
- ADD TO REMAINDERS adds the part to the remainder list.
- ADD TO CUT LIST adds the part to the current Cut List.
- RIP BEVEL allows the operator to set the short side to a specific dimension in order to create specifically-sized blocks or boards that are not in a Job file.
The Cut List Screen

Cut List Column Headings

Figure 3-7: Cut List Column Headings

The Cut List column headings are shown in Figure 3-7. Table 3-3 gives a brief overview of each column’s purpose. More detail is given in subsequent pages.

Table 3-3: Cut List Column Headings on Home Screen

<table>
<thead>
<tr>
<th>On-Screen Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board</td>
<td>The index of the board (the identity or order of the board in that job).</td>
</tr>
<tr>
<td>File</td>
<td>For boards, it is the name of the file that the boards were imported from. For parts, it is the order that the part will be cut in.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Displays an image of the cut part.</td>
</tr>
<tr>
<td>RB/EB</td>
<td>Signifies that there is a rip bevel (RB) or end bevel (EB) on the board.</td>
</tr>
<tr>
<td>Status</td>
<td>Complete: The board or part has been cut. In Process: The part is being cut. Queue: The part is loaded onto the load arms located on the Infeed Rail. Rejected: The part will not be cut. Infeed: A board in the job that has not been processed.</td>
</tr>
<tr>
<td>Source/Job-Truss.Desc.</td>
<td>For boards, it is where the board will be loaded from. For parts, it shows the job name, truss description, and part description</td>
</tr>
<tr>
<td>Grade</td>
<td>Grade of board</td>
</tr>
<tr>
<td>Size</td>
<td>Board dimensions. For example: 2x4 (for Imperial units), or width of the board in millimeters (for metric)</td>
</tr>
<tr>
<td>Length</td>
<td>Length of board and overall length of the parts.</td>
</tr>
<tr>
<td>Select Board Arrow</td>
<td>Click the arrow to choose Current Board, Top of List, or Bottom of List.</td>
</tr>
<tr>
<td>(right-click)</td>
<td>Right-click on any board or part in the Cut List to see an additional set of menu choices.</td>
</tr>
<tr>
<td>(double-click)</td>
<td>Double-click on any board or part in the Cut List to see the Database View window, giving additional data on each board, part, and job with graphical representation.</td>
</tr>
<tr>
<td>(left-click)</td>
<td>Click any heading with graphic next to it to resort the list by the values in that column.</td>
</tr>
</tbody>
</table>
Tips & Tricks for Using the Cut List

Columns with symbols are sortable by clicking on the heading name.

Table 3-4: Sample Cut List, Home Screen

<table>
<thead>
<tr>
<th>Board</th>
<th>Fib</th>
<th>Graph</th>
<th>BB</th>
<th>BB</th>
<th>Source / Job Title Doc.</th>
<th>Grade</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8750-4 / 26.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8750-4 / 30.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8750-4 / 30.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8750-4 / 30.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Cut List data changes for every job. It is a list of each part to be cut.

- Single-click on any column heading with arrows to sort the list by the heading metric. Click again to sort in the opposite order.
- Single-click on any column heading with ascending numbers to sort the list by the heading metric. Click again to sort in the opposite order.
- Single-click on Select Board arrow to choose the current board (see Figure 3-8).
- Single-click any part row (data for 1 part), and the part details display in the Cut List window shown in Figure 3-4.
- Double-click any row (data for 1 part or board), and the Database View screen appears, described on page OP-83. There are additional tabs within that window that display various details about the board, part, and job.
- Access the right-click menu on the Cut List by using the right-click method described on page OP-82.

Figure 3-8: Click the Select Board Arrow to Access This Menu
Right-Click Menu From Cut List

The term “right-click” describes the action when using a mouse, but a mouse is not required to operate the BLADE saw. You may also accomplish a “right-click” result by:

1. Select the board, part, etc. and release.
2. Place finger on selection again and hold it on the selection until a square outline appears.
3. Remove finger and the right-click menu appears.

When a board is right-clicked in the Cut List, most of the choices in Table 3-5 are available. When a part is right-clicked, fewer choices are available.

Table 3-5: Description of Right-Click Menus Choices

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Cutting Here</td>
<td>Skips previous boards in the Cut List and begins cutting with the selected board.</td>
</tr>
<tr>
<td>Cut</td>
<td>Use to cut a single board. Procedure is on page OP-143.</td>
</tr>
<tr>
<td>Redo</td>
<td>Cuts the selected board or part again. The stock length is chosen in the Redo window but must be adequate length.</td>
</tr>
<tr>
<td>Reject</td>
<td>Rejects the current board so it will not be cut. A rejected line is highlighted in red and moved toward the top of the Cut List.</td>
</tr>
<tr>
<td>Reject Series</td>
<td>Rejects a series of boards listed consecutively in the Cut List as chosen by the operator. See page OP-130 for selecting a series.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the current board so it can be re-cut.</td>
</tr>
<tr>
<td>Reset Series</td>
<td>Resets a series of boards listed consecutively in the Cut List as chosen by the operator. See page OP-147 for selecting a series.</td>
</tr>
<tr>
<td>Add To Queue</td>
<td>Adds the current board to the material handling queue.</td>
</tr>
<tr>
<td>Remove From Queue</td>
<td>Removes the current board from the material handling queue.</td>
</tr>
<tr>
<td>Add to Remainders</td>
<td>Only available when a part is selected (not a board). Add the selected part to the Remainders list. See page OP-97 to view the Remainders list.</td>
</tr>
</tbody>
</table>
Database View (Parts Data and Visual Representation)

Access the Database tabbed screens by double clicking any board or part on the Cut List. The Database screens are not visible on the Home Screen, but because they are a vital piece of the BLADE software, they are discussed in their own section here.

The information shown in the Database screens are pulled from the Jobs database when jobs are sent to the saw. All information needed for the saw to cut each part is stored in the Jobs database.

Figure 3-9: Diagnostics>Database>Board Tab

Figure 3-10: Diagnostics>Database>Part Tab

Rotate the part in a 3-D view by moving your finger (or cursor) vertically across the part.
Figure 3-11: Diagnostics>Database>Job Tab

Figure 3-12: Diagnostics>Database>All Boards Tab
Saw Menus in Detail

File Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Jobs</td>
<td>Allows files to be imported to Cut List. See Figure 3-13.</td>
</tr>
<tr>
<td>Jobs Stats/Delete</td>
<td>Allows parts to be deleted from Cut List.</td>
</tr>
<tr>
<td>Log In</td>
<td>Only required if site management sets it up in Tools&gt;Options or if needing technical or administrative permissions. See page OP-134 for an overview on login requirements.</td>
</tr>
<tr>
<td>Log Out</td>
<td>Can alternate between operator, technical, or administrator level permissions by logging out the current user. Log back in using the Log In icon.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the program.</td>
</tr>
</tbody>
</table>

File>Import Jobs

Figure 3-13: File>Import Jobs Screen

- The different network choices are actually different default folders on the network that are commonly used for storing job files. If none of the folders are the location needed, the operator can browse to any folder on the network by selecting GET FILES.

The address to the default folders can be changed in Tools>Options>File Import with Administrator or Technician permission levels.
## Diagnostics Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort Cutting Sequence</td>
<td>Cancels current cutting sequence.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Displays an image of the saw components and active board at any point in time. The image changes as the position of the components move. Must be selected before choosing START CUT. See page OP-87.</td>
</tr>
<tr>
<td>Logs</td>
<td>Allows detailed information of each part or board to be displayed, including print information.</td>
</tr>
<tr>
<td>Detailed Diagnostics</td>
<td>Brings up a set of tabbed menus for specific components. The data here can be viewed by anyone, but administrator or technician permissions is needed to change some fields.</td>
</tr>
<tr>
<td>Air Cut</td>
<td>For troubleshooting purposes; tells the system to function even though the sensors are not detecting boards to cut. Automated feed systems are not included in the operation during Air Cut. Click on the checkbox to turn on or off. Places a yellow Air Cut band across the START CUTTING button when the feature is on.</td>
</tr>
</tbody>
</table>

## Diagnostics>Abort Cutting Sequence

Use the *Abort Cutting Sequence* icon on the *Diagnostics* ribbon if the saw becomes unresponsive due to PLC miscommunication. Abort the cutting sequence and the saw will be ready for the next action. After selecting *Abort Cutting Sequence*, the software asks how to handle the board that was just active.
Diagnostics>Visualize

The Visualizer is a valuable tool for troubleshooting and operating the saw. It can be accessed any time. If the blade or any axis is moving, movement will also be seen in the Visualizer window.

This window shows exactly what the saw is doing in “almost” real time. The speed of the Visualizer window can be adjusted with the slider bar at the bottom of the screen to facilitate troubleshooting. The board data for the board shown in the Visualizer window is indicated at the bottom of the screen also.

Figure 3-14: Diagnostics>Visualize Screen

Diagnostics>Air Cut

A checkbox on the Diagnostics Ribbon activates Air Cut. The Air Cut feature allows the saw to operate as it would in Automatic Mode, but without a saw blade or lumber present. It is intended for testing and maintenance. When Air Cut is active, a yellow banner appears over the normal START CUTTING button on the Home Screen.

Figure 3-15: Air Cut On
Diagnostics>Logs

Logs > Complete Log Displays a log of all logged items. This log includes all logged information.

Logs > Import Log Displays a log of all of the imported job files.

Logs > Run Log Displays a log of changed constants, and operator messages.

Logs > Error Log Displays a log of all errors.

Figure 3-16: Diagnostics>Logs Menu

The Logs menu gives several different choices for the type of report desired. The Complete Log report is shown in Figure 3-17 because it includes everything in all of the other reports.

Figure 3-17: Diagnostics>Logs>Complete Log Screen
Diagnostics>Detailed Diagnostics Menu

Do not change numeric data on these screens unless a MiTek technician instructs you to change them! The technicians set them at installation and they should not need to be changed again. Many of the buttons will be used frequently during troubleshooting, but numerical data should remain untouched.

The Detailed Diagnostics screen is invaluable for troubleshooting. Although it falls under the Diagnostics Main Menu, it is given its own section here because of the depth of information required to understand this menu choice. The saw must be in Manual Mode to adjust most settings in Detailed Diagnostics.

Each component or axis controlled by the saw’s PLC has its own set of tabbed menus on this screen. When the tab is clicked, the tabbed area turns white. Each tab’s screen is divided in half. The top half has technical information and settings. The bottom half is primarily measurements and feedback for that component or axis.

The top half and bottom half are locked together by default. Every time a top tab is clicked (made active), the bottom half of the screen changes to match the tab above. But, clicking the bottom tabs do not automatically change the active top tab. This allows you to browse the information in the bottom half of the screen without losing sight of the data in the top half of the screen.

Each tab set is shown in the screen shots that follow. Some tips to understanding the data on these screens are:

- A blue box indicates that the setting is active or in an ON state.
- An orange box indicates that the setting is inactive or in an OFF state.
- Other symbols are defined in Diagnostics>Detailed Diagnostics>Help tab.
- Many of the fields can not be accessed in Auto Mode. Place the saw in Manual Mode using the selector switch on the saw’s operator interface panel.
- The CLEAR Z button that is located on the bottom half of the tabs controlled by servo motors is the only selectable setting on the bottom half of the screens. It can be used to manually clear the stored Z pulse, but recalibration is a safer way to accomplish this. The Z pulse measures the counts from the home sensor to the motor encoder’s Z pulse. See page OP-160 to calibrate any or all of the axes instead of using this button.

The home Z-pulse value does not need to be monitored or mechanically reset to be in the 30000 to 100000 range since the BLADE software 4.0 and higher no longer uses the Z-pulse on the most of the servo axes.
Clamps in Detailed Diagnostics

Figure 3-18: Clamps Tab in Detailed Diagnostics

- Clamp and unclamp the gripper, LASM, outfeed clamp, top clamp, and side clamp here.
- Raise and lower the load arms.
CLS in Detailed Diagnostics

Figure 3-19: CLS Tab in Detailed Diagnostics

- Enable *Elevation Following* to test if the elevation changes as the bottom of a board raises to different heights above the CLS. The saw chamber door must be closed when doing so.

- The *Calibrate* button on the *Detailed Diagnostics>*CLS* screen is for Admin use only. To calibrate the CLS, use the *Tools>*Calibrate* menu.

- The CLS uses ultrasonic wavelengths to determine the location of the bottom of the board. Because temperature can affect these wavelengths, a thermometer is located in the upper-right corner of the saw chamber. The thermometer must be working for the PLC to process all incoming data correctly.
Servo Screens in Detailed Diagnostics

This section covers all of the *Detailed Diagnostics* tabbed screens for servo axes, which includes the following: Angle, Bevel, Elevation, Gripper, LASM, Stroke.

**Figure 3-20: Angle Tab in Detailed Diagnostics**

*Move Parameters* section:

These buttons select which parameters to use when manually moving a servo axis for troubleshooting purposes. Click the appropriate button as described here, then select MOVE or CYCLE to move the axis to the location indicated.

- The MANUAL button is active by default when the *Detailed Diagnostics* screen opens. It moves the axis at half the normal (auto) speed. When this button is active, type in specific parameters in the numbers fields, then select MOVE or CYCLE.
- The FROM HOME and TOWARDS buttons contain the parameters that were most recently used in Auto Mode. The axis moves at full speed when one of these buttons are active and the MOVE or CYCLE button is chosen.

*Configuration* section:

- To view the default settings, click RESET TO DEFAULT. This does not reset the values, but it turns anything yellow that is not default so it can be viewed. Each value can be changed manually at this point by typing in the desired numbers or you can choose to accept all the defaults. This should be done sparingly, as some changes may negatively affect unwanted areas. It is best to manually change only the fields that are needed.
- When the values are correct, click SAVE TO CONFIG to apply them.
Saw Blade in Detailed Diagnostics

Figure 3-21: Saw Blade Tab in Detailed Diagnostics

- When the saw is in Manual Mode and the saw motor is running, it can be stopped using the STOP button shown in Figure 3-21.
Printer in Detailed Diagnostics

Figure 3-22: Printer Tab in Detailed Diagnostics

- The Dot Size and Time of Flight are set in Tools>Options>Printers.
- PRINTER CONTROLLER and PRINTER POWER ON/OFF buttons only apply while the Diagnostics window is open. They default to ON when the window is closed. To run boards without printing, turn the printer(s) off in Tools>Options>Printers. The saw may need to be in Manual Mode for some items in this area to be active.
- To flush the print heads, see page OP-176 in the Printer appendix.
- The Print to Send section allows data to be printed on a single board using the SEND PRINT button. If any of the buttons are grayed out, the saw is not in the correct status. Correct the status before attempting to send a print string.

To send a print string for 1 board only:

1) Select the GRIPPER button in the Encoder section.
2) Type the text in the Print to Send field.
3) Click SEND PRINT.
4) Select the Gripper tab in the Diagnostics>Detailed Diagnostics screen to manually move the gripper (with a board in the infeed rail) towards the outfeed.

   The board should be in front of the print head before the trigger is turned on. Printing will start immediately when the gripper starts to move. The gripper encoder should be selected as well.
5) Click ON in the Trigger section.
Machine in Detailed Diagnostics

Figure 3-23: Machine Tab in Detailed Diagnostics

- All Status Lights settings must be in the ON position during normal operation so the beacon operates correctly. This section is for testing purposes only.
- Turn the waste conveyor on or off in the Machine tab. Note that it automatically comes on and off in Auto Mode.
- The General Errors section shows if a component or axis has a positive status. An orange box shows which components have an error.
- Orange boxes in the Emergency Stops section shows which E-stops are activated and must be reset.
- Use the Cycle Test section to move the servos to their min and max positions and exercise the clamps. It saves the number of cycles and time so they are not lost on program shutdown. Press START (under Cycle Test) to start the cycle. Press the same button (it changes to STOP) to end the cycle.

Figure 3-24: Emergency Stops on Machine Tab

Indicates the safety motion sensor needs to be reset by pressing the blue RESET button.

Indicates the E-stop on the operator interface needs to be released.

Active E-stops are also listed on the Doors/E-Stops indicator on the Home Screen.
Help in Detailed Diagnostics

The Help tab gives technical indicators and data that may be of assistance during troubleshooting.

Auto Deck in Detailed Diagnostics

Figure 3-25: Auto Deck Tab in Detailed Diagnostics

- Manually manipulate the Auto Deck staging conveyor from this screen.
Material Handling Menu

View Remainders  See page OP-97
Reset All Boards  Resets all boards in the Cut List.
Reject All Boards  Rejects all boards in the Cut List.
Lumber Report  Displays an inventory pick list for boards used.

Material Handling > View Remainders

Remainders are parts that are cut out of the waste on boards and kept for future use. Commonly used parts can be programmed into the BLADE software, and anytime there is room for that part on a waste piece, the software prints its ID, cuts it, and exits it. View Remainders shows the remainder list and allows the operator to manage the list and each part’s option. To add a new Remainder part, see page OP-146.

Once in the remainder list, the following can be done:

- Click the checkbox under Leading Waste to cut remainders planned for the leading edge of the board. Active remainders in the list will be cut from the leading edge waste (when available).
- Click the checkbox under Trailing Waste to cut remainders planned for the trailing edge of the board. Active remainders in the list will be cut from the trailing edge waste (when available).
- To change the priority, click the part and follow the instructions on the screen to move it up or down the list.
- To make a part inactive or active, click the part and select the CHANGE ACTIVATION button (or double click the Yes or No).

Figure 3-26: Material Handling>View Remainders Screen

Place longer parts near the top of the priority list. If there isn’t enough room to cut that part, the saw will attempt to cut the next part in the list.

Waste is placed at the leading edge of the board as long as there is at least 1 part on the board over 2 ft long. If all parts on the board are shorter than 2 ft, waste is placed at the trailing edge.
Material Handling > Reset All Boards and Reject All Boards

 Resets or Rejects all boards in the active job so the job can be started over or skipped.

 An operator may reset or reject specific boards (using right-click menu) after resetting or rejecting all boards.

Material Handling > Pick List

Displays a list of boards necessary to process the current job. It is grouped by grade and size.

To view the boards in the order they will be cut, use the MANUAL BOARDS LIST button on the Toolbar.

Figure 3-27: Material Handling>Pick List Screen
Tools Menu

- **Pre-Calibration Boards**: Use specific boards and cuts to aid in calibration.
- **Calibrate**: Allows the servos, printer, and CLS to be auto-calibrated.
- **Options**: See Tools > Options subheading on page OP-100.
- **Backup Configuration**: Backs up the current configuration of the saw to a date-time stamped file.
- **Restore Configuration**: Restores the configuration of the saw from a previously backed up configuration.
- **Configuration**: Advanced function to change configuration items. Should not be used under normal circumstances.
- **Company Information**: Allows the company information to be entered which autofills some fields when contacting technical support through the Help Menu.
- **Current Shift Reports**: Provides production data, board usage, and non-productive time data per shift.

Tools > Pre-Calibration Boards

There are specific parts and boards programmed into the BLADE software to assist in determining which axes may need to be calibrated. Click the Pre-Calibration Boards choice on the Tools ribbon, and follow the on-screen instructions to use the pre-programmed boards before beginning the calibration procedure.

**Figure 3-28: Tools>Pre-Calibration Boards Screen**

Tools > Calibrate (See page OP-160)
Tools > Options

The Tools>Options selection displays a dialog box with multiple tabs that allows the saw configuration to be changed. Table 3-6 describes the purpose of each tab. The printer tab is described in more detail in the pages that follow.

Table 3-6: Summary of Tabbed Menus for Tools>Options

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>View the saw’s name and included options, enable the top clamp, and when to stop cutting.</td>
</tr>
<tr>
<td>Material Handling</td>
<td>Choose the lumber feed system, the quantity of rows in the Lumber Yard inventory list, and timing choices for Auto Deck actions.</td>
</tr>
<tr>
<td>File Import</td>
<td>Set the folders jobs are imported from and what happens to files after import.</td>
</tr>
<tr>
<td>Cut List</td>
<td>Auto Track Row: Select how many rows down from the top of the Cut List window the black Auto Track Row outline stays. The Cut List does not automatically scroll, unless the SELECT CURRENT BOARD button is chosen on the Toolbar. Then, the list scrolls so the current board is in auto track row position. Redo parts: Select whether they are cut first or last.</td>
</tr>
<tr>
<td>Display</td>
<td>Choose language, unit of measurement (imperial vs. metric), define a square cut (default is 90 deg.), and enable a second monitor (named Second Display).</td>
</tr>
<tr>
<td>Backup</td>
<td>Choose folder for backup files to save in.</td>
</tr>
<tr>
<td>Security</td>
<td>Set password specifics.</td>
</tr>
<tr>
<td>Printers</td>
<td>Turn printers on and off, set distance to blade, set dot size and timing.</td>
</tr>
<tr>
<td></td>
<td>See more details in the Printers Tab in Options section starting on page OP-101.</td>
</tr>
<tr>
<td>Saw</td>
<td>Set the following:</td>
</tr>
<tr>
<td></td>
<td>• Edge detector photo eye</td>
</tr>
<tr>
<td></td>
<td>• Blade kerf (should be .210)</td>
</tr>
<tr>
<td></td>
<td>• Blade hub to bevel X</td>
</tr>
<tr>
<td></td>
<td>• Stock length tolerance</td>
</tr>
<tr>
<td></td>
<td>• Clearance to accept stock</td>
</tr>
<tr>
<td></td>
<td>• LASM width and height</td>
</tr>
<tr>
<td></td>
<td>• Blade diameter</td>
</tr>
<tr>
<td></td>
<td>• Blade effective cut length</td>
</tr>
<tr>
<td></td>
<td>• Max. board length (can not be changed)</td>
</tr>
<tr>
<td>Production</td>
<td>Set allowable idle time and shift start times.</td>
</tr>
</tbody>
</table>

NOTE: None of these settings should be changed until conferring with a MiTek technical representative.
Printers Tab in Options

- The *Dot Size* must stay between 15-27, but the recommended setting is 27.
- *Time of Flight* is the time it takes for an ink dot to get from the print head to the board. It is calculated during the calibration of the printer. Must stay between 0-200.
- If marks are not in the correct location (most important when marking component location on wall panels), increase the time of flight to print on the board earlier. Decrease the time of flight to print on the board later.

**Figure 3-29: Tools>Options>Printers Menu**

![Printers Menu.png](attachment:Printers_Menu.png)
Help Menu

View Help
Opens the Equipment Manual. Adobe Acrobat Reader may be required to view the manual. The manual is fully searchable using Acrobat search tools.

Remote Support
Links to a web site where MiTek can remotely troubleshoot. MiTek must provide login information before using this site.

Online Support
Links to the MiTek web site where specifications and other information can be found. MiTek may also instruct a user to go here for specific technical tools.

Contact Us
3 tabs provide support information:
- Contact tab provides MiTek Machinery technical support phone number and address.
- Report Problem tab allows free typing and attachments to be sent directly to MiTek Machinery technical support.
- Code tab shows code information.

Email Logs/Jobs/Configuration
Automatically sends this information to MiTek Machinery technical support, along with a typed message explaining the current situation.

Email Report Data
Automatically sends this information to MiTek Machinery technical support.

About
Displays the BLADE software version number.

Board Stretcher Software

For instructions on using our optimization software, refer to the Board Stretcher Software Training Manual located on MiTek University (as of early 2017).
Reports Software

The Reports software will soon have a new interface and a new training class and Training Manual. Look for it in 2017.

The Reports software is a software package that provides reports to help manage production on the saw. It is usually loaded on a computer in an office area for management purposes, but it can also be loaded on the saw’s computer. Request this software from your MiTek representative if it was not loaded on the saw at installation.

All production data is saved in a file named History.MDB and is located on the saw’s PC at C:\Program Files (x86)\MiTek\Blade\Config.

1. Browse to the correct folder holding past production data using the Select button in the Report Input Data box or by using File>Open. Once you browse to the correct folder the first time, that path remains the default path unless somebody changes it.

2. Select the dates the report should cover.

3. Enter the times and days the report should cover:
   a) Indicate the start time and end time of expected work. Break times are entered by the saw operator as they occur. This data will be used to determine percentage of time the saw was running compared to how long it COULD have been running.
   b) Select the days of the week to consider within the date range.

4. Select the type of report desired.
   *The Long analysis provides all of the information on the Short analysis, plus some additional data regarding the quantity of certain types of cuts.*

5. Click Show Report.

6. From the report screen, the file can be printed or exported to several different file formats.
Figure 3-30: Reporting Software Home Screen
This chapter describes the operating mechanisms on this equipment and the procedure to operate it in most circumstances.

### Safety Operating Notes

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ELECTROCUTION, HIGH PRESSURE, CRUSH, CUT, AND CHEMICAL HAZARDS!</strong></td>
</tr>
<tr>
<td>Read this section AND the safety section in the preliminary pages before operating or maintaining this equipment.</td>
</tr>
<tr>
<td>Do not operate this machine until you have a thorough understanding of all controls, safety devices, E-stops, and operating procedures outlined in this manual.</td>
</tr>
<tr>
<td>Read and observe all warnings. Failure to do so may result in economic loss, property damage, and/or personal injury.</td>
</tr>
<tr>
<td>This manual must always be available to personnel operating and maintaining this equipment.</td>
</tr>
<tr>
<td><strong>CRUSH AND CUT HAZARD.</strong></td>
</tr>
<tr>
<td>Before turning on the equipment, make sure that all personnel and equipment are out of the restricted zone (see page 17).</td>
</tr>
</tbody>
</table>
### WARNING

Do not operate unless all guards and safety devices are in place.
Only qualified maintenance personnel shall repair, remove, or replace guards and safety devices.

### CAUTION

The operation of this equipment requires the use of PPE.
Do not operate without wearing required protective clothing.

### NOTICE

If your saw has an electrical outlet located on the outside of the main electrical enclosure, do NOT use the electrical outlet for anything other than a computer for troubleshooting purposes. It is not sized to run hand equipment, radios, or other industrial equipment. Doing so will render the circuit inoperable.
E-Stops, Interlocks, and Indicators

Emergency stops (E-stops) immediately cease all movement on the saw system. This includes the Auto Deck, Infeed Rail, saw, and Powered Skewed Conveyor. It does NOT include other material handling systems, even those supplied by MiTek.

Note that power still exists for the following components and features after an E-stop is activated: touch screen computer, PLC (but not its outputs), sensors, indicator lights, and limited use of the beacon.

Do not use an E-stop as a standard stopping method during the operation procedure. Overuse might cause certain components to wear faster.

E-stops and their locations are shown on page OP-108 and page OP-109. Door latches interlocked with the E-stop system are shown on page OP-113. Each is described further in subsequent text.

After releasing an E-stop, the appropriate RESET button must be pressed before the system can resume operation.

To determine which E-stops or interlocks are active using the touch screen, click the *Doors/E-Stops* indicator on the Home Screen or see page OP-95.
Optional equipment may have an E-stop that is or is not integrated with the system. Each site must post signage to inform operators if this condition exists.
Figure 4-2: Typical E-Stop Locations on Optional Powered Skewed Conveyor

Location of the E-stops on the Powered Skewed Conveyor may vary depending on system configuration.
Activating an E-Stop

Because there are many components integrated together in the BLADE wood processing system, all E-stops cut off power to all standard components. These include the Auto Deck staging conveyor, Infeed Rail, and all moving parts of the saw. After-market options may not be integrated with the rest of the system. Each facility must have signage to identify E-stop systems.

**E-Stop Pushbutton**

A typical E-stop pushbutton is shown in Figure 4-3. To activate a pushbutton, push the entire red button in. To release a pushbutton E-stop, pull straight up on the pushbutton with a slight twist until it locks in place. Some early models do not require the twist.

**Pull-Cord (Perimeter Safety Cable)**

A pull-cord is an E-stop that has a cord that can be pulled anywhere along its length. There is a switch box on each end that shuts down the E-stop system when the tension on the cord increases. One (1) of the switch boxes on each pull-cord has a reset button.

Once a pull-cord is pulled, the red light on the pull-cord switch that was activated illuminates. Reset the E-stop circuit by turning the blue Reset button (located on the pull-cord switch) in the direction of the arrow. A pull-cord Reset button is labeled in Figure 4-4. The reset action must occur at the same switch that was activated.

See page MT-121 for instructions to adjust the tension of the pull-cord cable.
Restarting After an E-Stop is Activated

1. Reset all activated E-stops.
   - Refer to the section starting on page 107 to determine how to reset each E-stop and their locations.
   - A list of all E-stops and which ones need to be released or reset is shown by selecting the Doors/E-Stops indicator on the Home Screen.

2. Press the blue RESET button on the saw’s operator interface panel (see Figure 4-5) and/or at the E-stop location if present.

3. Continue with operation as normal. The operating procedure begins on page 135.
Interlocked Door Switches

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEVER TOUCH A MOVING SAW BLADE!</td>
</tr>
<tr>
<td>The saw blade may still have slight coasting motion when the interlocked doors are allowed to open.</td>
</tr>
</tbody>
</table>

The saw chamber and stroke/elevation chamber both have door switches that are interlocked with the electrical system to stop the appropriate movement before the door is opened. These are NOT tied into the E-stop circuit. Live power is still present to allow the following components to be moved when needed:

- Gripper clamp
- Side clamp
- Top clamp
- LASM clamp
- Outfeed clamp

**Saw Chamber Door Switch**

The saw chamber door is on the front of the machine and encloses the saw blade. Lights on the saw’s operator interface panel indicate if the blade is moving or stopped. When the blade stops, the Blade Stopped light illuminates, and the door can be opened. Refer to Figure 4-6 on page OP-113 and this procedure to open the door.

1. Stop the saw blade motion by pressing the STOP button.
2. Wait for the Blade Motion Stopped light to illuminate.
3. Press the Request to Unlock button and hold it in while pulling open the door.

**Stroke/Elevation Chamber Door Switch**

The stroke/elevation chamber door is located on the left side of the saw. The door can only be opened when all axes are without movement. The release of the stroke/elevation chamber door switch shuts down the stroke and elevation servo motors. There are no indicator lights. Refer to page OP-113 and the following procedure to open the door.

1. Unlatch the mechanical latches.
2. Press the Request to Unlock button and hold it in while pulling open the door.

The RESET button must be pressed after using an E-stop pushbutton or pull-cord.
The keyholes in the stroke/elevation door lock and the saw chamber door lock are intended for maintenance personnel to override the door interlock for emergency or troubleshooting purposes only. Using the key allows the door to open without electrical power. The maintenance office should store the key in a safe and secure location. Two keys for each door (total of 4 keys) were delivered during installation or startup.
Safety Protection When Saw Chamber Door is Open

The BLADE saw assembly has Category 4 level protection for exposing the saw blade. The saw chamber door can not be opened until the saw blade is standing still. Two redundant (control and hardwire) systems must both be active before the blade can be exposed and during the time when the blade is exposed.

1. The operator must request to open by pressing the Request to Open button.
   a) The motion sensor tells the PLC and also the Door Safety Switch that the blade motion is safe.
   b) The PLC checks the safety motion module.
   c) The PLC controls CR8 which allows the locking solenoid to open.

2. With the door open or unlocked, the safety solenoid’s safety relay is monitored to control any power to the blade.
   a) Redundant locking contacts on the safety switch prevent power to the saw blade.
   b) Safety relays (SR4-A&B) control the VFD ENABLE and the Motor Starter Contactor (2 separate devices).
   c) The PLC control system also knows that the door is unlocked so the software is another level of monitoring.
Using and Locking Out the Disconnect Switch

See page OP-116 and page OP-117 for the location of the disconnect switch that controls the power supplied from that switch to the rest of the machine. Turning the disconnect handle to the On position supplies electrical power to the entire machine. To remove power to the machine, turn the disconnect handle to the Off position. The disconnect handle should be turned off when the machine is not in use.

The disconnect handle on the saw affects the power to the saw and Auto Deck, although the Auto Deck also has its own disconnect switch.

The disconnect handle on the saw does NOT affect optional equipment such as the Powered Skewed Conveyor.

See page 5 for more safety information regarding lockout/tagout guidelines.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELECTRICAL HAZARD!</td>
</tr>
<tr>
<td>When the disconnect switch is off, there is still live power to the disconnect switch’s enclosure. Always turn off power at the main power source before opening electrical enclosure!</td>
</tr>
</tbody>
</table>

A 3-phase indicator on the front of the main enclosure is lit up when power is live inside the top half of the main enclosure (past the 3-phase fuses). The 3-phase indicator in Figure 4-7 shows there is not live power present. Because this is only an indicator, an actual voltage absence verification must also be performed in accordance with NFPA70E, article 110.9. Refer to Figure 4-7 for greater detail.

The bottom half of the main enclosure has only 24 VDC power. The door can be opened with live power to it.

Figure 4-7: E-Stop Pushbutton and 3-Phase Indicator Showing No Power

Wait 2 minutes* after lights shut off before opening cabinet to give the servo amplifier time to disperse stored power.

Always perform volt-absence verification.

* NOTE: Wait 10 minutes before touching the VFD drives.
Figure 4-8: Locking Out the Disconnect Switches

When locking out the saw, always lockout all peripheral components that are not shut down by the saw’s disconnect switch, including the pneumatic system.

If uncertain, always lockout/tagout.
Figure 4-9: Lockout Mechanisms for Various Peripheral Components

Auto Deck Enclosure
May be replaced with optional infeed equipment.
Power can also be disconnected using saw’s main disconnect switch.

Powered Skewed Conveyor Enclosure
(optional equipment)

Main Pneumatic Filter/Regulator
- Located on right side of saw.
- Yellow plate is shown in lockout position.
  Place lock and tag through holes in yellow plate.
- Pneumatic lines will bleed naturally when yellow plate is in lockout position.
- Ensure gauge reads 0 before performing replacing a supply bottle for the printer or performing any maintenance!

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>When locked out at machine, there is still power in the transmission lines.</td>
</tr>
</tbody>
</table>
Indicator Lights on Saw’s Operator Interface Panel

In addition to the software in use, the indicator lights listed in Table 4-1 provide the operator with information about the status of the machine. The indicators are shown in Figure 4-10.

Table 4-1: Functions of Indicators Located on the Side of Main Enclosure

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blade In Motion</td>
<td>When the blade is spinning, this red light is on. Certain doors cannot be opened while this light is on.</td>
</tr>
<tr>
<td>Blade Stopped</td>
<td>When the blade is not spinning, this green light is on. This light must be on for certain doors to be opened.</td>
</tr>
<tr>
<td>VFD Fault</td>
<td>Red light indicates a VFD error exists. See page OP-151.</td>
</tr>
<tr>
<td>Overload</td>
<td>Yellow light indicates an overload has tripped. See page MT-142.</td>
</tr>
<tr>
<td>E-Stop</td>
<td>Red light indicates an E-stop is activated. This red light must be on for certain doors to be opened, and it must be off before operating the machine. See page OP-107.</td>
</tr>
</tbody>
</table>

Figure 4-10: Indicator Lights on Saw’s Operator Interface Panel (Touch Screen Enclosure)
Indication of Movement (Beacon & Horn)

The beacon is located on top of the saw’s main enclosure. It indicates the following:

- **Red**—A fault exists. The saw’s operator interface will communicate what the fault is and what the next step should be. Some faults allow the system to continue cutting, other shut down all movement.

- **Green**—System is operable and is in Auto Mode with no active faults.

- **Yellow (flashing)**—The system is waiting for one of the following actions to occur:
  - The Auto Deck to place a board on the Infeed Rail.
  - The printer trigger to be turned on.
  - The CLS to complete its reading.

The horn notifies the operator of errors and faults when in Auto Mode. The sound continues until the operator does one of the following:

- Acknowledge the error/fault on the HMI screen
- Turns the saw to Manual Mode
- Activates an E-stop

![Figure 4-11: Varying Colors of the Beacon](image)

![Figure 4-12: Horn and Beacon on Top of the Saw](image)
Operator Interface Overview

Graphics Showing Saw Operator Interface

Figure 4-13: Saw’s Operator Interface (Touch Screen Enclosure)

Do not pull on cooler tubing to move enclosure!
- May be hot
- May break tubing

Use black bar to move enclosure.

Figure 4-14: Touch Screen Enclosure and Adjustable Arm

NOTICE: Do not swivel the enclosure past 135° either direction.

---

Indicator Lights
Mechanical Controls
Figure 4-15: Moving the Touch Screen Up and Down

Pull lever for vertical adjustments.
Saw Operator Interface

The saw’s operator interface is located on the touch screen enclosure. It consists of a touch screen computer used in conjunction with USB ports on the external surface of the touch screen enclosure and a panel of indicator lights and mechanical controls.

The touch screen enclosure is mounted to the saw with an adjustable arm. It has several points of location adjustment to accommodate any operator. They are shown in page OP-120. Use the black handle and yellow lever under the enclosure to move the enclosure location and angle.

A cooler (shown on page OP-120) is mounted to the touch screen enclosure to keep the computer at an appropriate temperature. More information can be found on the cooler in the Maintenance Manual on page MT-117. Never use the cooler’s tubing to move the touch screen enclosure.

The mechanical controls shown in Figure 4-16 supplement the BLADE software for quick and convenient saw operation.

Table 4-2: Functions of Mechanical Controls on Saw’s Operator Interface Panel

<table>
<thead>
<tr>
<th>Control Mechanism</th>
<th>How It Works</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Stop</td>
<td>Red, mushroom pushbutton Press and release Must pull up/twist to deactivate</td>
<td>Stops all moving parts</td>
</tr>
<tr>
<td>Start</td>
<td>Green pushbutton Press and release</td>
<td>Starts the blade motor</td>
</tr>
<tr>
<td>Stop</td>
<td>Red pushbutton Press and release</td>
<td>Stops the blade motor when in Manual Mode.</td>
</tr>
<tr>
<td>Reset</td>
<td>Blue pushbutton Press and release</td>
<td>Press after using an E-stop to tell the saw it is safe to proceed</td>
</tr>
<tr>
<td>Pause</td>
<td>Yellow pushbutton Press and release</td>
<td>Stops cutting and infeed progress after completing the current cut</td>
</tr>
<tr>
<td>Mode</td>
<td>2-position selector switch Turn and release</td>
<td>Places system in Manual Mode or Auto Mode</td>
</tr>
</tbody>
</table>
Adding a Keyboard or Mouse

A keyboard or mouse can easily be added to the touch screen computer system by connecting it to one of the USB ports shown in Figure 4-17. A customer-supplied table will be needed if using a keyboard or mouse.

Using a USB Memory Stick

The USB ports shown in Figure 4-17 can also be used to upload data using a USB memory stick or flash drive.
Operator Interface for Auto Deck

Figure 4-18: Control Station for Manual Mode on Auto Deck

The Auto Deck operation is integrated within the BLADE software in Auto Mode, but manual operation occurs at the control station pedestal shown in Figure 4-18.

Table 4-3: Functions of Control Mechanisms on Auto Deck

<table>
<thead>
<tr>
<th>Control Mechanism</th>
<th>How It Works</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Stop</td>
<td>Mushroom-shaped pushbutton Press and release</td>
<td>Stops all movement on entire wood processing system.</td>
</tr>
<tr>
<td></td>
<td>Must pull up to deactivate</td>
<td></td>
</tr>
<tr>
<td>Forward/Reverse</td>
<td>Selector switch Turn and release</td>
<td>Controls which direction the Auto Deck staging conveyor chains run.</td>
</tr>
<tr>
<td>Lower/Raise</td>
<td>Selector switch Turn and release</td>
<td>Controls the lumber stops. (To raise or lower the load arms, see page OP-144.)</td>
</tr>
<tr>
<td>Foot Pedal</td>
<td>Foot pedal located under manual buttons Step and hold</td>
<td>Causes chain to travel.</td>
</tr>
</tbody>
</table>

(load arms must be UP for forward travel)
Operator Interface for Powered Skewed Conveyor

See page OP-158 for details on operating the Powered Skewed Conveyor.

Figure 4-19: Control Station on Powered Skewed Conveyor

Printer Overview

The printer automatically prints the information fed to it from the saw.

- To turn the printer off so it does not print during saw operation, see page OP-145.
- To flush the printer, see page OP-176.
- To clean the printer, see page OP-174.
- To modify what is printed on the boards, refer to the *Board Stretcher* Training Manual.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If printer is left idle for more than 48 hours, clean and flush the system! Dried ink will damage the print head and clog lines.</td>
</tr>
</tbody>
</table>
Using **Windows 10®**

At the time of the writing of this manual, *Windows 10®* is the operating system. If unfamiliar with *Windows 10*, here are some tips to help get started.

**Figure 4-20: Start Menu**

The Start menu, shown in Figure 4-20, is accessed by clicking the *Windows* icon in the bottom-left corner of the screen. To return to the *BLADE* software, press the *Windows* icon again.

*Place these manually*

*Click here to bring up this screen*

*Tracks most-used apps*

**Finding the Start Menu**

The Start menu, shown in Figure 4-20, is accessed by clicking the *Windows* icon in the bottom-left corner of the screen. To return to the *BLADE* software, press the *Windows* icon again.

If you have a keyboard attached to the operator interface, the *Windows* key also accesses the Start menu.
Shutting Down the Computer

To shut down the computer using the *Windows 10* operating system:

1. Click on the *Windows* icon in the bottom-left corner of the touch screen.
2. Select Power, as shown in Figure 4-21, and the power-down options appear.
3. Select the desired power-down option.

![Figure 4-21: Power-Down Screen](image)
Using **Windows 8**

*Windows 8®* notes are included here for computers manufactured prior to *Windows 10*.

**Finding the Windows 8 Start Menu**

The Start menu has been replaced with a Start screen and a Settings screen. The list of icons that include the Start and Settings screens is shown in Figure 4-22. It is hidden on the right side of the monitor screen. To access the list of icons from any *BLADE* screen:

1. Place your finger on the right edge of the monitor screen and pull toward your left.

2. Once the menu in Figure 4-22 appears, press the *Start* or *Settings* icon and the entire monitor screen will show that screen.

3. To return to the *BLADE* software, access Figure 4-22 as described in the previous steps, and press the *Start* or *Settings* icon again.

If you have a keyboard attached to the operator interface, the *Windows* key may also access the Start screen.

**Shutting Down a Windows 8 Computer**

To shut down the computer using the *Windows 8* operating system:

1. Access the list of icons in Figure 4-22 as described in the previous section.

2. Select the *Settings* icon.

3. Select Power.
Using the **BLADE Software: Tips & Terms**

**Understanding the Length Measurement Format**

In all applications used with the **BLADE** wood processing system, the following measuring rules apply.

- Imperial measurements (English) are given using 3 pair of numbers. **12-06-08** means 12 feet, 6 inches, and 8/16 inches (12’ 6-1/2”)
- Metric measurements are given in whole millimeters (mm).

**Terminology**

- **lumber**: A group of boards or a non-specific board
- **board**: A specific piece of lumber with specific dimensions required by the saw to cut out specific parts
- **job**: A group of parts requiring specific boards to cut it efficiently
- **part**: A piece of a board, cut to the size and shape required for the job

**Shortcuts**

The shortcuts listed in Table 4-4 apply when in the Cut List window.

**Table 4-4: Shortcuts When Using the Keyboard**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow up/down</td>
<td>Scrolls up or down Cut List one part at a time</td>
</tr>
<tr>
<td>CTRL + arrow up/down</td>
<td>Goes to top or bottom of Cut List</td>
</tr>
<tr>
<td>Page up/down</td>
<td>Scrolls Cut List one screen at a time</td>
</tr>
</tbody>
</table>
Using the On-Screen Keyboard (OSK)

The on-screen keyboard (OSK) in Figure 4-23 appears when needed, including when importing a job or logging in.

Figure 4-23: The On-Screen Keyboard Shown in Keyboard Mode

Tips

Tips for using the on-screen keyboard (some features are not available in Input Method Editor mode):

- To enter a period, double-click the spacebar.
- Press and hold a key to see similar keys.
- To activate the Caps Lock feature, double-click the Shift key (up arrow).
- If numbers and symbols are not showing on the OSK, click the key labeled 3 in Figure 4-23.
- To change the keyboard mode, click the button outlined in red in Figure 4-23. Keyboard mode is shown in Figure 4-23 and its icon is labeled with the number 1. The writing pad mode icon is labeled 2.
- Use keyboard shortcuts by click the CTRL key, then click the next key comprising the shortcut.
- The Emoticon key (smiley face) provides entertaining symbols.
Bringing Up the OSK

Figure 4-24: OSK Icon in Task Bar

If you want to use the OSK at a time when it doesn’t automatically appear, just click the icon labeled *Touch Keyboard* in Figure 4-24.

If that icon is not visible on your task bar or in your tray, right click the task bar and the menu in Figure 4-25 appears. Select *Show touch keyboard button* and the icon should appear on your task bar or in your tray.

Refer to...

See page OP-132 for right-click instructions.
User Interface Tips

1. Software instructions throughout this manual use terminology consistent with mouse and keyboard use. When operating the saw without a mouse and/or keyboard, those same tasks are accomplished using only the touch screen by following the instructions in Table 4-5:

Table 4-5: How to Operate the Software Without a Mouse or Keyboard

<table>
<thead>
<tr>
<th>Using a Mouse</th>
<th>Using a Touch Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click</td>
<td>The term “right-click” describes the action when using a mouse, but a mouse is not required to operate the <strong>BLADE</strong> saw. You may also accomplish a “right-click” result by:</td>
</tr>
<tr>
<td></td>
<td>1. Select the board, part, etc. and release.</td>
</tr>
<tr>
<td></td>
<td>2. Place finger on selection again and hold it on the selection until a square outline appears.</td>
</tr>
<tr>
<td></td>
<td>3. Remove finger and the right-click menu appears.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Gently tap the selection 2 times, in quick succession.</td>
</tr>
</tbody>
</table>

2. The blue RESET button on the saw’s operator interface panel must be pressed after any E-stop is used. If the saw will not operate, press the RESET button before looking for other solutions. The saw also provides these reminders:
   - The blue light is lit inside either RESET button.
   - The status banner on the Home Screen reads **Press E-Stop Reset**.

3. If software is not responding, a dialogue box may be open and/or minimized. The Home Screen can not be sized, so find open dialogue boxes by hovering over the active **BLADE** software icon or dragging the Home Screen window around to see the desktop behind it.

4. All status indicators on the Home Screen must be green before the saw will cut boards. If one or more status indicators are red, select the CLEAR ERRORS button, then select HOME SYSTEM. Both are on the Toolbar.

5. A series can be chosen in the Cut List by referring to page OP-147.

6. Every time the START CUTTING button is pressed, the gripper, LASM, and lumber exit chain clear out any wood left in the system from its previous use. The banner on the Home Screen displays **Clearing Saw**.

7. Auto Mode vs. Manual Mode

   Some features are only available in a specific mode. These icons indicate when Manual or Auto Mode are required. See page OP-143 for how to set the mode.
Quick Troubleshooting for Operator Interface

Additional information can be found in the Troubleshooting appendix and online, but the most common operator interface problems can be solved by following the instructions here. Specifically, if a button or field is grayed out or not available, try these steps first.

1. Read the status banner on the touch screen for clues to the saw’s status. If the solution is not clear from the status banner text, continue this procedure. The most common status clues that will quickly solve the problem are:
   - Emergency Stop: Locate and disengage the active E-stop.
   - Press E-Stop Reset: Press the blue RESET button on the operator interface.

2. Check that saw is in the correct Mode using the selector switch on the operator interface.

3. Press CLEAR ERRORS on the Toolbar.

4. Press HOME SYSTEM on the Toolbar.

5. Determine if Admin or Tech permissions are required and log in as such.

6. Check for active E-stops and release them, then press RESET.

7. Check that AIR CUT is not active (yellow banner across START CUTTING button).
Logging In or Out

A login is not required to operate the saw, unless site management has chosen to change the default setting. If Require Login has been chosen in Tools>Options>Security, a user name must be entered to operate the saw, but not a password. This feature may be useful for analyzing reports and data. Administrative or Technician permissions are needed to change a password or when the password is required.

Regardless of the Require Login setting, a user name and password must be entered to make certain administrative or technical changes. The login screen can always be accessed from the File ribbon. The areas most affected by the level of security on the password are Tools>Options and Diagnostics>Detailed Diagnostics.

When the Log Out icon is clicked, it immediately logs out the current operator, if one was logged in. It also displays the login/logout screen to allow someone else to login. Simply close this screen if it is not needed at this time.

The current login level can always be viewed at the bottom of the Home Screen as shown in Figure 3-1 on page OP-73.

Retrieving a Saw Password

If site management has chosen this option, a login screen may appear upon powering up the BLADE computer. If this password is ever lost and needs to be retrieved, MiTek can retrieve it during normal business hours by analyzing the configuration database located in this directory path: c:\program files (x86)\mitek\blade\config\config.mdb file.
Operating Procedure: Overview

<table>
<thead>
<tr>
<th>Step #</th>
<th>Summary Steps</th>
<th>See Page...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Perform safety tests</td>
<td>SAFETY-11</td>
</tr>
<tr>
<td>2</td>
<td>Power up the system</td>
<td>OP-136</td>
</tr>
<tr>
<td>3</td>
<td>Press the E-stop RESET button</td>
<td>OP-111</td>
</tr>
<tr>
<td>4</td>
<td>Setup the lumber feed system with the correct lumber</td>
<td>OP-138</td>
</tr>
<tr>
<td>5</td>
<td>Home the system</td>
<td>OP-159</td>
</tr>
<tr>
<td>6</td>
<td>Import the correct job files</td>
<td>OP-140</td>
</tr>
<tr>
<td>7</td>
<td>Begin cutting the parts</td>
<td>OP-141</td>
</tr>
<tr>
<td>8</td>
<td>To stop the saw:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click STOP CUTTING on the screen to stop after the current board is finished, (same button used to start cutting).</td>
<td>OP-76</td>
</tr>
<tr>
<td></td>
<td>Press the PAUSE button on the saw’s operator interface panel to pause the saw after the current cut is complete.</td>
<td>OP-122</td>
</tr>
<tr>
<td></td>
<td>Press the STOP button on the saw’s operator interface panel.</td>
<td>OP-122</td>
</tr>
<tr>
<td></td>
<td>For emergency situations, activate any E-stop that is integrated with the system.</td>
<td>OP-107</td>
</tr>
</tbody>
</table>

Summary of Normal Operating Procedure

At the start of a shift, the operating procedure listed in Table 4-6 should be followed. Each step is explained in detail, starting on the page listed next to each step.

Table 4-6: Operating Procedure Summary

Restart Procedure

See page OP-111.
Operating Procedure: Detailed

Powering Up or Down

**Powering Up the System**

1. Rotate the saw’s disconnect switch to the ON position.

2. Rotate the disconnect switch for the Auto Deck or other lumber feed and/or outfeed system (if equipped) to the ON position.

3. Press the touch screen’s power button accessed from inside the saw’s operator interface (touch screen enclosure). See Figure 4-26 on page OP-137.

4. Double-click the BLADE software icon and wait for it to launch.

   When the computer powers up, a login screen may pop up, depending on the settings site management has chosen. See OP-134.

5. Press the blue RESET button on the saw’s operator interface panel.

   The blue light goes out if all E-stops are cleared. If the RESET button light stays lit, determine which E-stop is activated and reset it (see page OP-107).

**Powering Down the System**

1. Click the BLADE program’s Exit icon on the File ribbon and Yes to verify. 
   
   *It may take a moment to close. Clicking the Exit icon again will slow the process.*

2. Shut down Windows and the computer.
   
   • For Windows 10, instructions are on page OP-126.

3. After the computer powers down, rotate the saw’s disconnect switch to the OFF position.

4. Rotate the disconnect switch for the Auto Deck or other lumber feed or outfeed system (if equipped) to the OFF position.

---

**NOTICE**

Do not leave the saw computer off or disconnected from the network for more than 21 days. If the computer can not verify the license within 21 days, MiTek will need to re-activate it.
Figure 4-26: Power Button on the Saw Operator Interface: Access From Inside the Back of the Touch Screen Enclosure

Size and shape of power button may vary.
Setting Up the Auto Deck Staging Conveyor

This procedure assumes an Auto Deck staging conveyor is being used to feed lumber to the Infeed Rail. If an automated feed system is being used, refer to that system’s equipment manual instead.

For details on operating the Auto Deck conveyor, refer to page OP-155.

1. Ensure all E-stops have been released and the RESET button on the saw’s operator interface panel was pressed.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRUSH HAZARD.</td>
</tr>
<tr>
<td>When an E-stop is released, the load arms on the Infeed Rail may automatically raise with high force.</td>
</tr>
</tbody>
</table>

2. Raise either the load arms or the lumber stops:
   - If the Auto Deck conveyor is empty of lumber and no job is currently running, place the **load arms** in the Up position. See page OP-144.
   - If there is still lumber on the Auto Deck conveyor to be used in the previous job, raise the pneumatic **lumber stops** to keep the two jobs separate from each other. Do so by turning the selector switch on the Auto Deck operator interface to RAISE.

3. Place the lumber on the Auto Deck, in a single layer. Boards must be placed on their face (4x dimension of a 2x4) in the order they will be cut. See Figure 4-27 on page OP-139 for a diagram of board configuration and proper alignment.

4. The lumber will automatically be forwarded and loaded onto the saw’s Infeed Rail after pressing START CUTTING on the touch screen.

As of PLC program v. 4.0.8, the Auto Deck chains slightly back up prior to the load arms lowering to alleviate pressure on the boards when entering the Infeed Rail. This feature can be turned on or off on the Options>Material Handling screen.
Figure 4-27: How to Place Boards on the Auto Deck

Dealing With Imperfections

**Crown:** a curve of the edge of a board (1-1/2” edge on a 2x4); the crown points up on floor studs or out for wall studs in constructed homes; place board so crown points up as it enters saw

**Wane:** a defect in a board where a portion of the wood is missing from the board edge or face; place toward saw-end of conveyor

**Warp/Twist:** a curve where the face of a board (3-1/2” side on a 2x4) is higher or lower in one spot than on the rest of the board; place board so warp points up when sitting on Auto Deck
Importing Job Files

After jobs are processed through Board Stretcher, the optimization software, they are stored in the input location (see page OP-85) until the saw operator is ready for them.

1. Import the job using one of these methods:
   a) To import a job and clear the previous Cut Lists, click the Clear Cutlist & Import icon shown on page OP-159.
   b) To import a job without clearing the Cut List, click File (in tabbed menus at top of Home Screen) and select the Import Jobs icon.

2. Review the lumber assignments and make sure boards are assigned to the correct locations:
   a) Click the Lumber Yard icon shown in Figure 4-42. (You may also have the opportunity to go to the Lumber Yard directly from the Import Jobs screen.)

   The lumber the saw needs is listed in the top section. The lumber existing in inventory (in the BLADE software) is listed in the bottom section.
   b) Click on the lumber in the top section and drag it to the appropriate inventory in the bottom section.
   c) Click OK.
Cutting the Parts

**Cutting Procedure**

1. Before cutting, ensure that the correct lumber is loaded onto the lumber feed system in the correct order.

2. Press the START button on the saw’s operator interface panel to start the motor.

3. Cut the job or a single board:
   a) Click START CUTTING on the screen to cut the whole job and lumber will begin to feed onto the Infeed Rail and into the saw chamber.
   
   OR

   b) Right-click a board and select CUT to cut only 1 board. The software will prompt you to place a board on the Infeed Rail.

**Common Error**

The saw motor must be started before the system will cut or feed lumber. A common error occurs when the operator presses START CUTTING before starting the saw blade motor. This error states, “The saw blade is not running at full velocity.” To start the saw blade motor, press the green START button on the operator interface panel, shown in Figure 4-16 on page OP-122.

After the motor has ramped up to full speed, press the START CUTTING button on the touch screen.
Specialized Operating Procedures

Refer to page OP-73 for software guidance.

Optimizing (Operating Board Stretcher Software)

The optimizing program (usually loaded on a computer in the production control or design area) attempts to arrange multiple components on each piece of lumber stock of the required design, grade, and species while utilizing the inventory the user has specified. While doing so, it lets the user compare the waste generated by varying the lengths of lumber and size of the job file. The optimizing program can be run multiple times for any job in an effort to get the best result.

Operating the CLS (Crooked Lumber Sensor)

The CLS is a feature that automatically senses the actual bottom surface of a board inside the cutting chamber and compares it to where the bottom surface of a perfectly straight board would be. The software then adjusts the height of the cutting head to compensate for any crookedness. This elevation adjustment of the saw blade happens quickly, so very little time is lost in the production process.

There is no operation procedure associated with the CLS. The BLADE software and CLS communicate automatically.

The CLS has an air feature that periodically blows sawdust off the sensor anytime the saw is in operation.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CLS is intended to compensate for minor faults in lumber, not to allow for consistently low-quality lumber. The higher the quality of lumber, the faster and more accurate the cuts will be.</td>
</tr>
</tbody>
</table>
Choosing Manual Mode or Auto Mode

Some software choices will be “grayed out” or unavailable if the saw is not in a certain mode. Auto Mode is typically required during normal cutting operation and integrates most infeed and outfeed devices to make this system a true wood processing system. Manual Mode may be required when troubleshooting, performing maintenance, or changing software settings. To change the mode, turn the selector switch shown in Figure 4-30 so it points to the desired mode.

Cutting 1 Board

1. Place the Mode selector switch in Auto Mode.
2. Start the blade motor.
3. Select the board in the Cut List.
4. Right-click and select Cut.
   A message appears asking the user to drop the selected board into the gripper rail slot or place it on the load arms.
5. Press the CONTINUE button and the board feeds into the saw chamber for cutting.
Raising or Lowering the Load Arms

The load arms are the components on the Infeed Rail that raise the lumber up from the Auto Deck (or similar staging area) and set it in the Infeed Rail. They must be in the up position for the Auto Deck to manually operate.

To raise or lower the load arms, select the **Load Arms** indicator on the Home Screen and select **Up**. The status indicators are shown in Figure 4-31.

It can also be done from the **Diagnostics>Detailed Diagnostics>Clamps** tab.

Using the Visualize Feature

The **BLADE** software has the ability to show on-screen exactly what the various saw components and current board are doing. Refer to page OP-87 for details.

Finding an Active E-Stop

Locate active E-stops by selecting the **Doors/E-Stops** indicator. The status indicators are shown in Figure 4-31.

Active E-stops and open doors can also be viewed by going to **Diagnostics>Detailed Diagnostics>Machine** tab. See page OP-95.
Operating the Printer

The Printer(s) print identification on each board as it enters the saw chamber. Each saw has at least 1 printer.

- To turn the Printer off, or back on, go to Tools>Options>Printer and check or uncheck Available for use in the BLADE software.
- To choose or change the fields to print, use the Board Stretcher software.
- To adjust the dot size, go to Tools>Options>Printer in the BLADE software.
- To adjust the location of the image on the board, among other settings, calibrate the printer using Tools>Calibrate from the BLADE software.
- To flush the system (required weekly), see page OP-176.

Figure 4-32: Tools>Options>Printers
Other Printing Options (Board Stretcher)

The printing features controlled by the BLADE software are minimal. Most printing control is located in the Board Stretcher software. The following topics are discussed further in the Board Stretcher software training manual. Refer to the General chapter to learn how to access the Board Stretcher manual.

- Print the PartHighSide arrow to show which end points toward the top of the truss.
- Where printing occurs
- What fields print
- How to use the Multi-saw feature
- Much, much more!

Managing Remainders

The saw program can maintain a list of default components or remainders, selected by the user, which may be processed from any waste remaining after the cutting list has been run through the normal optimizing routine. The remainder components are entered and assigned a priority by the saw operator, based on the required demand and existing supply of such items.

Adding Remainders

Pre-programmed remainders can be added to the remainders list or to the Cut List using the KEY-IN PART button on the Toolbar. Learn more on page OP-78.

Parts from the Cut List can be added to the remainders list by right-clicking the part in the Cut List and selecting Add To Remainders. See page OP-132 for right-click help.

Viewing Remainders

After a part is added to the remainders list, it can be viewed and managed using the following tasks on the View Remainders screen on the Material Handling menu:

- Make each part active or inactive.
- Change the priority of each part in relationship to each other.
- Delete parts from the list (this does not affect the job they came from).
- Indicate if remainders should be cut from leading or trailing end of board.
Deleting Completed Jobs

Delete completed jobs and view statistics on previous jobs using the Job Stats/Delete icon on the File ribbon.

Rejecting or Resetting Jobs and Boards

Individual parts can not be rejected.

- To reject/reset one board, right-click on the board in the Cut List and select Reject or Reset.
- To reject/reset a series of boards in the Cut List, select one row, then immediately select a lower row. Right-click on the lower row and select Reject Series or Reset Series. Everything between and including the two rows selected is now either:
  - Highlighted and moved to the top of the list if Reject Series was chosen.
  - Unhighlighted and moved back to their numerical place in the list if Reset Series was chosen.
- To reject/reset all the boards in a job, use the icons in the Material Handling ribbon.

Recording Non-Productive Time

The Non-Productive Time section allows the operator to indicate what the saw is doing when it’s not running.
• **Break**: Indicates operator break

• **Error**: If an error is received on-screen that requires attention, activate this button while finding the solution. The error automatically populates the window.

• **Maintenance**: Indicate time spent on any maintenance using this button. Select the most accurate category from the drop-down menu.

• **Other Delays**: For any non-productive time that doesn’t fit one of the categories above, select this button and type a description of the delay.

Figure 4-34: Non-Productive Time Section on Home Screen
Determining Board Recovery Solutions

Understanding Board Recovery

The screen shown in Figure 4-35 will appear when a board has a status of *In Process* and the START CUTTING button is selected. It is the result of the saw having been stopped in the middle of a job. The partially cut board will be cleared out of the saw chamber automatically when the START button is pressed. This screen gives the operator a chance to tell the saw the status of that board. Select one of the options shown in Figure 4-35 and select OK. Each option is defined later in this section.

Figure 4-36: Cut List Sample, Shown While Cutting Board 18, Part 1

In Figure 4-36, note the following things while reading the description of each board recovery option discussed on subsequent pages.

- Board 2 is in process (already in the saw cutting chamber). When the cutting was stopped, Board 2 was not complete, and therefore, will have to be cleared out of the saw chamber before the saw can continue cutting.
- Board 3 is Queue #1 (already processed by software and sitting on load arms to be placed onto the Infeed Rail).
Infeed

Place the new board on the Auto Deck, just behind the load arms, so it is the next board to be placed on the Infeed Rail after Queue #1 board (Board 3 in Figure 4-36).

Queue 1

Place the new board on the Auto Deck, above the load arms, so it is the next board to be placed on the Infeed Rail.

Complete

No more parts are needed from the interrupted board (in the software), so don’t manually load anything. The software marks it as complete and moves on.

Reject

The board does not need to be cut further, so don’t manually load anything. The software marks it as rejected.

Reject and Add as Redo

The board is being marked as rejected, but also added back into the job. With this option, all parts on the board are recut. Where the board falls in the job depends on the default chosen in Tools>Options>Cut List>Redo Parts.

If Cut First is selected, a new board must be placed on the Auto Deck just behind the load arms, so it is the next board to be placed on the Infeed Rail after Queue #1 (Board 3 in Figure 4-36). If Cut Last is selected, it will be the last board cut in this job.

Reject and Redo Selected Parts

The board is being marked as rejected, but certain parts can be added back into the job. With this option, only the parts selected in the lower portion of the screen shown in Figure 4-35 are recut. Where the parts fall in the job depends on the default chosen in Tools>Options>Cut List>Redo Parts.

If Cut First is selected, a new board must be placed on the Auto Deck just behind the load arms, so it is the next board to be placed on the Infeed Rail after Queue #1 (Board 3 in Figure 4-36). If Cut Last is selected, it will be the last board cut in this job.
Resetting a VFD Fault

If the VFD Fault indicator light is on (located on the operator interface panel; see page OP-118), start investigating the cause using this procedure:

1. See if any E-stops are active (Doors/E-Stops indicator on the Home Screen).
2. Press the blue RESET button on the operator interface panel.
3. Click the CLEAR ERRORS button on the Toolbar on the Home Screen.
4. If the problem is not resolved or continues to arise, use the error code noted on the touch screen to guide in troubleshooting.

**WARNING**

ELECTROCUTION HAZARD!

If it is necessary to view the VFD screen to gather additional data about the error, do so with caution. Follow NFPA 70E when troubleshooting near energized components.

Figure 4-37: VFD in Top Half of Main Electrical Enclosure
Resetting a Stalled Saw

See *Abort Cutting Sequence* on page OP-86.

Managing the Configuration

Backup, restore, or view the configuration using the icons in the *Tools* ribbon.

Changing Default Computer Settings (*Tools>*Options*)

**Language, Units, and Straight Cut Definition**

Change the following specifications by using *Tools>*Options*, and clicking the *Display* tab:

- Switch between Spanish and English languages (if available). No password is required for this change.

- Choose Imperial (inches and feet) or Metric (millimeters) units. Administrative or Technician permissions are needed for this change.

  When changing units of measurement, the same unit must be chosen in *Board Stretcher* before optimizing the job.

  In all applications used with the *BLADE* wood processing system, the following measuring rules apply.

  - Imperial measurements (English) are shown using 3 pair of numbers. **12-06-08** means 12 feet, 6 inches, and 8/16 inches (12’ 6-1/2")
  - Metric measurements are given in whole millimeters (mm)

- Change what your saw calls a straight cut (0 or 90 degrees)

  Administrative or Technician permissions are needed for this change.

  All instructions in this manual assumes the saw uses the default setting of 90 degrees for a straight cut.

- Change the password and if password is required.
Saw Settings

Figure 4-38: Tools>Options>Saw Tab

The settings shown in Figure 4-38 can be adjusted using Tools>Options and clicking the Saw tab. NEVER make adjustments to these settings without guidance from MiTek. For an explanation of settings controlled on other tabs shown in Figure 4-38, refer to page OP-100.

Administrative or Technician permissions are needed for these changes.
Manual Operations

Manually Operating the Saw

The MANUAL-AUTO selector switch must be in MANUAL to operate in Manual Mode. It is the black switch shown in Figure 4-30 on page OP-122. The other manual buttons are also described there.

To manually move an axis after placing the saw in Manual Mode, select its status indicator on the Home Screen, shown on page OP-144, and choose the desired action from the menu that appears.

The axes can also be manually moved using the Diagnostics screen. Refer to page OP-89.
Manually Operating the Auto Deck

The Auto Deck chains can be manually advanced by using the Auto Deck operator pedestal or by using the saw software. Certain variables, as described in the next overview given here, should be understood before doing either. For step by step instructions on using the Auto Deck operator pedestal, refer to page OP-156.

Overview of Scenarios Available to Operate the Auto Deck

### To Operate for Automatically Processing a Job

<table>
<thead>
<tr>
<th>Mode</th>
<th>Auto Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch on pedestal</td>
<td>doesn’t matter</td>
</tr>
<tr>
<td>Direction</td>
<td>forward</td>
</tr>
<tr>
<td>Load Arms</td>
<td>doesn’t matter, system will cycle them automatically</td>
</tr>
<tr>
<td>Activated by</td>
<td>job’s cycle</td>
</tr>
</tbody>
</table>

### To Manually Operate From the Auto Deck Operator Pedestal

<table>
<thead>
<tr>
<th>Mode</th>
<th>Auto or Manual Mode, doesn’t matter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch on pedestal</td>
<td>turn to fwd or rev</td>
</tr>
<tr>
<td>Direction</td>
<td>controlled by switch on pedestal</td>
</tr>
<tr>
<td>Load Arms</td>
<td>up for fwd, doesn’t matter for rev*</td>
</tr>
<tr>
<td>Activated by</td>
<td>foot pedal (faster than other methods in fwd and rev)</td>
</tr>
</tbody>
</table>

* If load arms are down and SS is Fwd, nothing will happen.

### To Manually Operate From the Touch Screen Operator Interface: (Diagnostics>Detailed Diagnostics>Auto Deck tab).

<table>
<thead>
<tr>
<th>Mode</th>
<th>manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch on pedestal</td>
<td>doesn’t matter</td>
</tr>
<tr>
<td>Direction</td>
<td>can press forward or rev button on-screen</td>
</tr>
<tr>
<td>Load Arms</td>
<td>doesn’t matter</td>
</tr>
<tr>
<td>Activated by</td>
<td>button on-screen</td>
</tr>
</tbody>
</table>

Do not attempt to manually reverse the Auto Deck conveyor when the saw is running a job in Auto Mode. If attempted, the saw goes to a non-initialized state and loses track of where the boards are.
Manually Traveling the Conveyor Chains

1. Place the saw in Manual Mode using the selector switch on the saw’s operator interface.

2. If moving the chains forward, ensure the load arms on the Infeed Rail are in the Up position. See page OP-144.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRUSH HAZARD.</td>
</tr>
<tr>
<td>When an E-stop is released, the load arms on the Infeed Rail may automatically raise with high force.</td>
</tr>
</tbody>
</table>

3. Set the direction the Auto Deck staging conveyor should travel:
   - Turn the selector switch on the Auto Deck operator interface to FWD (forward) to move the lumber forward.
   - Turn the selector switch on the Auto Deck operator interface to REV (reverse) to move the lumber backward.

4. Press the foot pedal to start the Auto Deck staging conveyor traveling in the direction selected.

Figure 4-39: Auto Deck Operator Interface for Manual Control
Raising the Lumber Stops

The lumber stops serve two purposes:

• To separate two different jobs that may be on the Auto Deck staging conveyor at the same time.
• To create space within a job to reduce the amount of pressure or clutter near the load arms, especially when using a mixture of lumber lengths.

They are pneumatically activated up or down by turning the selector switch on the Auto Deck operator interface shown in Figure 4-39.

**Figure 4-40: Lumber Stop on Auto Deck Conveyor**
Operating the Powered Skewed Conveyor

(optional equipment)

The Powered Skewed Conveyor is an option that replaces the outfeed table when installed. It is a powered conveyor that drives the lumber away from the saw’s outfeed chamber to be offloaded or directed onto other conveyors. It operates by using a selector switch on the control station mounted to the front of the conveyor.

The Powered Skewed Conveyor operation is controlled at the control station shown in Figure 4-41. The operation is accomplished only at this control station and is not tied into the BLADE software, but the E-stops are tied into the BLADE safety system.

To turn the Powered Skewed Conveyor on or off, turn the selector switch to either the START or STOP position and release the switch. It is a spring-return center switch, so when it is released, it will always return to the center.

There are 2 E-stop pushbuttons. They both shut down the entire wood processing system. One is shown in Figure 4-19. They are intended for emergency situations only. If an E-stop pushbutton is used, the RESET button on the saw’s operator interface must be pressed before the conveyor will operate again.

Turn the disconnect switch off during long periods when it will not be in use.

Figure 4-41: Control Station for Powered Skewed Conveyor
Calibration

Homing the System

The BLADE software automatically homes all axes when the operator clicks the HOME SYSTEM button on the software toolbar.

For the Gripper, LASM, and Stroke:

As of BLADE software v 4.0, the location of each axis is monitored anytime the saw is operating in Auto Mode. It will automatically “home” itself in order to recalibrate the axis when needed. Since the saw never lets its home position become compromised, manual recalibration is rarely required.

The primary reason the home position may become compromised and needs to home itself is that a jam in any given axis may cause the motor collar to slip. The motors are designed to let this happen to avoid costly damage. By automatically homing itself, occasional slips are planned for and dealt with automatically. But, if the saw is experiencing a high number of out-of-calibration instances on a certain axis, the root cause must be determined and fixed. If the saw reads 4 or more slippages on the same axes within an hour, it gives the following error: The xx servo has mechanically slipped many times in a short duration. The Online Support button will display a web page with information on how to eliminate this issue. Online Support is accessible from this error, from the saw’s Home Screen, and from our web site.

Depending on where the Stroke z-pulse is located when the HOME SYSTEM button is pressed, in rare cases, the stroke axis may retract all the way to the hard stop and display an error. To remedy this:

Go to Diagnostics>Detailed Diagnostics in the BLADE software at the HMI.
Click the Stroke tab.
Click the RESET button under Home Offset.
Calibrating the Angle, Bevel, Elevation, and CLS

This section applies only to the angle, bevel, elevation, and CLS axes. The other axes are kept in calibration with the automatic homing feature discussed on page OP-159. Additional axes may be added to the automatic homing feature in future versions of the BLADE software.

Determining if Calibration is Necessary

Certain axes, or possibly the entire system, may occasionally need to be recalibrated. This is usually only required if maintenance has occurred or if cuts are no longer accurate. Over-calibrating may cause complications within the system, so only calibrate after all mechanical issues have been ruled out, starting with:

- Check for barriers, scrap lumber creating jams, etc.
- Blow off and lubricate the equipment; keep preventive maintenance up to date

If calibration is necessary, pay careful attention to the notes on-screen regarding the order to calibrate certain axes. Because of the relationships between certain axes, the calibration may need to be performed 2-3 times for all axes to be accurately calibrated.

Calibration Screen

The saw constants can be restored to a previous date or time. Select Tools>Restore. Select which configuration you want, and select Open.
Safety During Calibration

The BLADE saw has been given Category 4 protection against exposure to the saw blade. The saw chamber door cannot be opened until the saw blade is standing still. Two redundant (control and hardwire) systems must both be active before the blade can be exposed and during the time when the blade is exposed. Further details are given on page OP-114.

Create Straight Board Feature

It is still vitally important to use a straight board when calibrating any axis. A new feature has been added that trims one edge of a board to ensure a straight, flat edge for calibrating certain axes. The CREATE STRAIGHT BOARD button has been added to the Calibration screen, and is available at any login level. It is grayed out until the saw is in Auto Mode and the saw blade is started. Once the CREATE STRAIGHT BOARD button is pressed, the saw rips across the top of a board to create a straight edge that can be trusted for certain tests. Always use this method to create a straight edge for CLS and Elevation Home calibration.
Calibration Procedure

1. Ensure the status banner on the HMI shows READY. You may need to press the HOME SYSTEM button on the Toolbar if the system is not in the Ready state.

2. Place the saw in Manual Mode.

3. Go to Tools>Calibrate.

4. Select which axis to calibrate and choose START. Only calibrate the axis that requires it. Overcalibrating can cause other system complications.

5. Follow the instructions on the screen. What happens next is listed in Table 5.

Table 5: What Happens During Calibration

<table>
<thead>
<tr>
<th>Axis</th>
<th>What Happens</th>
<th>Select</th>
<th>Indicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>With a flat saw blade, cuts 7 plunges at top of board, at different angles. The height of the raised areas on each side of a cut are to be focused on.</td>
<td>Pick the cut that has the raised areas on both sides of it at approximately the same height.</td>
<td>On the Calibration screen showing on the HMI, press the ID letter that is printed next to your selection.</td>
</tr>
<tr>
<td>Bevel</td>
<td>Cuts 14 plunges (7 pair). 1 pair = 1 partial cut, then flips blade 180° and makes cut in same place, with stroke slightly retracted.</td>
<td>Pick the pair with the cuts in exact same place (or closest to).</td>
<td>On the Calibration screen showing on the HMI, press the ID letter that is printed next to your selection.</td>
</tr>
<tr>
<td>Elevation</td>
<td>10 plunges, creates stair steps in bottom of wood. In calibrated saw, the first 5 don’t touch the wood.</td>
<td>Count the # of stair corners visible on the board that are complete semi-circles.</td>
<td>On the Calibration screen showing on the HMI, press the # matching the number of stair corners.</td>
</tr>
<tr>
<td>CLS</td>
<td>Performs a “stability check”. Determines if the CLS sensor eye is failing to sense the board because it is not physically aligned with the board location or if there is a sensor and/or electrical issue.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If the calibration process does not complete, select HOME SYSTEM to continue operating the saw.

Graphics Supporting Calibration

**Figure 4-43: Angle Calibration Screen**

![Angle Calibration Screen](image)

Note: If choice A or G is made and the cut is not level, finish this calibration normally (do not cancel) and perform the calibration again until there is a cut that is level.

**Figure 4-44: Angle Cut**

![Angle Cut](image)

**Figure 4-45: Bevel Calibration Screen**

![Bevel Calibration Screen](image)

Note: If choice A or G is made and the step is greater than 1/64 inch, finish this calibration normally (do not cancel) and perform the calibration again until there is a choice containing a step of 1/64 inch or less.
Figure 4-46: Elevation Calibration Screen

Choose the number of corners shown on the bottom of the board. A corner must have the following attributes to be counted:
1. Must be a complete semi-circle (see Bottom View).
2. Must be a part of a tight group of corners which are evenly spaced (see Bottom and End Views) keeping in mind there may only be one corner or no corners cut.

Choices:
- 0
- 1
- 2
- 3
- 4
- 5
- 6
- 7
- 8
- 9
- 10

Note: If choice 0 or 10 is made, finish this calibration normally (do not cancel) and perform the calibration again until the choice is not 0 or 10.

Figure 4-47: Elevation Cut
Home System

The HOME SYSTEM button on the Toolbar moves all servo axes to the Home position, determined by the location of the home sensor/limit switch.

If the stroke axis is not in its Home position when certain commands are made, the error shown in Figure 4-49 appears. To remedy this error, press the MOVE TO HOME button located inside the error window.

Figure 4-49: Saw Stroke Must Be on Its Home Limit Error
Solution to Z-Pulse Error

If during calibration, either of the messages shown in Figure 4-50 or Figure 4-51 are shown for the angle, bevel, or elevation axes, follow the steps listed in the error window.

Figure 4-50: Error SRV006

1. On the HMI (touch screen), go to Tools>Calibrate and calibrate the appropriate axis.

Figure 4-51: Error SRV002

2. Follow the steps in the error window.
   • To clear the stored Z-Pulse:
     • Go to the HMI’s Home Screen and select Diagnostics>Detailed Diagnostics.
     • Select the correct tab on the bottom half of the screen and press the CLEAR Z button.
     • To home the system, press the HOME SYSTEM button on the Home Screen Toolbar.

Defining Printer Marks

See the Board Stretcher manual for all printer fields and what they mean.
Second Monitor and Production Metrics  (optional)

For monitor specifications and more, refer to the General chapter.

Activating a Second Monitor (Display)

For systems with the option to add a second monitor (display), the feature must be activated in the BLADE software as shown in Figure 4-52.

Managing Production Metrics

The data that displays on the second monitor is not customizable at this time. The production metrics are taken from the history database within the BLADE software. The time period for the metrics are from start-of-shift to the current time. Shift times can be changed in the Tools>Options>Production tab, but remember, that also affects break times allowed.
Supplies

How to Order Printer Supplies

To order supplies for the MiTek Printer, contact Matthews directly. MiTek does not sell the ink or cleaning solution.

Once the account is set up, future orders can be placed by providing a PO in any of the three ways listed here. To place your very first order with Matthews Marking Systems™, see page OP-169.

- E-mail to mms-insidesales@matw.com, or
- Fax 412-665-2594, or
- Call 800-775-7775

Table A-1: Printer Supplies

<table>
<thead>
<tr>
<th>Product</th>
<th>Unit of Issue</th>
<th>Quantity per Case</th>
<th>Matthews Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaner</td>
<td>SCP-900C</td>
<td>case</td>
<td>6 bottles (1 liter ea.)</td>
</tr>
<tr>
<td>Ink</td>
<td>SCP-901A, Black Ink</td>
<td>case</td>
<td>6 bottles (1 liter ea.)</td>
</tr>
</tbody>
</table>

Only use the specified ink in this printer! Ink specified for other MiTek inkers and printers will damage this unit.

The ink must be stored between 32°F and 90°F and has a 2-month shelf life.

How Much Ink Will I Use?

The amount of ink you will use depends greatly on which Printer(s) you have, type of parts you cut, and quantity of parts each day. Basic guidelines are listed below to help you determine how much ink to purchase at one time. These guidelines are based on a 5-day work week, 1 shift/day. Adjust these numbers to reflect your work week.

- For Truss Use, with an AGS option:
  On average, the Printer uses approximately 1 liter of ink every 1-2 weeks.
- For Wall Panel use, with an AGS option:
  On average, the Printer uses approximately 2-3 liters per week.
Placing Your First Supplies Order Through Matthews™

Consumable supplies (ink and cleaner) must be purchased from either Matthews or a local distributor prior to the saw’s installation, and it MUST be present at the installation of the saw. MiTek does not sell the ink and cleaner solutions. The most efficient way to place your first order is as follows.*

1. Print and fill out the Matthews credit form that is included in the Inker/Printer Agreement.
2. Send an e-mail to Matthews at mms-insidesales@matw.com with the following information:
   a) Notation that you are a MiTek customer
   b) Ship To address
   c) Bill To address
   d) Attach the following files:
      · Matthews Credit Form
      · PO stating this purchase items, Matthews part numbers, and quantities
        (listed in Inker/Printer Agreement)
3. A customer service representative will assign the account internally, and your Matthews account is created.
4. Call the number below to place your first order and verify that all credit information has been received. Orders should be placed at least 3 weeks prior to the saw installation date to ensure the supplies will be there during installation.

* Failure to supply a purchase order will delay the shipment of supplies. If you do not have the credit form, contact Matthews to obtain a credit application. These supplies may also be purchased from an approved local distributor. Contact Matthews to obtain your local distributor’s contact information.
Overview of Printer Components

The printer used with this equipment is designed to allow inkjet printing on the edge or face of lumber. The print heads are located at the infeed side of the saw, just before the lumber enters the saw chamber. The control unit is located in an enclosure mounted to the Infeed Rail. It can control up to 3 print heads. If more than 1 controller is used, a second enclosure is also located on the Infeed Rail.

Identify your printer option using Table A-2 on page OP-176.
Learn more about operating and the printer starting on page OP-182.

Printer Component Descriptions

Control Unit

The BLADE software communicates with the control unit to determine what to print and when. The control unit then sends a message to the print head(s). The word “printer” is often used when discussing the control unit, or sometimes refers to the entire assembly (control unit and print heads).

The information in this appendix is written for a Matthews V84i control unit. If the control unit changes, there may be slight differences in graphics and specifications.

Normal illumination of the Print LED on the controller is:
- Solid green at startup
- Flashing green when printing output is on

Print Head(s)

The print head uses ink from the ink supply unit to mark a print target according to the signals received from the control unit. For more information on a specific print head, please see the documentation received with the applicable head.

Ink Supply Unit

Used for supplying ink and cleaner fluid to the print head.

Pneumatic System

The printer system has its own pneumatic regulator that should be set at 15 psi or lower. Exceeding this recommended setting will damage print heads.
Printer System Graphics

Figure A-1: Printer System

Print Heads

May only have 1 ink bottle, depending on ink head configuration.
1 ink bottle is dedicated to the 16-valve print head. The 2nd ink bottle is used for all other print heads.
Keeping You and Your Printer Safe

• Always wear safety glasses and rubber gloves when handling ink.
• Never clean nozzles with pressurized air.
• Use only the correct Matthews inks and cleaners. Failure to do so will damage the unit and void the warranty.
• Running the print head/s without fluid will cause damage.
• Check regularly for kinks or other stoppages in the lines.
• Never refill an ink or cleaner bottle.
• Do not allow the ink or cleaner level to fall below the bottom of the pick-up tube. The air will negatively effect print quality and cause damage to the print head.
• Never pressurize a bottle while it is positioned outside the ink supply unit.
• Never exceed the recommended pressure setting: 15 psi.

Sensor States

To see the printer sensor states, go to Diagnostics, then Main Controller.
Maintaining the Printer (HANG NEAR PRINTER)

Cleaning the Printer Daily

Follow this procedure carefully to avoid pushing debris into the print head. When a print head is damaged by dust and debris, it may require replacing the entire print head which is a costly solution. Lengthen the life of the print heads by keeping them clean in accordance with these instructions.

**NOTICE:**

DO NOT use a cloth rag because it will push debris into the print head nozzle including cloth lint.

A brush was provided with your new printer. It may be helpful to trim the ends of the bristles to make them shorter, and therefore, stiffer.

Keep the brush in a ZIPPED plastic bag. If the bag or the brush get contaminated between uses, wash it or replace it.

Do not use other cleaning solutions! Cleaning this ink requires 100% acetone, and the Matthews cleaner has been specially formulated to dissolve the Matthews ink. Other cleaners may contain additional ingredients that will damage the printheads.

Do not spray the cleaner on. The spray can push debris into the nozzles.

Always store extra bottles of cleaner in a temperature-controlled area. When opening a bottle near the saw, set the bottle and cap on a clean and dust-free surface.

Clean the printer face (nozzles) at least **twice a day** with this procedure:

1. Dip the brush in the cleaner used in the printer assembly (for flushing print heads).
2. Lightly move the brush back and forth across each nozzle, ensuring that all visible traces of ink are gone each time.
3. Rinse the brush immediately to remove ink before it dries.

Place the brush in a plastic bag and seal the plastic bag.

**CAUTION**

- Wear goggles and gloves when handling ink/cleaner.

- Never wash ink or cleaner in a location where food or dishes may be. Rinse area well when done.

- If ink or cleaner makes contact with a person’s skin, hair, eyes, or clothes, refer to the treatment section in the Safety pages at the beginning of this manual.
**Printer Relief Valve**


**Printer Fuse**

Flushing the Printer

The printer should be flushed to clean ink out of the lines every weekend, or at least once a month.

Identifying Your Printer

The flushing instructions refer to 16-valve and 7-valve printers. Use Table A-2 to determine which printers your system uses.

Table A-2: Printer Models and Specs

<table>
<thead>
<tr>
<th># of Valves</th>
<th>16</th>
<th>7</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID and Printing Location</td>
<td>Uses Ink Bottle 1</td>
<td>Uses Ink Bottle 2</td>
<td></td>
</tr>
<tr>
<td>Standard A</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option B</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Option C</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Option D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AGS+ Option E</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>AGS+ Option F</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Flushing is filling the lines with the desired fluid. Purging the previous fluid out is a step within Flushing that is described on page OP-179.
The Flushing Procedure

Go to the Diagnostics>Detailed Diagnostics>Printer tab in the BLADE software, then follow the instructions in Figure A-4 to flush any print head.

Figure A-3: Printer Screen in Detailed Diagnostics

The 16- and 32-valve print head has a valve controlled by the screen in Figure A-3 to switch between ink and cleaner. The 7-valve print heads have a valve located near the ink supply bottles that must be switched manually. See Figure A-5 on page OP-178.
**Figure A-4: Procedure for Flushing** (Refer to Figure A-3 for screen.)

<table>
<thead>
<tr>
<th></th>
<th><strong>32- or 16-valve</strong></th>
<th><strong>7-valve</strong></th>
<th><strong>FLUSHING CLEANER OUT</strong></th>
<th><strong>FLUSHING INK OUT</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>print head:</td>
<td>print head:</td>
<td>From Diagnostics&gt;Detailed Diagnostics&gt;Printer screen:</td>
<td>Manually move valve handle to point up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>a) Select print head from drop-down menu.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>b) Select the correct valve:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Ink</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Cleaner</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>Place a container in front of purge valve.</td>
<td>Place a container in front of purge valve.</td>
</tr>
<tr>
<td>3</td>
<td>See detailed steps on subsequent page.</td>
<td>Manually Purge Cleaner From Lines</td>
<td>Manually Purge Ink From Lines</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>Place a paper towel in front of print head.</td>
<td>Place a paper towel in front of print head.</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td>From Diagnostics&gt;Detailed Diagnostics&gt;Printer screen:</td>
<td>FLUSH</td>
</tr>
</tbody>
</table>

**Figure A-5: Manual Valve for 7-Valve Print Heads**

*Handle is shown pointing up for ink transfer.*

- Ink
- Cleaner

7-Valve Print Head Valve Handle
Manually Purging Ink or Cleaner From Lines

Flushing the existing fluid from the printer lines will eventually purge all fluid from the lines, but it may be a slow process. A more efficient method is manually purging the unwanted fluid from the lines, then flushing the desired fluid into the lines.

To Manually Purge 32- or 16-Valve Print Heads:

1. Follow the procedure in Figure A-4 on page OP-178 until the Manually Purge... step, then follow this procedure.

2. With a waste container under the purge valve, pull the purge valve back to compress it, and ink will exit out of the purge valve into the waste container.

3. If flushing the system, continue with the procedure on page OP-176.

To Manually Purge 7-Valve Print Heads:

1. Follow the procedure in Figure A-4 on page OP-178 until the Manually Purge... step. Note that the 7-valve print head selects ink or fluid by manually turning the valve handle shown in Figure A-5 on page OP-178.

2. With a waste container under the purge valve, pull the purge valve back to compress it, and ink will exit out of the purge valve into the waste container.

3. If flushing the system, continue with the procedure on page OP-176.

Figure A-6: Printer Parts Diagram
Preparing for Shut Down of Over 48 Hours

When the printer is not in use for more than 48 hours, it is HIGHLY recommended to flush cleaner through the print head(s).

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLUID WILL EXIT NOZZLES DURING FLUSH!</td>
</tr>
<tr>
<td>When a Flush cycle is initiated be sure to have something in front of the print head nozzle plate(s) to capture the discharged fluid!</td>
</tr>
</tbody>
</table>

1. Flush cleaner through the lines as described on page OP-176.
2. Clean nozzles as described on page OP-174.
3. Leave cleaner in the print head manifold until printing resumes.

After Shut Down for Over 48 Hours

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLUID WILL EXIT NOZZLES DURING FLUSH!</td>
</tr>
<tr>
<td>When a Flush cycle is initiated be sure to have something in front of the print head nozzle plate(s) to capture the discharged fluid!</td>
</tr>
</tbody>
</table>

1. Flush ink through the lines as described on page OP-176.
2. Clean nozzles as described on page OP-174.
Replacing an Ink or Cleaner Fluid Bottle

1. Lockout/tagout the pneumatic system’s main regulator. There must not be any air pressure in the system when replacing fluid bottles.

2. Shake the new ink bottle vigorously.

3. Remove the cap from the new bottle, but not the foil seal.

4. Remove filter assembly from empty bottle.

5. Cut a slit in the foil seal on the new bottle.

6. Insert the filter assembly into the new bottle.

7. Place the new bottle back in the Ink Supply Unit and close the door.

8. Purge the line so all air is pushed out. See page OP-179.

9. Ensure the valve is in ink position for printing.

NOTICE

ONLY USE INK SPECIFIED FOR THIS SAW. Other ink, including ink used on other MiTek equipment, will destroy the print head and result in costly repairs. See page OP-168 for printer supplies.

Refer to page OP-168 for help with ordering ink or cleaner fluid.

If the previous bottle was empty, air MUST be purged from the lines.
Printer Description and Operation Details

When used in conjunction with a MatchPoint Blade™ wood processing system, the BLADE™ Printer allows a component manufacturer to print member level information that assists in the truss or wall panel assembly process. The different printing options are outlined here. Options E & F were added in 2014 to offer a more visual method of communicating the proper plates to be used.

Printer Options Overview

When used in conjunction with a MatchPoint Blade wood processing system, the BLADE™ Printer allows a component manufacturer to print member level information that assists in the truss or wall panel assembly process. The different printing options are outlined here and described in detail on our web pages. The information here is subject to change, so refer to the web pages for the most recent information.

A: Standard with every saw. Prints standard print fields (text) on front face.

B: Uses two print heads to print standard print fields, joint and plate information, and joint alignment marks on face-up (on assembly tables) side of board.

C: Same as A, plus a 2nd print head to print on top edge of board.

D: Same as B, plus a 3rd print head to print on edge of board.

E: AGS+: Uses 2 print heads to print everything in B, plus plate outlines in correct location and basic graphics on the face-up side. BEST ROI FOR TRUSSES!

F: AGS+: Same as E, plus a 3rd print head to print on edge of board. BEST ROI FOR WALLS!

Joint alignment marks can be moved toward the top or bottom edge of the board so they are closer to the joint.
**Print Fields**

The standard print fields can be printed on each part as it enters the saw chamber. The fields with an asterisk mark are printed by default, but any other field can be chosen to replace or add to the default fields by selecting the Custom field in Board Stretcher’s *Tools > Options* window.

**Table A-3: Standard Print Fields**

<table>
<thead>
<tr>
<th>Truss (name) *</th>
<th>Description*</th>
<th>Overall Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly</td>
<td>Grade</td>
<td>Side</td>
</tr>
<tr>
<td>Job Name</td>
<td>Stock Length</td>
<td>AO Side</td>
</tr>
<tr>
<td>Group</td>
<td>Stock Width</td>
<td>Assembly Staging Group</td>
</tr>
<tr>
<td>Quantity*</td>
<td>Centerline Length</td>
<td>Text</td>
</tr>
</tbody>
</table>

* default choices

---

**Figure A-8: Printing Without AGS**

White Text = Standard Print Fields

Black Text = AGS Printing

**Figure A-9: Printing WITH AGS**

Square plate slots run parallel to double lines.
Print Side

Remember that the side of the board receiving an image depends on the part and the printer option installed. The graphic here defines front face, back face, edge (always top edge), and face-up to assist in understanding Table 2 which summarizes what and where each option can apply ink.

Figure A-10: Front Face vs. Face-Up

Edge Printer

Edge printing, in systems with that option, is always located on the top edge of the board as it enters the saw chamber. This is typically used for printing stud locations on wall panels. It can also print any of the standard print fields. All options including an edge printer (C, D, & F) require that the wall panel software license be purchased also.
Image Size and Location

Options A & C

<table>
<thead>
<tr>
<th>Vertical</th>
<th>Horizontal Location</th>
<th>Size of Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select Leading Edge, Trailing Edge, or Center in <em>Board Stretcher</em>.</td>
<td>1 row of large text if it fits. If needed, automatically changes to two lines of small text.</td>
</tr>
<tr>
<td>See graphic.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Options B & D

<table>
<thead>
<tr>
<th>Vertical</th>
<th>Horizontal Location</th>
<th>Size of Text</th>
<th>Face That Receives Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Without AGS Software: Select Leading Edge, Trailing Edge, or Center in <em>Board Stretcher</em>.</td>
<td>Without AGS Software: 1 row of large text if it fits. If needed, automatically changes to two lines of small text.</td>
<td>Without AGS Software: Prints standard print fields on front and back faces every time.</td>
</tr>
<tr>
<td></td>
<td>With AGS Software: Face-Up Side: The largest available print zone.</td>
<td>With AGS Software: Small text arranged in two rows.</td>
<td>With AGS Software: Default is to print standard print fields on face-up side only. A MiTek representative can change the configuration to print the standard print fields on the opposing (face-down) side also.</td>
</tr>
<tr>
<td></td>
<td>Opposing Side (face-down): Select Leading Edge, Trailing Edge, or Center in <em>Board Stretcher</em>.</td>
<td></td>
<td>AGS printing data always prints on the face-up side only.</td>
</tr>
<tr>
<td>See graphic.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Options E & F

<table>
<thead>
<tr>
<th>Vertical</th>
<th>Horizontal Location</th>
<th>Size of Text</th>
<th>Face That Receives Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Face-Up Side: The largest available print zone.</td>
<td>Small text arranged in two rows.</td>
<td>Default is to print standard print fields on face-up side only. A MiTek representative can change the configuration to print the standard print fields on the opposing (face-down) side also.</td>
</tr>
<tr>
<td></td>
<td>Opposing Side (face-down): Select Leading Edge, Trailing Edge, or Center in <em>Board Stretcher</em> software.</td>
<td></td>
<td>AGS printing data always prints on the face-up side only.</td>
</tr>
<tr>
<td>See graphic.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Plate Printing Note: Only plate edges that fall within the print area will be printed. On boards larger than a 2x6, some plate edges will not print.
Figure A-11: Location of Print

**Options**

- **A, B, C, D**
  - Front Face
  - 16-Valves

- **B & D**
  - Rear Face
  - 7-Valves

- **E & F**
  - Both Faces
  - 32-Valves

---

**2x12**

- 2-3/4" down to 1/2"
- 3-1/4" to 2-1/4"
- 5-3/8" down to 7/16"

---

**2x6**

- 2-3/4" down to 1/2"
- 3-1/4" to 2-1/4"
- 5-3/8" down to 7/16"

---

**2x4**

- 2-3/4" down to 1/2"
- 3-1/4" to 2-1/4"
- Top edge down to 7/16"
Printing Lateral Bracing on Roof Trusses

Lateral bracing is indicated on truss drawings as a cross section of a piece of lumber at the required location. It is accompanied by a bracing note, as shown.

To apply the lateral bracing without the AGS+ Printer, the web must be measured and the location(s) calculated and marked. With AGS+, the lateral bracing symbols are printed directly on the face-up side of the board.

As you can see in the sample photo, one side of the rectangle may be open due to print area limitations. If that occurs, it simply means the truss drawing had the symbol on that side of the board (the side without a line). In actuality, though, the bracing can be attached to either side (edge) of the truss lumber.

Just like on the truss drawing, the lateral bracing symbols printed on the lumber are not to scale, and they do not indicate the size of bracing to be used. Bracing sizes should be determined by the building designer and industry best practices. A typical MiTek drawing includes a note that reads, “MiTek recommends that Stabilizers and required cross bracing be installed during truss erection, in accordance with Stabilizer Installation guide.” The Stabilizer product was designed specifically for this purpose.
Sample Printer Agreement

In exchange for purchasing the MiTek® Inker/Printer from MiTek, the user (customer) of the Inker/Printer can expect the following from MiTek:

1. MiTek agrees to install the aforementioned Inker/Printer during the installation of a new Cyber® A/T saw or BLADE™ wood processing system that is purchased at the same time as the Inker/Printer. If purchased separately, the Inker/Printer will be installed at a mutually scheduled time between MiTek and the user.

2. MiTek will provide training and startup assistance during the installation of the Inker/Printer.

3. After installation is complete, MiTek will provide on-site assistance for software or saw related issues only. Mechanical repairs to the Inker/Printer are the responsibility of Matthews™ (the manufacturer of the Inker/Printer) and the user (customer).

In exchange for purchasing the Inker/Printer from MiTek, the user (customer) of the Inker/Printer can expect the following from Matthews, the manufacturer of the Inker:

1. Matthews will perform all warranty services of the Inker/Printer.

2. Matthews will supply all of the perishable supplies when they are purchased by the user. MiTek will not be providing perishable supplies.

In exchange for purchasing the Inker/Printer from MiTek, the user (customer) of the Inker/Printer acknowledges the following:

1. The user understands the capabilities of the Inker/Printer, including its limitations, as integrated with the saw. The user agrees that MiTek is only responsible for providing the stated capabilities of the Inker/Printer during the installation and after the Inker is operational. Additional capabilities are not available without prior agreement with MiTek, which may delay shipment and installation of the Inker/Printer.

2. The user agrees to have the site ready for installation of the Inker/Printer at the scheduled time of installation. This includes, but is not limited to, building completion, available access to the building, power on site for the saw and Inker/Printer, power in the correct location for the saw and Inker/Printer, air to the saw, and access to required tools.

3. The user agrees to have adequate materials and samples for testing the operation of the Inker/Printer and training on operation during the installation. The user should have actual cutting information that can be downloaded from the saw to the Inker/Printer.

4. The user agrees to purchase all consumable supplies such as ink or solvent at least three (3) weeks prior to the installation of the Inker/Printer, as they will not be
included with the Inker/Printer. The supplies and part numbers that must be available for use during installation are supplied in this document.

5. The user agrees to follow the maintenance procedures recommended by MiTek and Matthews. This may involve hourly, daily, weekly, monthly, and annual maintenance on the Inker/Printer. Ink for the Inker/Printer is required to be stored and used at a temperature of at least 32°F to prevent ice crystals from forming and clogging the Inker/Printer.

6. The user is responsible for establishing and maintaining a relationship with Matthews according to the contact information given in this document.

7. The user agrees to read and understand the Inker/Printer manual.

8. Failure to follow these items may delay the installation and start-up of the Inker/Printer. It may also result in extra charges from MiTek and Matthews, depending on the severity and nature of the discrepancy.

This agreement must be signed and returned to MiTek prior to shipping. Failure to sign this agreement will delay the shipment and installation of the Inker/Printer. It may take up to 3 WEEKS for supplies to come in, and they must be received prior to the saw’s installation date!

Only Matthews-approved consumables can be used. Using any non-approved consumable supply will result in damage to the print heads and will void the warranty!

_____________________________________________________________
Signature of User  Title

_____________________________________________________________
Company Name  Date
Safety Resources

Safety notes are located at appropriate places throughout this manual, but nothing can teach common sense and planning ahead. Before operating or performing maintenance on any MiTek saw or assembly equipment, each person must watch the safety videos created for that equipment. They can be viewed on the MiTek web site under Machinery.

Basic Understanding of the System

Description of Machine and Training

The BLADE wood processing system is a highly sophisticated automated production method for the truss and wall frame industry. Once the cutting and marking list has been downloaded to the machine, the operator’s involvement is minimal.

As with most automated machining systems, the BLADE wood processing system will likely cause you to change the way you do business, especially as it relates to your current cutting procedures and practices. Unlike many other brands, this system dictates production rates, not the operator. However, certain guidelines must be followed to ensure maximum production and accuracy levels. The following pages describe conditions that will affect performance and ultimately, your level of satisfaction.

This section is intended to be a training and familiarization tool. It offers ideas and guidelines based on design intent and lots of customer feedback. Each facility must determine which ideas work best for their application.
Operator Requirements

Training an operator is relatively easy since the system does most of the work. Customers have told us of successfully training an individual in as little as one half hour, but the quality of the training is more important than the quantity. The computer-literacy and component industry knowledge will also affect the amount of training an operator needs.

An effective operator must be a conscientious employee who looks out for the maintenance of the machine, stays busy stocking the lumber feed system in a timely fashion, handles manual loads without delay, watches for misfeeds due to crooked and bowed material, efficiently organizes and collates the finished parts, and is capable and willing to handle the occasional problem that occurs with all machines.

The Reports software can assist the operator and management in determining areas for improvement to facilitate further training.

Meeting Your Expectations

The system records virtually everything that is going on at the saw. Production rates are extremely predictable and repeatable. Comparing reports from week to week will help show trends that may influence production. It is like having an industrial engineer looking over the operators shoulder and can be a highly effective tool if used correctly.

When maintained properly, this system will almost run itself. If multiple related issues arise, a thorough troubleshooting attempt should be conducted immediately to solve the issues, regardless of how small they seem. Any issue that distracts the operator or slows the machine is unnecessary.

Your team has the potential of producing more parts per man-hour, while using a single operator, than is possible on any other machine in this industry. Follow these tips and we are confident you will be pleased.

Optimizing Board Usage

Optimization training is found online at MiTek University (as of late 2017).
Acceptable Material and Finished Parts

What You Should Send To the Saw

The smaller the job size, i.e., one or two trusses, the more likely you will want to do all of the components on the saw. Doing so eliminates the setup time and material handling that would normally be required for even the fastest automated multi-blade component saw. We suggest you evaluate the production capabilities of the multi-blade saws or other cutting hardware you have available. Take into account getting the material to the saw, marking it if necessary, doing the saw setup(s), doing the run, and going to the next setup in the machines computer (if it has one).

Now compare the multi-blade saw time with this equipment, using the production reports to predict the elapsed time to process the job or components. You will find you can very quickly and accurately predict such times since its report shows the average time in seconds to process a part in a given length range with a specified number of angles. These recorded times already account for material handling and doing the run. Since there is no setup time, it need not be estimated.

Generally speaking, the shorter the part the more likely you will want to process it on a linear saw. Conversely, the larger the number of long parts, the more likely a conventional component saw would be the choice. Again, evaluating the actual production times of the available cutting systems will dictate where the job or parts should be processed. When evaluating and comparing the production rates on the two systems, keep in mind that sending very short runs and short parts to a linear saw will dramatically improve the production rates of your multi-blade component saws.

What the Saw Will Cut

Certain parts may be directed to the saw, regardless of quantity, simply because of safety or its greater ability to make unusual or difficult cuts. This would include very short parts such as wedges and extremely long scarfs such as are common on large bottom chords. While the saw will attempt to cut virtually any part you send to it, there are certain limitations as to its ability to control the finished part with the LASM (lumber advance short move). With experience, the operator will develop parameters that define the minimum length to be processed at that facility while having the part discharge to the lumber exit chain from the LASM. Components shorter than this minimum length can then be deleted from the job file prior to being downloaded to the saw optimizing program. This should rarely be necessary, though, because the saw can cut and exit anything with a 2” surface for the LASM to grab.

Under no circumstance should the operator attempt to relieve a jam by placing a hand or an object within the vicinity of the lumber exit chain or the cutting chamber when the saw is powered.
Stock Length, Size, and Grade

We strongly recommend minimizing the grades, species, and lengths of material stocked. Traditionally, truss plants have tended to stock a wide variety of lumber to accommodate any truss. With current technology, the software is much more flexible than your floor space, so it is more cost-effective to stock fewer types and lengths of lumber. With the use of optimization software, waste will likely not be affected by fewer board lengths and substitutions are quick and easy within the software.

LENGTH AND SIZE: As an alternative to an infinite variety of dimensions, we suggest modifying designs to accommodate a smaller range of inventory. Doing so, will help assure the material in the lumber stations (if equipped) will only have to be changed under special circumstances rather than as an hourly or daily activity. This procedure will save operator time, confusion, and errors as well as minimize the space necessary near the machine for staging raw materials.

GRADE: Another important consideration is to use higher grades of materials. Perhaps select a grade that could be used on a larger percentage of components. In some instances, the higher grade might be overkill; however, it serves to minimize the variety of grades in inventory. In addition, it eliminates the possibility of using a substandard grade because of operator error, reduces the probability of recuts, improves efficiency at the assembly tables, and generally enhances the quality and appearance of your product. Finally, it can have a significant effect on the performance of the saw and its material handling system.

To work properly, automated machines and material handling systems need uniformity in the raw materials they process. Wood presents challenges not normally found in the world of automated machines. These challenges are even greater when dealing with lumber used in the truss industry. With that in mind, one of the changes you may be faced with is the viability of using higher grade materials. We acknowledge that certain other manually fed saws can more easily process bowed, twisted, or crooked material, however, their accuracy, man hours per part, production rates, and the quality of the finished product is always compromised.

While being the cheapest to purchase, the lowest grades of material may not be the least costly when considering the total production process. Some of the hidden costs are often overlooked by the purchasing agent. You should determine what your actual total cost per part is when processing low-grade materials with your current production method. Cull rates can reach over 25% on the lowest grades. Consider the time it takes to sort through a unit, handle the usable material, handle the reject material, and determine the potential use for such rejected material. Accounting for all of the preceding, plus the actual time to cut the part, will give you the true cost per part.
Things to Understand

Understanding Job Files

In general, when optimizing materials, the larger the job file of different truss types, the better the material utilization. Because of the large variation in components created by a larger job file, more parts can be placed on the available lengths of stock. The downside is, more complicated logistics on the outfeed end of the saw. Many users limit the job file to a couple of truss types, thus minimizing the number of carts and collating headaches at the end of the saw. Each facility must determine what works best at that site.

The jobs are created by the Board Stretcher software. Board Stretcher has different options for the sorting and optimizations that can be configured so as to be best suited for your operation. Experiment and see what works best for you.

One final note relating to downloaded job file size: Experience has shown that very large files, i.e. in excess of a thousand parts or more, can slow the rate of production of the saw. If you find it necessary to use very large files, contact MiTek to discuss your needs.

Understanding the CLS

The CLS (Crooked Lumber Sensor) automatically senses the position of crooked lumber above or below the bottom surface of the board in the saw chamber and adjusts the height of the cutting head to compensate for the crook. This elevation adjustment of the saw blade happens on the fly, so very little time is lost in the production process. The result is extremely accurate heel and centerline heights on lumber that previously may have been scrapped.

This system was developed with the idea of eliminating the challenges associated with component saws when processing the occasional piece of crooked lumber. Its use is not intended as an inducement to begin processing the worst of lumber. On the contrary, we prefer the straightest materials. As noted above, when discussing the use of low grade materials, the user must accept the fact that you will have more misfeeds, gripper and LASM jams, and generally slower production rates than when running lower grades of stock.
Using Remainders

At the saw, the saw program can maintain a list of default components, or remainders, selected by the operator, which may be processed from any waste remaining after the cutting list has been run through the normal optimizing routine. A remainder is the usable part of a board that unless used, would otherwise be scrap.

These remainder components are entered and assigned a priority by the saw operator, based on the required demand and existing supply of such items. This feature further reduces downfall to an almost insignificant volume, thereby creating usable standard components automatically while minimizing additional handling. With proper utilization, the program will dramatically reduce the waste that would normally be generated by other cutting systems. In some instances, you may choose to use longer original stock in order to increase the length of a remainder, thus permitting it to be recycled directly into the magazines or be processed by another saw.

This option can be turned on or off. Any part can be defined as a remainder. The parts can either be added from the cut list on the Home Screen by selecting F4, or from the Key In Part screen. Once in the remainder list, remainder parts can be active or inactive. If a part is inactive, that means it will never be cut, until it is activated. Remainder parts are prioritized within lumber sizes. For example, all active 2x4 remainder parts are prioritized. This means a remainder part with priority 1 will be cut before a part with priority 2. You should use caution here - typically priority 1 parts are longer than priority 2 parts.

That is, if your priority 1 part fits within the waste area, it will be cut. If it doesn't fit then your priority 2 part will be tested to see if it fits. This means a shorter priority 1 part will always be cut and a longer priority 2 part will never be cut. A diagram of the possible remainders can be viewed by clicking the F3 button.

- At the top of the screen, you have the option to cut leading and/or trailing remainders - these are the parts you defined that show in the middle of the screen.
- If you wish to delete a part, highlight it and press the Del key or click on DELETE.
- If you wish to change the priority of a part, highlight it and press the CTRL key with the up or down arrow.
- If you wish to deactivate or activate a part, double-click it or highlight it and then click on the CHANGE ACTIVATION button.
- If you have a printer on your saw, the information under the 'Print' column is printed on the remainder part. You can change this information by highlighting the part and then keying in something new into the print field.
- If you make a change to the remainder part data, the ACCEPT button will become active. You must press the ACCEPT button to allow the data to take effect.
- If you make a mistake, such as deleting a part that you don't really want to delete, simple return to the Home Screen. You will get a pop up message saying you have changed items - answer 'No' - and your remainder data will be the same as when you entered the remainder screen.
Glossary

actuate

to activate, put into action

affected employee

an employee whose job requires him/her to operate or use a machine or equipment on which servicing or maintenance is being performed under lockout or tagout, or whose job requires him/her to work in an area in which such servicing or maintenance is being performed

amperage

the strength of an electric current, expressed in amperes

authorized employee

a person who locks out or tags out a machine or equipment in order to perform servicing or maintenance on that machine or equipment; an affected employee becomes an authorized employee when that employee’s duties include performing servicing or maintenance covered under this section

Auto Deck

a staging conveyor that feeds lumber to the Infeed Rail

Auto Mode

the normal operation mode when the saw is using job files to cut the lumber in the correct order

automated lumber feed system

mechanical system used to feed lumber to the Infeed Rail; can be the Auto Deck staging conveyor or an automated lumber retrieval system

axis

a main line of direction, motion, growth, or extension; includes angle, bevel, elevation, and stroke; plural is axes

bevel

the cut on the 4” dimension of a 2x4, is an optional feature

board

A specific piece of lumber with specific dimensions required by the saw to cut out specific parts

bow

a curve of the face of a board (3-1/2” surface on a 2x4); the bow points to the side on floor and wall studs
Glossary

bumper
a small, black rubber shock resistor used throughout the interior of the saw

bus bar
an electrical device that allows multiple gantry heads to be used simultaneously

CLS
Crooked Lumber Sensor; senses when a piece of lumber is crooked and adjust the cut to compensate

connector plate
a metal plate with “teeth” that hold truss or wall components together

crown
a curve of the edge of a board (1-1/2” edge on a 2x4); the crown points up for floor studs or out for wall studs

disconnect
noun, the handle, often on a machine’s main electrical enclosure, that shuts off incoming power at that spot in the electrical system

elevation
the assembly that moves the saw blade up and down

energized
connected to an energy source or containing residual or stored energy

energy isolating device
a mechanical device that physically prevents the transmission or release of energy, including but not limited to the following: manually operated electrical circuit breaker; a disconnect switch; a manually operated switch by which the conductors of a circuit can be disconnected from all ungrounded supply conductors, and in addition, no circuit can be operated independently; a line valve; a block; and any similar device used to block or isolate energy—push buttons, selector switches, and other control circuit type devices are not energy isolating devices

energy source
any source of electrical, mechanical, hydraulic, pneumatic, chemical, thermal, or other energy
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>felt strip</td>
<td>an anti-friction border on the metal plate that the stroke joins with inside the stroke-elevation chamber</td>
</tr>
<tr>
<td>foot switch</td>
<td>an operating device on the Auto Deck staging conveyor</td>
</tr>
<tr>
<td>gas spring</td>
<td>the mechanism that holds the saw chamber door open</td>
</tr>
<tr>
<td>gripper</td>
<td>the component on the Infeed Rail that holds the end of the board and pushes it into the saw chamber</td>
</tr>
<tr>
<td>hold-down</td>
<td>now called the top clamp; located on the infeed side of the saw</td>
</tr>
<tr>
<td>home</td>
<td>the default location of a component, the act of “homing”; a component means to send it to it’s home position</td>
</tr>
<tr>
<td>infeed gripper</td>
<td>see gripper</td>
</tr>
<tr>
<td>job</td>
<td>A group of parts requiring specific boards to cut it efficiently</td>
</tr>
<tr>
<td>illuminate</td>
<td>to light up, to turn on a light, to glow</td>
</tr>
<tr>
<td>Infeed Rail</td>
<td>the rail that lumber rests on before entering the saw chamber</td>
</tr>
<tr>
<td>infeed side clamp</td>
<td>see side clamp</td>
</tr>
<tr>
<td>inventory</td>
<td>in the saw software, inventory is the lumber entered into the software that is available to assign parts to in a job</td>
</tr>
<tr>
<td>jigging</td>
<td>any of several devices used to hold something; typically describes holding the truss in place on assembly tables</td>
</tr>
<tr>
<td>job</td>
<td>A group of parts requiring specific boards to cut it efficiently</td>
</tr>
<tr>
<td>LASM</td>
<td>Lumber Advance Short Move; grabs the board as it enters the saw chamber, and moves it to the outfeed side of the saw chamber, if necessary</td>
</tr>
</tbody>
</table>
Glossary

LASM lockout sensor  
Sensor that prevents collisions between the LASM and the saw blade

layout  
A scaled diagram of the location of components and the space that they occupy

leveling screws  
Used to refer to any structural leg that can be adjusted up or down by a screwing motion

limit switch  
An electro-mechanical device that consists of an actuator mechanically linked to a set of contacts; when an object comes into contact with the actuator, the device operates the contacts to make or break an electrical connection

load arms  
Arms that load lumber from the lumber feed system (Auto Deck or) to the Infeed Rail

lockout device  
A device that utilizes a positive means such as a lock, either key or combination type, to hold an energy isolating device in the safe position and prevent the energizing of a machine or equipment, including blank flanges and bolted slip blinds; should be standardized within the facility in at least one of the following criteria: color; shape; or size; and additionally, in the case of tagout devices, print and format shall be standardized

lockout/tagout  
A means of isolating a piece of equipment from its energy source so maintenance can safely occur; guidelines provided in OSHA 29 CFR 1910.147

lumber  
A group of boards or a non-specific board; no consideration given to the final size or shape

lumber exit chain  
Outfeed chain, part of the outfeed assembly

lumber feed system  
Any system that feeds lumber to the Infeed Rail; usually the Auto Deck staging conveyor or an automated lumber retrieval system

lumber pusher  
On Auto Deck, pushed the lumber onto the Infeed Rail
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lumber Yard</td>
<td>The virtual lumber yard in the saw software that lists lumber available to use and allows the operator to assign each board in a job to a specific lumber in the virtual inventory.</td>
</tr>
<tr>
<td>Manual Mode</td>
<td>the mode the saw is in when operating it from the Diagnostics screen</td>
</tr>
<tr>
<td>master printer enclosure</td>
<td>the enclosure that powers the first printer in the system (included in saw purchase)</td>
</tr>
<tr>
<td>Miser</td>
<td>a linear saw created by The Koskovich Company and sold by MiTek</td>
</tr>
<tr>
<td>operator control interface or operator interface</td>
<td>the physical components and methods in which the operator controls the machine; for this equipment, it is a touch screen and panel of mechanical buttons</td>
</tr>
<tr>
<td>operator interface panel</td>
<td>a group of controls located on the operator interface, to the right of the touch screen</td>
</tr>
<tr>
<td>outfeed assembly</td>
<td>the entire area between the saw chamber and the outfeed table or conveyor; includes the lumber exit chain and outfeed clamp</td>
</tr>
<tr>
<td>panel</td>
<td>may refer to an electrical enclosure or a group of controls, such as the operator interface panel located on the touch screen enclosure</td>
</tr>
<tr>
<td>part</td>
<td>A piece of a board, cut to the exact size and shape required for the job</td>
</tr>
<tr>
<td>PC</td>
<td>personal computer</td>
</tr>
<tr>
<td>plate</td>
<td>see connector plate</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller; a solid-state control device that can be programmed to control process or machine operations.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>port</td>
<td>a connection point for a peripheral device</td>
</tr>
<tr>
<td>potentiometer</td>
<td>a control knob that is a dial; allows a range of values to be set by turning the dial, also called <em>pot switch</em></td>
</tr>
<tr>
<td>Powered Skewed Conveyor</td>
<td>an optional outfeed conveyor that integrates with the system to transport and sort the lumber</td>
</tr>
<tr>
<td>proximity switch</td>
<td>a switch that uses an electromagnetic field to detect when an object is near, there is no physical contact between the object and the switch; inductive proximity switches detect only metal objects, capacitive proximity switches can sense both metallic and non-metallic objects</td>
</tr>
<tr>
<td>qualified person</td>
<td>a person or persons who, by possession of a recognized degree or certificate of professional training, or who, by extensive knowledge, training, or experience, has successfully demonstrated the ability to solve problems relating to the subject matter and work—ANSI B30.2-1983; one who has skills and knowledge related to the construction and operation of the electrical equipment and installations and has received safety training on the hazards involved—NEC2002 Handbook</td>
</tr>
<tr>
<td>regulator</td>
<td>a component of the pneumatic system that connects to the main air source and regulates the air pressure allowed into the system</td>
</tr>
<tr>
<td>side clamp</td>
<td>roller clamp on infeed side of saw that contacts the face of the lumber</td>
</tr>
<tr>
<td>solenoid</td>
<td>an assembly used as a switch consisting of a coil and a metal core free to slide along the coil axis under the influence of the magnetic field</td>
</tr>
<tr>
<td>station</td>
<td>a physical location on an automatic lumber feed system</td>
</tr>
<tr>
<td>stroke</td>
<td>the assembly that moves the saw blade in and out (toward or away from operator)</td>
</tr>
</tbody>
</table>
Glossary

tagout device
a prominent warning device, such as a tag and a means of attachment, which can be securely fastened to an energy isolating device in accordance with an established procedure, to indicate that the energy isolating device and the equipment being controlled may not be operated until the tagout device is removed; should be standardized within the facility in at least one of the following criteria: color; shape; or size; and additionally, in the case of tagout devices, print and format shall be standardized.

top clamp
roller clamp on infeed side of saw that contacts the top edge of the lumber; has been called a hold-down

torque
a turning or twisting force

touch screen monitor
a computer monitor that operates from human touch

VFD
Variable Frequency Device; controls the speed of the cycle

voltage
Equal to the difference of electric potential between two point on a conducting wire carrying a constant current of one ampere when the power between the points is one watt

wane
a defect in a board where a portion of the wood is missing from the board edge or face

warp
a curve where the face of a board (3-1/2” side on a 2x4); is higher or lower in one spot than on the rest of the board

waste conveyor
a conveyor under the saw blade that transports waste lumber to a waste receptacle supplied by customer

wood processing system
the entire system including the saw, and all devices that transports lumber to and away from the saw
**Numerics**

3-phase indicator 115

**A**

AGS 63, 67
- print fields 183
- angle, home & radius 61
- arm for touch screen 120

Auto Deck 58
- description 65
- disconnect switch 117
- lumber stops 157
- manually operate 156
- operator interface 124
- setting up 138
- axis, defined 59

**B**

beacon 119
- bevel, home & radius 61
- blade
  - diameter 153
  - home orientation 59
  - kerf 153
  - size 68

Board Stretcher
- introduction 142
- manual 54
- overview 73

**C**

calibrating 160
- capacity 68
- centerlines 71
- cleaner
  - ordering 168
  - replacing 181
- cleaning, printer 174
- CLS 91
  - operating 142

**D**

defaults 100
- changing 152
- Diagnostics menu 86
- disconnect switch 115
- locking out 115
- door switches 112, 113
- double-click, how to 132
- drawing set 52
- dust extraction 64

**E**

edge detector, adjusting 153
- electrical
  - indicator lights 118
  - main enclosure location 57
- emergency stop, see E-stop
- environment 70

E-stop
- disconnect switch 115
- location 108, 109, 144
- pull-cord 110
- pushbutton 110

**F**

File menu 85
- filter/regulator 57
- fire 28
- flushing printer 176
- folders
  - backup files 100
Index

job import 100

G
graphics 56
gripper
  adjusting setting 153
  home 60

H
hazardous substances 28
home
  positions defined 60
  home & path 59
  home positions 60
  home positions 59, 61
  homing 159

I
import
  job to saw 140
  indicator lights 118
  Infeed Rail 57, 58
  ink 168
  replacing 181
  ink, ordering 168
  interlocks
    safety 114

J
job files 194

K
kerf, adjusting 153
keyboard 123
  on-screen 130

L
language, changing on saw 152
LASM
  home and 0 60
  measurements 153
  length tolerance 153
  light beacon 119
  load arms
    raising and lowering 144
  lockout/tagout 115
    graphic 53
    guidelines 5
    main disconnect graphic 116
    other components graphics 117
    procedure 6, 9, 35, 38
  logging in or out 134
  lumber specs 193
  lumber stops 157

M
Main Menus 74
main screen 74
  Miser II software 74
  Reports software 104
  manual
    how to use 52
    introduction 50
    navigation 53
    part number 52
    purpose 50
    understanding formatting 53
  manual operation 154
  Material Handling 97
  Miser II software
    main screen 74
    overview 73
    mode, choosing 143
  monitor
    second
      activating 167
    second monitor 63
      specs 64
  mouse
    adding 123
Index

living without a mouse 132

N
notice of change iii

O
operation
  Auto Deck 138, 156
  begin cut 141
details 136
import to saw 140
indicator lights 118
manually operating 154
power up or down 136
Powered Skewed Conveyor 158
procedure overview 135
remainders 146
restart after E-stop 111
specialized procedures 142
stopping 107
operator interface 120
  Auto Deck 124
  location 56
manually operating 154
moving 120, 121
troubleshooting the basics 133
USB ports 123
optimizing 142
optional equipment 63
outfeed mechanism 58

P
page change iii
password
  changing 152
retrieving when lost 134
perimeter safety cable 110
power on or off 136
Powered Skewed Conveyor
disconnect switch 117
e-stops 109
operation 158
picture 58
printer 101, 146
cleaning 174
components 170
defaults 100
description 67
flushing 176
graphics 171
operation 145
ordering supplies 168
print fields 183
replacing ink or cleaner 181
safety 173
sensor states 173
shut down over 48 hrs 180
supplies 56, 168
printer agreement 188
printing the manual 1
pull-cord 110
raising 157
reducing waste
  Board Stretcher introduction 142
remainders 146
remainders 146, 195
reporting errors ii
Reports software
  main screen 104
  overview 73
  procedure 103
  sample report 104
reset 132
restricted zones 17
return goods ii
right-click menu
  how to access 132

S
safety
  hazardous substance 28
  in Spanish 29
  indicators 1
interlocked door switches 112, 113
lockout/tagout 5, 53
operation 105
printer use 173
restricted zones 17
rules 2
safety rules 1, 30
saw chamber door 114
signal words 1
test 11
troubleshooting w/energy 10
safety symbols 19
saw 58
saw chamber
door switch 112, 113
saw chamber door 56
screen shot version 73
second monitor
option 63
select current board
sort the cut list
select board 81
sensors
view sensor state 173
shortcuts 129
software
BLADE Home Screen 74
BLADE Main Menus 74
BLADE menus 85
BLADE status indicators 75
cut list 80
delete jobs 147
log in or out 134
Miser II 74
overview 73
reject 147
Reports 103
reset 147
shortcuts 129
tips 129
specifications 68
features 63
general 68
status indicators 74, 75
stop motion, see E-stop
straight cut blade definition 152
stroke, home & path 59
stroke/elevation chamber door 57
stroke/elevation chamber door switch 112, 113
thermostat 91
Toolbar 74
touch screen
moving 120, 121
overview 120
training 190
truss terminology 71
units of measure, changing on saw 152
USB ports 123
visualizer 87, 144
Wall Frame software 63
wall panel 101
waste conveyor 56
waste pan drop length 153
Windows operating system
Windows 10 126
Windows 8 128